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Foreword 
 

The National Vocational & Technical Training Commission (NAVTTC) developed a National Skills Strategy (NSS) 

after extensive research and consultation with experts and stakeholders including policy makers and 

representatives from Industry, Academia and the Provincial Government departments dealing with technical and 

vocational training. The strategy aims at establishing a regime that facilitates competency-based and demand-

driven training and assessment.  

 

NAVTTC has developed competency-based training programs with the technical support of TVET Reform Support 

Programme (TVET-RSP), which is funded by the European Union, the Kingdom of the Netherlands, the Federal 

Republic of Germany and the Royal Norwegian Embassy. The Programme has been commissioned by the German 

Federal Ministry for Economic Cooperation and Development (BMZ) and is being implemented by the Deutsche 

Gesellschaft für Internationale Zusammenarbeit (GIZ) GmbH in close collaboration with NAVTTC. These vocational 

training programs have been approved by the National Curriculum Review Committee (having representation from 

all over the country from TEVTAs and industry) for implementation in Public and Private Training institutions. 

 

The purpose of developing competency-based training programs is to equip the learners with modern skills and 

knowledge for each of the trades to meet the requirements of local as well as international markets. These training 

programs include competency standards, qualification, curriculum, assessment material and teaching & learning 

material that will aid in implementation of competency-based and demand driven training in the country.  

 

This Teaching and Learning Material is part of the competency based training program exclusively developed to 

support the implementation of CBT curricula. This Material is intended for the use of learners undertaking training 

in National Vocational Certificate Level-2 in Information Technology (Computer Operator) under the guidance of 

experts and appropriate trainers. This Teaching and Learning Material has been designed in consultation with 

industry, academia and researchers to ensure that the material is relevant and current.  

 

On behalf of the Federal Government/NAVTTC, I wish to express my sincere appreciation and gratitude to all 

subject matter experts, industry representatives and TVET-RSP experts who have diligently contributed in 

producing this valuable Teaching and Learning Material. 

 

 

 

 

 

 

 

 

 

Executive Director 

National Vocational & Technical Training Commission 

(NAVTTC) 

  



Introduction 
 
A computer operator performs simple and routine tasks to carry out different functions and operations in an 
organization. The major responsibilities includes typing of documents, creating letters and memos, sending and 
receiving emails, maintain accounting data, and maintaining backups.  
 
The National Vocational & Technical Training Commission (NAVTTC) has developed a national qualification 
entitled, “National Vocational Certificate Level-2 in Information Technology (Computer Operator)”. Relevant industry 
and employers were consulted in the design and validation processes in order to come up with a national 
qualification that fulfills the requirements of the sector in general and the occupation in particular.  
 
This Teaching and Learning Material (TLM) is developed based on competency standards and curriculum of the 
Computer Operator national qualification. It carries a learning volume of 80 credits and includes eight learning 
modules which are as under:  
 
 

Module 1: Maintain Computer System  
Module 2: Prepare Word Documents  
Module 3: Prepare Spreadsheets  
Module 4: Prepare Presentation  
Module 5: Prepare In-page documents  
Module 6: Manage e-mail / internet  
Module 7: Manage Information System  
Module 8: Identify and peruse new business opportunities in the field of Computer (ICT) 

 
 
This TLM provides support for more effective training and productive learning. Each of the learning modules 
contains learning outcomes and information regarding learning elements in the form of knowledge, skills and 
attitudes. At the end of every learning module are Frequently Asked Questions (FAQs) and Test Yourself which will 
help learners in self-assessment before proceeding to modular or final assessment. 
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Module 1: Maintain Computer System 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Install Operating System 

  Configure Peripheral Devices 

  Install Peripheral Devices 

  Install software Applications 

  Update / Upgrade software Applications 

  Un install Software Applications 

  Perform Windows Scan 

  Format External Mass Storage 

  Troubleshoot Basic Software Errors 

  Troubleshoot Basic Hardware Faults 

  Configure Basic Internet Connectivity 

 

  



Module 1: Maintain Computer System 

2 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 



 Module 1: Maintain Computer System 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 3 

Learning Unit 1: Install Operating System 

Overview 

Computer consists of two main parts Hardware and Software. In software, system 
software (Operating system) is main software which control and manage the computer 
and all the devices attached to it. This learning unit covers the procedure of installing, 
operating system; describes different types of operating systems, precautions and 
hardware requirements for installing Operating system. After completion of this learning 
unit, you will be able to demonstrate the procedure for installing Operating System and 
describes the different types of operating system and computer parts. 

1. Basic Parts of Computer System 

A computer is an electronic device which takes input from the user, processes it and gives output. Computer 
consists of several parts like CPU, Mouse, Keyboard monitor, LCD, Printer, and Speakers. 

 

Basic Parts of a Computer 

These parts may be different according to the system. Like in laptops, touchpad replaces mouse, built in speakers 
in LCD and built in laptop. 

 

Basic Components of Computer System 

There are three basic components of computer system. CPU or system unit, Input unit and Output unit.  

1. CPU or System Unit 

System unit is a base for computer system. That commonly known as CPU (Central Processing Unit). 
The central processing unit is "brain" of computer , which consists of the following three main parts: 

The word computer 
comes from a Latin 
word “Compute” 
which means to 
calculate. So it is 
also called a 
calculating device 

Remember 

Operating system is 
the soul of a 
computer. It 
controls/ manages 
all the working of 
computer and 
devices attached. 

Operating System  
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1.1 Memory Unit: consists of primary memory and secondary memory. In primary 

memory, RAM (Random Access Memory which is primary memory that loads 
the required data and erase it at the time of shutdown/restart. In secondary 
memory which store information on disc drives / devices permanently this can 
be used in future again and again.  

1.2 Control Unit:  it controls all the devices (peripheral devices) which attached to 
the computer. 

1.3 ALU (Arithmetic Logic Unit): It is also called Microprocessor which is the brain 
of the computer, which deals with all the arithmetic (additions, multiplication, 
subtractions) and logical operations (greater, less then, equal etc.) of the 
computer. 

 

Main Parts of CPU 

2. Input Unit 

Input unit /devices are used for giving input to the computer for processing. There are many types of input devices 
like keyboard, mouse and scanner. 

 

3. Output Unit 

Output unit/ devices are used for giving and display output to the user. There are many types of output devices 
like printer, speaker and monitor. 

2. Hardware and Software 

Following are the two major elements of the computer. 

1. Hardware 

Hardware is the physical parts of Computer that can be seen or touched.  This includes 
the computer casing, monitor, keyboard, and mouse. It also includes all the parts inside 
the computer casing, such as the hard disk drive, motherboard, video card, LAN card 
and many others.  

2. Software 

The set of instructions given to the computer to perform a task is called software. 
Computer software or software is any set of machine-readable instructions that directs a computer's processor 

Hardware is tangible 
elements and 
software is 
intangible elements 
of computer. 
Hardware and 
Software are 
dependents on each 
other. 

Remember 

There are three 
basic components of 
computer system 
input unit, output 
unit and system unit. 

Remember 
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to perform specific operations.  The two main types of software are System Software and Application software. 
Following are the two main types of software. 

2.1 System software: System software is computer software designed to operate and control the 
computer hardware and to provide a platform for running application software it includes software 
like operating system Language Software, device drivers 
 

2.2 Application Software includes Word processing software, Spreadsheet software, Database 
software, Education software, entertainment software and many more. 

3. Types of Operating Systems 

Operating System 

An operating system (OS) is a set of programs contains instructions that work together to coordinate all the 
activities among computer hardware resources. Most operating systems perform similar functions that include 
starting and shutting down a computer, providing a user interface, managing programs, managing memory, 
coordinating tasks, configuring devices, establishing an Internet connection, monitoring performance, providing 
file management and other utilities, and automatically updating itself and certain utility programs. 

 

Types of Operating Systems 

Operating systems usually preinstalled on the computer when it is purchased. Mostly people use the operating 
System that preinstalled on their computer, but it is possible to upgrade or even reinstall new operating systems. 
The most common operating systems for personal computers are : 

Microsoft Windows, Apple Mac OS X, and Linux, Unix etc. 
 
 
1. Microsoft Windows 

Microsoft created the Windows operating system in themid-1980s. Over the years, there have been many 
different versions of Windows, but the most popular ones are Windows 7 (released in 2009), WindowsVista 
(2007) and Windows XP (2001). Windows is very compatible and user friendly which makes it the most popular 
operating system in the world. If you're buying a new computer or upgrading to a new version of Windows, you 
can choose from several different editions of Windows, including Home, Premium, Professional, and Ultimate.  

 
2. Apple Mac OS X 

Mac OS is a line of operating systems created by Apple Inc. It is also preinstalled on 
all new Macintosh computers, or Macs. All of the recent versions are known as Mac 
OS X (pronounced Mac O-S Ten), and their specific version names are Lion 
(released in 2011), Snow Leopard (2009) and Leopard (2007). Apple also offers a 
version called Mac OS X Server, which is designed to operate on servers. The Apple 
operating system does have some disadvantages, primarily in regard to software and 
hardware compatibility. 

 
3. Linux 

Linux operating system is developed on a kernel, based on Unix. It is known as one of the most secure platforms, 
yet Linux is often viewed as more complex. Linux (pronounces LINN-ux) is a family of open source operating 
systems, which means that they can be modified and distributed by anyone around the world. This is very 
different from proprietary software like Windows, which can only be modified by the company that owns it 

Who is the founder 
of Apple Company 
and who is the 
owner of Microsoft 
Company?? 

Do you know! 
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(Microsoft). The advantages of Linux are that it is free, and there are many different distributions (versions) that 
can choose from. Each version has a different look and feel, and the most popular ones include Ubuntu, Mint, 
Red Hat and Fedora. Linux is named after Linus Torvalds, who created the Linux kernel in 1991. 

4. Basic Difference between Operating Systems 

There are many differences among these operating systems. These are according to their work. 

Single-Tasking and Multi-Tasking 

A single-tasking system can only run one program at a time, while a multi-tasking 
operating system allows more than one program to be running in concurrency. This is 
achieved by time-sharing, dividing the available processor time between multiple 
processes which are each interrupted repeatedly in time-slices by a task scheduling 
subsystem of the operating system. Multi-tasking may be characterized in pre-emptive 
and co-operative types.  

Single-User and Multi-User 

Single-user operating systems have no facilities to distinguish users, but may allow multiple programs to run in 
tandem. A multi-user operating system extends the basic concept of multi-tasking with facilities that identify 
processes and resources, such as disk space, belonging to multiple users, and the system permits multiple users 
to interact with the system at the same time. 

Distributed 

A distributed operating system manages a group of distinct computers and makes them appear to be a single 
computer. In distributed computing that are liked and communicated to each other. Computers work in groups in 
distributed system. 

Embedded 

Embedded operating systems are designed to be used in embedded computer systems. They are designed to 
operate on small machines like PDAs with less autonomy. They are able to operate with a limited number of 
resources. They are very compact and extremely efficient by design. Windows CE and Minix 3 are some 
examples of embedded operating systems. 

Real-Time 

A real-time operating system is an operating system that guaranties to process events or data within a certain 
short amount of time. A real-time operating system may be single- or multi-tasking, but when multitasking, it uses 
specialized scheduling algorithms so that a deterministic nature of behavior is achieved. An event-driven system 
switches between tasks based on their priorities or external events while time-sharing operating systems switch 
tasks based on clock interrupts 

5. Precautions to be taken before Installing Windows 

Before installing any operating system, Following precautions must be followed for safety and security of 
important data / software’s. 

Windows is a  
Multi-tasking 
operating system. 

Remember 
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1. Regularly take backup of your computer system data. 
2. Check the prefix for Installation of new Operating system. 
3. Check the compatibility issue before installing windows. 
4. Create check points/restore points. 

 
 
 

System Requirements for Windows 7 

For installing windows 7 we need: 

 1 gigahertz (GHz) or faster for 32-bit (x86) or 64-bit (x64) processor. 

 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit). 

 16 GB available hard disk space for (32-bit) or 20 GB for (64-bit). 

 DirectX 9 graphics device with WDDM 1.0 or higher driver. 
 

6. Installation of Operating System 

Step by Step Windows Installation 

1. Boot/Start Computer From Window 7, bootable DVD or Bootable USB Flash 
2. Press Esc, F10, F2 or Delete key from Keyboard depending upon your Manufacturer. 
3. If prompted, Press any key to Boot from CD/DVD……” then press Any key 
4. The obvious place to start in Win 7 is with the installation process. 

 

Loading Files into RAM 

5. Then  switch from a DOS-looking progress bar to a Windows-looking progress bar 

    

6. Get the first Windows 7 install screen. After picking an install language, get to the main install kick-off 
window. 

 

Select Language and Start 

 

Windows can also 
be installed using 
bootable Flash drive 
or through using 
network share. 

Remember 

F2 key is used for 
entering setup of the 
computer system. 

Do you know! 
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Select Version of Window 7 

 X86 means 32-bit (older technology)  

 X64 means 64-bit (newer technology).  

 

Select Windows Version 

7. Click “I accept the license terms”. 

 

Upgrade or Custom 

Upgrade VS Custom 

Upgrade  

 Keep Files, Setting, Programs of Old Window  

 Available only on Existing Version of Window 

 Can be upgraded to newer or Higher Version 

 Cannot change Partition 

Custom 

 Does not keep Files, Setting, Programs of Old Window 

 Install a fresh / New copy of Window 

 Any version can be installed 

 Can change Partition 

The key difference: 
32-bit processors 
are perfectly 
capable of handling 
a limited amount of 
RAM, and 64-bit 
processors are 
capable of utilizing 
much more. 

Do you know! 
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8. Choose Custom option. 
 

9. Click on the link Drive options (advanced), it shows managing hard disk partitions. 

 

Drive Option 

 

Select Drive Size 

10. If wants to create a new partition on unallocated space then give the size of the drive and click on apply. 
 

11. Click Next. 

Now the installation will begin. 



Module 1: Maintain Computer System 

10 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 

Installing Windows 

At this point the windows will install features, updates and finally it will complete the installation. 

 

User Name 

12. Now type the username in the box and click Next. 
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Password 

13. Type, Retype password and hint in the boxes and click next. 

 

Asking about Product Key 

14. Now it will ask about the Product key. Check the box” Automatically activate windows through online.” 
Windows will automatically activate if you are installing an activated version. 

Password can also 
be applied using 
control panel 
through user 
accounts and control 
settings. 

Remember 
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Set Date and Time 

15. Set Date and time and click Next. 

 

Select Network 

16. Select the desired network and the windows is installed. 

We can change date 
& time after 
installation of 
windows. 

Do You Know 
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Preparing Desktop Screen 

After completion of all the steps the windows will prepare your desktop. 

 

Welcome Screen 
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Learner’s Activity 

 What is an operating system? 

 Mention the name of the operating system installed in your computer. 

 Visit the Microsoft and Apple websites to learn more about each operating system. 

 If you have a PC and currently use an older version of Windows, such as Windows 7 starter, upgrade to win 

7 ultimate versions.  
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Learning Unit 2: Configure Peripheral Devices 

Overview 

A peripheral is a "device that is used to put information into the computer or get information out of the computer. 
Peripheral device is generally defined as any auxiliary device such as a computer mouse or keyboard that 
connects to and works with the computer in some way. Other examples of peripherals are image scanners, tape 
drives, microphones, loudspeakers, webcams, and digital cameras. This learning unit covers about most 
commonly used peripheral devices and commonly used communication ports in computer. After completion of 
this learning you will be able to describe different types of peripheral devices and their use. And most commonly 
used hardware ports. 

1. Commonly Used Peripheral Devices 

A computer peripheral device is an external device that provides input and output for the computer. There are 
three types of peripheral devices one is Input that is use for providing input to the computer, second is output that 
is used for providing output and the last which provides input and output both.  

 

Some Common Input Devices Include: 

 Keyboard 

 Mouse 

 Scanner 

 Microphone 

 Joystick 

 

1. Mouse 
 
A mouse is an input device used to point and select items on the computer screen. A mouse usually has two 
buttons: A primary button (usually the left button) and a secondary button. Many mouse also have a wheel 
between the two buttons, which allows to scroll for ups and down options. 

When the mouse move with the hand, a pointer on screen moves in the same direction. When an item wants to 
select, point to the item and then click (press and release) the primary button. Pointing and clicking with mouse 
is the main way to interact with the computer. 

An external device 
that provides input 
to the computer or 
receives output from 
the computer is 
called a peripheral. 

Peripheral 
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Mouse 

2. Keyboard 
 
A keyboard is used for typing text into the computer. There are many types of keys on the keyboard. These are: 

2.1 Alphanumeric Keys, used to enter alphabetic and numerical data. (E.g. A, B, C …1, 2, 3…) 

2.2 Special Purpose keys, each key is used for any special purpose like Backspace, Spacebar, 
Enter key , CTRL, Shift, ALT keys Caps lock and Tab keys. 

2.3 The function keys, found on the top row, perform different functions depend on where they 
are used. (e.g. F1, F2, F3…) 

2.4 The numeric keypad, located on the right side of most keyboards, allows entering numbers 
quickly. 

2.5 The navigation keys, such as the arrow keys, allow to move the cursor position within a 
document or webpage. 

 

Keyboard 

 

3. Scanner 

A scanner is a device that is used to capture images from photographic prints, posters, magazine pages, and 
similar sources for computer editing and display. There are many types of Scanners, hand-held, feed-in, and 
flatbed used for scanning black-and-white only, or color. Very high resolution scanners are used for scanning for 
high-resolution printing, but lower resolution scanners are adequate for capturing images for computer display.  
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Scanner 

4. Microphone 
 
Microphone is an instrument for converting sound waves into electrical energy variations which may then be 
amplified, transmitted, or recorded. 

It is sometimes abbreviated as “mic”. A microphone is a peripheral that allows computer users to input audio into 
their computers.  

 

Microphone 

5. Joystick 
 
Joystick is a lever that moves in all directions and controls the movement of a pointer or some other display 
symbol. A joystick is similar to a mouse. With a mouse the cursor stops as we stop moving the mouse. With a 
joystick, the pointer continues moving in the direction the joystick is pointing. For stopping the pointer, it must 
return to its upright position. Most joysticks include two buttons called triggers. 

Joysticks are used mostly for computer games, but they are also used for other systems like in Aero plane. 

 

Joystick 

Some Common Output Devices Include: 

http://pc.net/glossary/definition/outputdevice
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 Monitor 

 Projector 

 Printer 

 Speakers 

 

1. Monitor 

A monitor is an output device used to display information in visual form. The portion of the monitor that displays 
the information is called the screen. Like a television screen, a computer screen can show still or moving pictures. 

There are two basic types of monitors: CRT (cathode ray tube) monitors and the LCD (liquid crystal display) 
monitors. Both types produce sharp images, but LCD monitors have the advantage of being much thin and lighter. 

 

           CRT Monitor        LCD Monitor 
 

2. Printer 
 
A printer is an output device used to transfer data from a computer to paper. The two main types of 
printers’ impact printers and non-impact printers. 
 
Impact printers used striking hammer on the inked Ribbon to print on paper, while non-impact printer used 
laser technology for printing. 
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3. Projector 

A projector or image projector is an optical device that projects moving images onto a surface, commonly 
a projection screen. Most projectors create an image by shining a light through a small transparent lens, but some 
newer types of projectors can project the image directly, by using lasers.  

 

Projector 

4. Speaker 

Speaker is one of the most common output device used with computer. The purpose of speakers is to produce 
audio output that can be heard by the listener.  

 

Speakers 

There are some devices that functions both as input and output devices, such as: 

 Hard drives 

 CD/DVD ROM Drive 

 Modems 

 Webcam 
 
 

 
1. Hard Disk Drive 

 
Hard disk drive stores information on a hard disk which is a rigid platter or stack of platters with a magnetic 
surface. Because hard disks can hold massive amounts of information, they usually serve as computer's 
secondary means of storage, because it’s a permanent storage holding almost all of the programs and files. The 
hard disk drive is normally located inside the system unit. 

You can store a 
large amount of data 
on Hard disk. 
External hard disks 
are also available for 
data backups. 

Remember 

http://pc.net/glossary/definition/externalharddrive
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Hard Disk Drive 

 
2. CD (Compact Disc) and DVD (Digital Video Disc) Drives 

 
CD or DVD drive, usually located on the front of the system unit. CD drives uses lasers 
to read data from a CD; many CD drives can also write (record) data onto CDs. 

A DVD drive can do everything that CD drive do, but read DVDs also. Many DVD drives 
can record data onto blank DVDs. This DVD-RW also called Combo drive. 

 

3. Modem 
 

Modem is a short for modulator-demodulator. A modem is a device that enables a computer to 
transmit data over telephone or cable lines. A modem converts between these two forms from analog to digital 
and digital to analog. There are two types of modem Wired and Wireless. 

 

Modem 

4. Web Cam 

A webcam short for “web camera” is a digital camera that is connected to a computer. It can send live pictures 
from wherever it’s sited to another location through the internet. Many desktop computer screens and laptops 
come with a built-in camera and microphone, but if it doesn’t, separate webcam can connect any time. 

Periodically back up 
(copy) your 
important files to 
CDs or DVDs 
because if your hard 
disk ever fails, you 
won't lose your data. 

Remember 

 Periodically back up 
(copy) your 
important files to 
CDs or DVDs 
because if your hard 
disk ever fails, you 
won't lose your data. 

Remember 
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Web Cam 

2. Different Types of Communication Ports 

In computer hardware, a port serves as an interface between the computer and other 
computers or peripheral devices. A port generally refers to the female part of 
connection. Computer ports have many uses, to connect a monitor, webcam, speakers, 
or other peripheral devices. These ports are connection points or interfaces with other 
peripheral devices. 

Physical ports/ Communication ports are used for connecting a computer trough a 
cable and a socket to a peripheral device. Physical computer ports list includes: 

 serial ports ( DB9 socket ),  

 USB ports ( USB 2.0 or 3.0 socket / connector ),  

 parallel ports ( DB25 socket / connector ), 

 Ethernet /internet ports (RJ45 socket / connector). 

 VGA port (Display port) 

 Fire wire (IEEE 1394 interface) 

 E-SATA port 

 PS/2 port 
 

 

 

Any images you 
make available to 
others via webcam 
could remain on the 
internet forever. 

Do you know! 

Serial ports transfer 
data bit by bit and 
parallel port transfer 
data byte by byte. 

Do you know! 

Communication 
Ports are the 
gateway for data 
between devices 
and computers. 

Remember 
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1. Serial Ports 

Serial port is an electronic communication gateway used for transferring data one bit at a time. Serial port was 
used almost for all type of information transfer between a computer and other peripheral devices. Nowadays 
serial port has been replaced with dedicated ports like USB port.  

The serial port is also known as COM port and when a device is connected to it you will found it in device manager 
on port COM1 or COM2. 

 

 

Serial Port 

2. USB Port 

USB port (Universal Serial Bus) is the most useable connection point for data transfer in the world. It was created 
in the mid-1990s with the intention of replacing all other PC ports like serial port, parallel port, PS/2 port.  A 
standard USB connector is a simple socket with 4 pins: one for power, one for ground and two for data transfer. 

 Is used for USB. 

 

USB Cable & Port 

3. Parallel Port 

Parallel port is used for data transfer between a computer and a peripheral device 
through a 25 or 36 pin connector. In parallel communication multiple bits are transferred 
at a time. This port is used for high transmission of data between device and computer. 

 

Ethernet port is also 
called internet 
connection port. 

Do you know! 
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Parallel Port (DB25) 

4. Ethernet Port 

Ethernet port is a network hardware interface used for data transfer and control between two devices that can 
support the IP protocol. The Ethernet port speed can vary 10Mbps up to 10Gbps.  

 

Ethernet Port and Connector 

5. VGA Port 

The VGA port is used for connecting a computer to a monitor. It was the replacement of MDA, CGA and EGA 
standards. 

With the development of new and powerful processing units came the need of a new video standard and this is 
how the VGA port was invented. This new standard brought with VGA monitors compatible with 640×480 
resolution. 

 

VGA Cable    VGA Connector 

6. Fire-wire Port 

Fire-wire port or IEEE 1394 was first developed in 1990 by Apple and worked as a serial bus interface for high 
speed data transfer. The standard was first introduced on computers in 2000 and became the main data 
connection port for apple. 



Module 1: Maintain Computer System 

24 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 

Fire-wire Port 

7. E-SATA Port 

An e-SATA is a combined connection for external storage devices. An e-SATA or USB device can be plugged 
into an e-SATA port. SATA is a computer bus interface for connecting host bus adapters to mass storage devices 
such as hard disk drives and optical drives. e-SATA combines the functionality of an e-SATA and a USB port, 
and a source of power in a single connector. E-SATA can supply power at 5 V and 12 V. 

 

8. PS/2 Port 

The PS2 port is used for connecting keyboards and mouse to a computer. Its purpose was to replace the serial 
keyboard and mouse. 

PS2 connector color code: 

 Purple – Keyboard 

 Green – Mouse 
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Learner’s Activity 
 

 Define different types of ports colors according to their connectors. 

 Plug out all the ports from the computer and connect them again for practice. 

 Write the difference between Hardware and software?? 

 Find out what types of drives are on your computer (CD-ROM, DVD-ROM, etc.). 

 Count the number of USB ports on your computer. 

 What are some of the peripherals you can use with your computer? 
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Learning Unit 3: Install Peripheral Devices 

Overview 

Installing and configuring the variety of peripheral devices, including mouse, microphone, scanner, gamepad, 
camcorder and other devices. This learning unit covers the procedures for installing most commonly used 
peripheral devices like keyboard, mouse, printer, CD ROM, scanner etc. After completion of this learning unit, 
you will be able to install and check different peripheral devices. 

1. Installing Most Commonly Used Peripherals 

There are various types of peripheral devices each of which has different use. A 
peripheral device is defined as a computer device, such as a keyboard or printer that 
is not part of the essential computer, memory and microprocessor. 

1. Installing CD ROM 
 
1.1 Remove the CPU case. 

 

Removing Cover 

1.2 Remove the drive bay cover where the CR-ROM drive will be inserted. 

 

Safety precautions 
must be followed 
before installing any 
Hardware. 

Remember 
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Removing Drive Bay Cover 

1.3 Insert the CD-ROM drive inside the drive bay slowly and smoothly. 

 

Insert Drive 

1.4 Fit the CD-ROM drive with the locking mechanism, to let it fix it in its Bay. 

 

Insert Drive Slowly 
 

1.5 Connect the SATA power cable to the CD-ROM drive. 
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Connect SATA Cable 

1.6 Connect the other end of the SATA power cable to the power supply. 

 

Connect SATA Cable to Power Supply 

1.7 Connect the SATA data cable to the CD ROM drive. 
 

 

Connect Data Cable 
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1.8 Connect the other end of the SATA data cable to the motherboard. 

 

Connect Data Cable to Motherboard 

10. After installing the CD-ROM drive and the cables, close the CPU casing again. 

 

2. Installing Keyboard 

Installing PS/2 Keyboard 

2.1 Connect the keyboard to the PS/2 port on the back of the computer. 
2.2 At the back of the computer there are two PS/2 ports next to each other. Connect the keyboard into 

the purple connection. If the ports are same color, Look for a small symbol next to the port to identify 
what one is the keyboard. 
 

 

Keyboard PS/2 Port 

Installing USB Keyboard 

Connect the USB keyboard to the USB ports on the back or front of the computer. The computer will automatically 
(If win 7 installed) detect and install its drivers also. 
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Install Software and Drivers 

If the keyboard has any special features such as a built on touch pad or special buttons or is wireless, for these 
features to work properly, the software and drivers for the keyboard must be installed after the computer keyboard 
has been connected to the computer. 

 
3. Installing Mouse 

PS/2 Mouse 

3.1 Connect the mouse to the PS/2 port on the back of the computer.  
3.2 Connect the mouse into the teal or green connection. Or Look for a small symbol 
next to the port to identify which one is the mouse. 

 

 
USB Mouse 

Connect the USB mouse to the USB ports on the back or front of the computer. 

Keyboard port color 
is green and mouse 
port color is purple. 

Do you know! 
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4. Installing a Printer 

A printer does not work without driver. If driver is not available then it can be 
downloading from internet. 

 
 
Connecting the Printer to the Computer 

Connect the printer to the computer either using a USB cable, parallel port cable, or 
SCSI cable and then connect the power plug to a power outlet. 

 

Setup Printer and Install Software 

 
1. After everything has been plugged in turn the computer on. 
2. Insert the CD that came with the printer. If the CD does not automatically start, open My Computer, double-

click on the CD drive, and then click the Setup or Install file.  
3. If you have downloaded the drivers, run the downloaded setup file. 
4. Follow the installation wizard and once completed, the software is installed. 

 

If you do not see 
your printer in the 
printer’s list, your 
printer is not 
installed. 

Do you know! 
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Installed Printer 
 

Testing the Printer 

After the printer is installed, Windows is used to print a self-test page to verify the printer is working. 

1. Click Start, Settings, and open Control Panel. 
2. Double-click the Printers or Printers and Fax icon. 
3. Right-click on the Printer wanted to test and click Properties. In the Printers Properties window, click 

the Print Test Page button. 
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Test Print 

 
1. In case of successful installation of printer test page will be printed.  

 
2. Installing a Scanner 

Before scanning the documents into the computer with a scanner, it needs to install the scanner driver, so that 
scanner and computer can communicate. Start by connecting the scanner to computer’s USB port. Plug and 
Play, a technology that Windows uses to recognize equipment and automatically install and set it up. If a scanner 
is Plug and Play-enabled, Windows 7 shows a Found New Hardware message in the Taskbar notification. Most 
Plug and Play devices will then automatically install, the message will change to verify the installation is complete. 
But now most new peripherals are available with their driver’s installation CD. 

1. Turn on the scanner. 

2. Click the Found New Hardware message, click Yes, This Time Only, and then click Next again. 

(You only need to do this step if you don’t permit Windows 7 to automatically connect to Windows Update. 
Otherwise, you don’t see the Found New Hardware Wizard.) 

3.  Insert the driver’s CD in CD drive and click next. 
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(Windows 7 searches for your scanner driver software and installs it.) 

4. Click on start button in search bar type Add Device. 

5. Click the Add Device button and then click Next. 

(The Scanner and Camera Installation Wizard window appears. When you click Next, the next screen of the 
wizard appears.) 

 

Installing Scanner 
 

6. Click a Manufacturer in the list on the left and then click a model in the list on the right. 

(Now it’s just a matter of following the wizard directions based on the model of scanner you choose and 
whether you have a manufacturer’s disc (a CD- or DVD-ROM). If you don’t have a disc, Windows can help 
you download software from the Internet.) 

7. Click Finish when the wizard ends 

8. Now the installation is complete and scanner is ready to use 

 
 
3. Installing a Webcam 

 
1. Plug the webcam into a USB port of the computer.   
2. Wait for the webcam to be installed automatically. Most operating systems will automatically detect and 

install the necessary software for the webcam. If this doesn't happen, then it may be prompted to search 
for the webcam drivers. Operating system can usually search online automatically. 

3.  
4. Installing the Software on the Disc that Came with the Webcam: 

1. Put the CD into the drive. Open the CD ROM drive from My Computer. 

Installation of web 
cam manufactured 
by different 
companies may 
differ from these 
screen shots 

Remember 
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2. Double click on the Setup. 

 

 
5. A dialogue box will be open. Click on Run. 

 

 
 

6. The setup will be installed using wizard. Just click on Next, Next and the driver will be installed. 
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Installation Wizard 
 

7. The driver will be installed and the webcam is ready to use. 

 

Testing the Webcam 

1. Open a program that will use your webcam (Skype, yahoo messenger, Hangouts, etc.). This will allow you 
to see if your webcam is working properly. 
 

2. Open the Video Settings menu. The process for this, varies depending on the program you are using. In 
Skype, for example, click Tools and select Options. Click "Video settings". You will see an image from your 
webcam appear in the window. 
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Learner’s Activity 

 Install printer on your computer and print test page. 

 Install the driver of webcam and test it using Skype. 

 Install the CD ROM drive into your computer. Also remember safety precautions. Like plug out the 
Computer power cable before installation. And install the drive slowly. 
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Learning Unit 4: Install Software Applications 

Overview 

Application software is a type of software that can be used for a variety of tasks. It is 
not limited to one particular function. This learning unit covers different types of 
application software and procedure of installing software. After completion of this 
learning unit you will be able to describe various types of application software and how 
to install this software. 

1. Different Software Applications 

Application software is the software that is used at offices, home and school 
.Application software consists of programs like word processing, spreadsheets, 
Database, Graphics software, designed to perform specific tasks for users. Application 
software are used as a productivity/business tool, to assist with graphics and 
multimedia projects, that supports home, personal, and educational activities. Specific 
application software products, called software packages, are available from software 
vendors. Although application software also is available as shareware, freeware, and 
public-domain software, these usually have fewer capabilities than retail software 

packages. It provides many features like formatting text, creating charts, organizing table’s data, saving records. 

There are many reasons of using these software’s. 

1. It is very cheap. 
2. It is easily available from internet or computer shops. 
3. There will be lots of user support available for users like books, user guides, online help and discussion 

forums. 
 

Examples and Use of Application Software: 

1. Word Processing Software (Microsoft Word) 

Used for writing letter, applications, reports, memos etc. 

 

2. Spreadsheet Software (Microsoft Excel) 

Used for keeping simple company accounts, Employees salary calculations, simple stock control system. 

 

3. Database Software: (Microsoft Access) 

To create/prepare costumers database, Employees database, etc. 

 

4. Publishing Software ( MS Publisher) 

Used for designing posters, leaflets, business cards. 

5. Presentation Software (MS PowerPoint) 

Used for graphically representation of data. 

 

6. Graphics Software ( Adobe Photoshop, Corel draw) 

Used for retouching or manipulating images for business or personal use. 

 

 

Applications 
software also called 
end-user programs. 

Do you know! 

An application is a 
program, or group of 
programs, that is 
designed for the end 
user. 

Application  
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7. Web Design Software ( PHP, Adobe Dream Viewer) 

Develop/create personal or business websites. 

 

8. Entertainment Software 

Used for entertainment of the users like games and media players. 

 

2. Precautions for Installing Application Software 

 

1. Install the software which you really need. 

2. Check whether enough disk space or resources to run this software. 

3. Check is there any conflicting software on your computer. 

4. Always read online reviews about the software. 

5. Investigate the software developer or company and their reputation. 

6. Check out removal options before installing. 

7. Always create System Restore Point before installation. 

8. Always select Custom installation. 

9. Always uncheck installation of extras. 

10. Install to the default directory. 

11. Always uncheck installation of 3rd party toolbars, etc. 

12. Don't forget to select "Restart later" option at the end. 

3. Installing Microsoft Office 2010 

Step by Step Installation of Microsoft Office 2010: 

Installation of Microsoft office 2010 is very easy. If you running an earlier version of Office, such as Office 2007 
the process will also upgrade you to Office 2010. 

1. Insert the office 2010 DVD or double click on the downloaded setup.exe file, you will see the option 
 

 
 

Extracting Files 
 

2. Then a window will appear simply pop a tick in the accept license conditions and click continue. 
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Accepting License Agreement 

 
3. Then it will ask about the product key. 

 

 

Asking for Product Key 

4. Copy the product key from the text file given in the CD and paste it in the given box. Or if it is a downloaded 
setup the product key text file will be available with it. 
 

You can also 
download latest 
version MS office 
2013 trial version of 
90 days from 
Microsoft website. 

Remember 
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Giving Product Key 

5. You now get the option to run the default install or a custom install as seen below. 
 

 

Select Install Now 

6. Now the installation process will be start and it will take several minutes for completion of installation. 
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Processing Installation 

7. After this the completion of installation window will appear. 
 

 

Completing Installation 

Now the installation is completed and your software is ready to use. 
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Learner’s Activity 

 What are some examples of application software’s you have on your computer? 

 Install MS Office 2010 using CD/DVD on your computer. 

 Install VLC media player on your computer 
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Learning Unit 5: Update/ Upgrade Software Application 

Overview 

A software update means to enhance the capability, stability and features of an existing 
version of the software. Updates usually download free of cost while upgrading means 
replace an older version of the same product with the newer version. Typically, software 
upgrades available by software vendors at a discount to prevent users from switching 
to other products. This learning unit covers the procedure for updating software 
manually and upgrading a software using CD, searching and downloading software that 
are available online also describe different versions of software. After completion of this 

learning unit you will be able to demonstrate the procedure of installing updates and upgrades manually, 
automatically or from CD. 

1. Various Versions of Application Software 

Microsoft Office application Software: 

Microsoft Office is an office suite of desktop applications, servers and services for Microsoft's Windows and 
Apple's OS X operating systems. Over the years, Office applications have grown substantially closer with shared 
features such as a common spell checker, OLE data integration and Visual Basic for Applications scripting 
language.  

 

Version History of Microsoft Office: 

Microsoft Office for Windows 

Microsoft Office for Windows started in October 1990 as a bundle of three applications designed for Microsoft 
Windows 3.0, Microsoft Word for Windows 1.1. 

Microsoft Excel for Windows 2.0, and Microsoft PowerPoint for Windows 2.0. 

Microsoft Office for Windows 1.5 updated the suite with Microsoft Excel 3.0. 

Version 1.6 added Microsoft Mail for PC Networks 2.1 to the bundle.[66] 

 

Microsoft Office 3.0 

Microsoft Office 3.0, also called Microsoft Office 92, was released on 30 August 1992, contained Word 2.0, 
Excel 4.0, PowerPoint 3.0 and Mail 3.0. It was the first version of Office also released on CD-ROM. In 1993, 
The Microsoft Office Professional was released, which added Microsoft Access 1.1. It was look like this : 

Microsoft Office is 
an office suite of 
desktop 
applications. 

Remember 
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Layout of MS Office 3.0 

Microsoft Office 4.X 

Microsoft Office 4.0 was released containing Word 6.0, Excel 4.0a, PowerPoint 3.0 and Mail in 
1993.Microsoft Office 4.2 for Windows NT was released in 1994. Microsoft Office 4.2 (Standard Edition) and 
4.3 (Professional Edition) were released as the last 16-bit version and so the last to support Windows 3.x, 
containing Word 6.0, Excel 5.0, PowerPoint 4.0. Office 4.2 is the Standard Edition, 4.3 the Professional 
Edition, which also includes Access 2.0. 

 

Layout of MS Office 4.X 

Microsoft Office 95 

Office 95 was available in two versions, Office 95 Standard and Office 95 Professional. The standard version 
consisted of Word 7.0, Excel 7.0, PowerPoint 7.0, and Schedule+ 7.0. The professional edition contained all of 
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the items in the standard version plus Microsoft Access 7.0. If the professional version was purchased in CD-
ROM form, it also included Bookshelf. 

 

Layout of MS Office 95 

Microsoft Office 97 

Microsoft Office 97 (Office 8.0), included hundreds of new features and improvements, and introduced command 
bars, menus and toolbars. Office 97 also featured Natural Language Systems and grammar checking. Office 97 
was the first version of Office to include the Office Assistant. 

 

Layout of MS Office 97 

Microsoft Office 2000 

Microsoft Office 2000 (Office 9.0) introduced adaptive menus, where little used 
options were hidden from the user. It also introduced a new security feature, built 
around digital signatures, to diminish the threat of macro viruses.  

 

Office 2000 is the 
last version to 
support Windows 
95. 

Do you know! 
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Layout of MS Office 2000 

Microsoft Office XP 

Microsoft Office XP (Office 10.0 or Office 2002) was released in conjunction with Windows XP, and was a major 
upgrade with great enhancements and changes over Office 2000. Office XP introduced the Safe Mode feature, 
which allows applications such as Outlook to boot when it might otherwise fail. Safe Mode enables Office to 
detect and either repair or bypass the source of the problem, such as a corrupted registry or a faulty add-in. 
Smart tag is a technology introduced with Office XP. It was the first version to require Product Activation as an 
anti-piracy measure, which attracted widespread controversy. 

 

Layout of MS Office XP 

Microsoft Office 2003 

Microsoft Office 2003 (Office 11.0) was released in 2003. It featured a new logo. Two new applications made 
their debut in Office 2003: Microsoft InfoPath and OneNote.  

 

 

Layout of MS Office 2003 

2003 is the last 

Office version to 

support Windows 

2000. 

Do you know! 
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Microsoft Office 2007 

Microsoft Office 2007 (Office 12.0) was released in 2007. Office 2007's new features include a new graphical 
user interface called the Fluent User Interface, replacing the menus and toolbars that have been the cornerstone 
of Office since its inception with a tabbed toolbar, known as the Ribbon; It is the last version to support Windows 
XP and Server 2003. 

 

Layout of MS Office 2007 

Microsoft Office 2010 

Microsoft Office 2010 (Office 14.0, because 13.0 was skipped was finalized on 15 April 2010, The main features 
of Office 2010 include the backstage file menu, new collaboration tools, a customizable ribbon, protected view 
and a navigation panel. This is the first version to ship in 32-bit and 64-bit variants. Service Pack 1 for Office 
2010 was released on 28 June 2011. 

 

Layout of MS Office 2010 

 

Microsoft Office 2013 

A technical preview of Office 2013 was released on 16 July 2012, the interface is based on Metro, (the interface 
of Windows Phone and Windows 8). Microsoft Outlook has received the most pronounced changes so far; for 
example, the Metro interface provides a new visualization for scheduled tasks. PowerPoint includes more 
templates and transition effects, and OneNote includes a new splash screen. On 16 May 2011, new images of 
Office 15 were revealed, showing Excel with a tool for filtering data in a timeline, In Word, the capability of inserting 
video and audio online as well as the broadcasting of documents on the Web were implemented.  

On 24 October 2012, Office 2013 Professional Plus was released for download. On 15 November 2012, the 60-
day trial version was released for public download. 
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Layout of office 2013 

2. Precautions for Installing Updates of Software 

It is necessary to take precautions before installing updates or upgrade any software. 

1. Install updates from a CD or from any known and familiar/secure source. 
2. Check whether it is a spam or legal software. 
3. Before installing or upgrading software take a backup of your data to an external source or hard drive/ 

other drive (e.g. D, E). 
4. Check out removal options before installing. 
5. Always create System Restore Point. 
6. Always select Custom installation. 
7. Always uncheck installation of extras. 
8. Always uncheck installation of 3rd party toolbars, etc. 
9. Don't forget to select "Restart later" option at the end. 

 
 

3. Applications Available Online 

There are millions of software applications available online that can be easily downloadable, also many sites 
available on Google through which you can download these Software. Most famous of them are Filehippo.com, 
Google search, Softpedia.com, softonic.com and many more. These are the trusted sites for downloading 
software applications. There is less chance of malware or spam on it. 

 

For Searching Online Application Software:  

1. Open the browser 
2. Click on the address bar and type Google search or you can directly open the 

filehippo.com by typing www.filehippo.com OR www.google.com.  
 

In Ms office 2013 
edited documents 
can be saved as 
PDF  files also. 

Do you know! 

There are many 
other websites 
available for 
downloading 
software but these 
may not be trust 
worthy. 

Remember 

http://www.filehippo.com/
http://www.google.com/
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Searching for Online Applications 

 

3. The filehippo.com will be open. Here you can download most popular software and updates also. 
 

 

Checking for Software and Updates 

From this website you can download most commonly known software like fire fox, Opera, Google chrome, VLC 
media player, AVG antivirus, Skype, Adobe Reader and many more. You can also search for a specific 
website by typing the name of the software in its search bar which is given at the top of the page or you can 
search it in its category that are given below. It is a most popular website for online application software. 

 

Downloading any Application Software Online: 

Click on the desired software link that is required. For example download skype. 
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Downloading a Software 

A page will open here you can download the latest version or older version of the software also can check the 
specification and technical specifications about the software. 

 

Download a Software Latest or Older Version 

Download and install the desired software from this website by following these simple steps. 

 

 

 

 

First check the 
technical description 
and software 
vendors then 
download it. 

Remember 
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4. Upgrading a Software Application through CD 

Upgrading software through a CD/DVD is very easy here you can follow some steps to 
easily upgrade software. Now we are upgrading MS office 2010 from MS office 2010 
Trial version. For this purpose, here are some simple and easy steps to follow: 

1. Insert MS office 2010 CD/DVD in the CD/DVD ROM. 
2. Run the setup.exe file. 
3. A Dialogue box will appear. Check the License agreement box and click Next 
as like you do in installation process. 
4. Now click on Upgrade option. 
 

 
 

5. Now the installation will start. 
 

 

Installing Updates 

6. Now the installation is complete. Click on close button for finishing installation. 

If you can keep both 
older and newer 
versions of MS 
Office at the same 
time then don’t 
upgrade just install 
the software? 

Remember 
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Installing Updates Completed 

 

5. Installing Updates Manually or Automatically 

Software updates can also be installed manually, or automatically. For this purpose open the software which 
updates wanted to be installed. 

Here we are installing updates of Avast antivirus. 

 

Opening Avast Antivirus Application 

1. Click on the Settings options. Then click on Updates. 
 

Mostly antivirus 
software available 
free of cost but it 
provides limited 
features. 

Remember 
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Selecting Updates Option 

2. A window will appear click on Update and the update will be started. 
 

 

Updating Software 

3.  It can also set the option for Automatic updates in the settings options. 



 Module 1: Maintain Computer System 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 55 

 

Setting Automatic Updates 

Every software has its own settings for update but almost they are the same like the above procedure. 
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Learner’s Activity 

 Check out some of the application software online. 
 

 Upgrade any software through CD/DVD on your computer. 
 

 Manually update any software on your computer. 
 

 Install automatic update of any software on your computer. 
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Learning Unit 6: Perform Uninstallation of Software 

Overview 

The proper way to uninstall a program is to use the uninstall routine that is provided 
with the program itself. This will remove the files, Windows Registry information, and 
other configuration from your computer to avoid conflicts in future. This learning unit 
covers about basic precautions to un install a software application, how and where to 
take backup of necessary data files, also demonstrate various features of control panel 
and the procedure for uninstalling a software from the computer. 

1. Necessary Precautions for Uninstalling a Software 

Software must be un installed through a proper way it cannot be removed by deleting its icon from the computer 
or deleting its folder from windows because a large amount of information regarding configuration left in the 
Windows Registry as well as files that may be installed in locations other than the program's folder. These files 
and Registry data may cause conflicts on your computer thus leading to problems.  

2. Taking Backup of Necessary Files 

Backup is an important thing for computer users. There are a lot of ways for creating 
backups it can be created through windows backup or using different types of 
application software that provide backup facility . There are three common ways of 
creating backup. 

Local Backups 

It’s important to create local backups to an external drive or another computer. It is a quickest way to create 
backups. 

 
Windows Backup Feature 

Online Backup 

There are a number of paid online backup services like Spideroak, and Jungledisk, and there are also some 
file sync services like Dropbox and SugarSync that provide backup type of capability. These are all excellent 
secondary backup services, but probably shouldn’t replace a regular backup just because they will take a long 
time to restore. 

Some software 
create temporary 
files in windows. 

Do you know! 

Backup means 
creating an 
additional copy of 
your data for future 
use. 

Backup 

Don’t delete any 
installed software 
but always un-install 
it. 

Remember 



Module 1: Maintain Computer System 

58 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

System Image Backups 

Rather than simply backing up files, it can create a complete backup of your system that can be restored over 
top of your system. The only problem with creating these type of backups is that they require a lot of drive space. 
The best technique is to create an image when your system is up and running and everything is installed, and 
then you can use it to more easily restore everything rather than reinstalling everything manually. 

 

What Type of Files should be Backup 

The most important files to backup are probably your documents, pictures, music, and other user files, but they 
are not the only files that you need to backup.  

 

Documents: You should backup your entire documents folder all the time.  

 

Music: you should back up of your music if you paid lots of money for MP3 downloads, you’ll probably be sad to 
lose them. Make sure to include this folder. 

 

Pictures & Videos: The photos might not have actually cost anything, but you’ll probably be sadder about losing 
memories also. So include this folder also in backup. 

 

Other Files 

Some other files also have important data like desktop email software, bookmarks and application settings also 
be backed up for future use. 

3. Features Available In Control Panel 

The Control Panel is a part of the Microsoft Windows which allows users to view, configure and control basic 
system settings such as adding hardware, adding and removing software, controlling user accounts, and 
changing accessibility options.  

 

Features of Control Panel: 

There are many features available in control panel which are used for different purposes. There are eight major 
categories of these features. 
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Control Panel Features 

1. System and Security Category:  
This category contains all the tools that are used to perform system, administrative, and security related task. 

2. Network & Internet Security 
The Network and Internet category is the second one in the Control Panel and contains all the tools that are used 
to check the status of the network, change settings, set preferences for sharing files and computers, configure 
Internet connections, and much more. 
 

3. Hardware and Sound   
This category contains all the tools that are used to add and remove printers and other hardware, change system 
sounds, configure AutoPlay, manage power, update drivers, and more. 

4. Programs Category  
This contains all the tools that are used to uninstall programs or Windows features, manage gadgets, and more. 

 

5. User and Family Safety    
This contains all the tools that are used to change user account settings and passwords, set up parental controls, 
manage credentials, and more. 

 

6. Appearance and Personalization   
This category contains azll the tools that are used to change the appearance of 
desktop items, apply various desktop themes, screen savers, and customize the 
Start menu or Taskbar, and more. 
 
 

7. Clock, Language and Region Settings   
The Clock, Language, and Region category is the seventh one in the Control Panel 
and contains all the tools that are used to change date, time, language, numbers, 
currency, and more 

 

 
 

From where in the 
control panel you 
can apply password 
on your account?? 

Do you know! 

You can apply 
Parental controls 
from control panel to 
prevent children 
from restricted 
computer over 
usage. 

Remember 
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8. Ease of Access Center 
The Ease of Access category is the eighth one in the Control Panel and contains all 
the tools that are used to adjust your computer settings for vision, hearing, and mobility 
as well as configure speech recognition to control your computer with voice 
commands. 

 

4. Procedure for Uninstalling a Software 

 
1. Click on start button. 
2. Click on control panel. 
3. Click on programs and features. 
4. Select a program, and then click Uninstall. Some programs include the option to change or repair the 

program in addition to uninstalling it, but many simply offer the option to uninstall. To change a program, 
click Change or Repair. 

 

 

Uninstalling a Software 

5. A dialogue box will appear for uninstallation. 
 

Uninstall software 
using Program and 
features option from 
control panel. 

Remember 

How many 
languages are 
available with 
windows 7?? 

Do you know! 
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Completing Uninstalling a Software 

6. Then another dialogue box will appear for asking Do you want to remove History. 
 

 
 

7. Click on Yes. 
8. Then click on OK. 

 

 

Recheck the Programs and Features window, you will find the updated list without this uninstalled software. 
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Learner’s Activity 
 

 Count & list the major features that are available in Control panel? 
 

 Change the Date and time of your computer? 
 

 Uninstall any unwanted software from computer? 
 

 Change the background of your computer? 
 

 Check and list the installed hardware in your computer?? 
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Learning Unit 7: Perform Windows Scan 

Overview 

Scanning a computer means detect viruses and malwares from the computer. 
Computer viruses are small software programs that are designed to spread from one 
computer to another and to interfere with computer functioning. There are many types 
of viruses like Trojan horses, direct viruses, overwrite viruses, booting viruses. This 
learning unit covers windows scanning procedure and various types of virus attack. 
After completion of this learning unit you will be able to demonstrate different types of 
viruses, Antivirus software programs and the procedure of scanning to secure your 
system and data.  

1. Precautions to be taken to Perform Windows Scanning 

Before performing windows scan the Users should take reasonable precautions to 
protect the files on their computers, and to protect data as it transits the Internet. 

All users should take the following basic precautions: 

 Create back up of important files before scanning. 

 Use a registered virus scanner on computer. 

 Regularly check for, download, and Install security patches from the vendors of the software. 

 Use a backup of electricity, like using UPS or stand by generator so that there is no disturbance of electricity 
during scanning. 

 Always use updated virus scanner, if it is not then update it before scanning. 

 Don't open suspicious e-mails, especially attachment without scanning. 

 Scan your computer for viruses on a regular basis, such as once per week. 

 Create a strong password or phrase. 

2. Types of Viruses and Spam 

What is Computer Virus? 

Computer viruses are small software programs that are designed to effect the 
files/programs, spread from one computer to another and to interfere with computer 
functioning. A virus might corrupt or delete data on the computer, or even erase 
everything on the hard disk. 

Computer viruses are often spread by attachments in e-mail messages or instant 
messaging. That is why it is essential that never open e-mail attachments unless don’t 
know who it's from.  

Viruses can be disguised as attachments of funny images, greeting cards, audio or 
video files. Computer viruses also spread through downloads on the Internet, or from 

Internet surfing and 
Emails are the main 
source of viruses so 
be aware of emails 
asking for personal 
information. 

Do you know! 

A computer virus or 
malware is a 
commonly used 
term to describe all 
types of malicious 
software including 
Trojans, worms, 
adware, and 
spyware. 

Virus 

Keep your virus 
detection software 
up to date to avoid 
from viruses attack. 

Remember 
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USB flash data traveler. They can be hidden in illicit software or other files or programs that might download. 

Most Common Types of Viruses and Other Malicious Programs 

 

1. Direct Viruses 

The main purpose of this virus is to replicate and take action when it is executed. When a specific condition is 
met, the virus will go into action and infect files in the directory or folder that are specified in the AUTOEXEC.BAT 
file PATH. This batch file is always located in the root directory of the hard disk and carries out certain operations 
when the computer is booted. 

 

2. Overwrite Viruses 

This Virus deletes the information contained in the files that it infects, rendering them 
partially or totally useless once they have been infected. 

The only way to clean a file infected by an overwrite virus is to delete the file completely, 
thus losing the original content. 

Examples of this virus include: Way, Trj.Reboot, Trivial.88.D. 

 

3. Booting Viruses 

This type of virus affects the boot sector of a floppy or hard disk. This is a crucial part of a disk, in which information 
on the disk itself is stored together with a program that makes it possible to boot (start) the computer from the 
disk. 

The best way of avoiding boot viruses is to ensure that floppy disks are write-protected and never start your 
computer with an unknown floppy disk in the disk drive. 

Examples of boot viruses include: Polyboot.B, AntiEXE. 

 

4. Resident Viruses 

This type of virus is a permanent which resides in the RAM memory. From there it can interrupt all of the 
operations executed by the system: corrupting files and programs that are opened, closed, copied, renamed etc. 

Examples include: Randex, CMJ, Meve, and MrKlunky. 

 

5. Multipartite Viruses 

Multipartite viruses are distributed through infected media and usually hide in the memory. Gradually, the virus 
moves to the boot sector of the hard drive and infects executable files on the hard drive and later across the 
computer system. 

 

One method of 
computer virus 
infection is "joke" 
programs. 

Remember 
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6. Macro Viruses 

Macro viruses infect files that are created using certain applications or programs that contain macros. These 
mini-programs make it possible to automate series of operations so that they are performed as a single action, 
thereby saving the user from having to carry them out one by one. 

Examples of macro viruses: Relax, Melissa.A, Bablas, O97M/Y2K. 

 

7. Directory Viruses 

Directory viruses change the paths that indicate the location of a file. By executing a 
program (file with the extension .EXE or .COM) which has been infected by a virus, are 
unknowingly running the virus program, while the original file and program have been 
previously moved by the virus. Once infected it becomes impossible to locate the 
original files. 

 

8. Polymorphic Viruses 

Polymorphic viruses encrypt or encode themselves in a different way using different algorithms and encryption 
keys every time they infect a system. 

This makes it impossible for anti-viruses to find them using string or signature searches and also enables them 
to create a large number of copies of themselves. 

Examples include: Elkern, Marburg, Satan Bug, and Tuareg. 

 

9. File Infectors 

This type of virus infects programs or executable files (files with an .EXE or .COM 
extension). When one of these programs is run, directly or indirectly, the virus is 
activated, producing the damaging effects it is programmed to carry out. The majority 
of existing viruses belongs to this category, and can be classified depending on the 
actions that they carry out. 

 

10. Encrypted Viruses 

This type of viruses consists of encrypted malicious code, decrypted module. The 
viruses use encrypted code technique which make antivirus software hardly to detect 
them. The antivirus program usually can detect this type of viruses when they try spread 
by decrypted themselves. 

 

11. Companion Viruses 

Companion viruses can be considered file infector viruses like resident or direct action types. They are known as 
companion viruses because once they get into the system they "accompany" the other files that already exist. In 
other words, in order to carry out their infection routines, companion viruses can wait in memory until a program 
is run (resident viruses) or act immediately by making copies of themselves (direct action viruses). 

Spyware is 
computer software 
that is unknowingly 
installed on a 
personal computer 
to collect information 
about a user. 

Do you know! 

Adware or 
advertising-
supported software 
is any software 
package which 
automatically plays, 
displays, or 
downloads 
advertisements to a 
computer after the 
software is installed 
on it 

Do you know! 
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12. Network Virus 

Network viruses rapidly spread through a Local Network Area (LAN), and sometimes throughout the internet. 
Generally, network viruses multiply through shared resources, i.e., shared drives and folders. When the virus 
infects a computer, it searches through the network to attack its new potential prey. When the virus finishes 
infecting that computer, it moves on to the next and the cycle repeats itself. 

The most dangerous network viruses are Nimda and SQLSlammer. 

 

13. Nonresident Viruses 

This type of viruses is similar to Resident Viruses by using replication of module. 
Besides that, Nonresident Viruses role as finder module which can infect to files when 
it found one (it will select one or more files to infect each time the module is executed). 

 

 

14. Stealth Viruses 

Stealth Viruses is some sort of viruses which try to trick anti-virus software by intercepting its requests to the 
operating system. It has ability to hide itself from some antivirus software programs. Therefore, some antivirus 
program cannot detect them. 

 

15. FAT Viruses 

The file allocation table or FAT is the part of a disk used to connect information and is a vital part of the normal 
functioning of the computer.  

This type of virus attack can be especially dangerous, by preventing access to certain sections of the disk where 
important files are stored. Damage caused can result in information losses from individual files or even entire 
directories. 

 

16. Worms 

A worm is technically not a virus, but a program very similar to a virus; it has the ability 
to self-replicate, and can lead to negative effects on your system and most importantly 
they are detected and eliminated by antiviruses. 

Examples of worms include: PSWBugbear.B, Lovgate.F, Trile.C, Sobig.D, Mapson. 

 

17. Trojans or Trojan Horses 

Another unsavory breed of malicious code (not a virus as well) are Trojans or Trojan horses, which unlike viruses 
do not reproduce by infecting other files, nor do they self-replicate like worms. These are used to steal user 
information and sometimes take control of your computer. 

 

A computer worm is 
a self-replicating 
computer program. 
It uses a network to 
send copies of itself 
to other computers 
on the network. 

Do you know! 

Trojans allow an 
outside user to copy 
your files, see your 
browsing history, or 
even take remote 
control of your 
computer. 

Do you know! 
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18. Logic Bombs 

They are not considered viruses because they do not replicate. They are not even programs in their own right 
but rather camouflaged segments of other programs. 

Their objective is to destroy data on the computer once certain conditions have been met. Logic bombs go 
undetected until launched, and the results can be destructive. 

3. Types of Registered Scanning Software 

Most Commonly Used Registered Antivirus Programs: 

There are many types of registered scanning software mentioned below: 

 

1. AntiVir Personal  

AntiVir by Avira is a light-weight antivirus program offering fast detection of malware. It supports netbooks and is 
compatible with Windows 2000, XP, Vista, and Windows 7. The free edition of AntiVir is lacking an important 
protection- defense against known rogues and malicious URLs. Such web protection is only available to paid 
customers of AntiVir. Free AntiVir will only protect your browsing if the site you have visited websites has malicious 
content or when you download a known rogue or malware instead of blocking the rogue/malware sites. AntiVir 
Premium edition is offering more features and protection.  

 

2. NOD32 

NOD32 is a powerful antivirus program that offers real-time protection against online 
threats. The program includes features such as Social Media Scanner, Exploit Blocker, 
Advanced Memory Scanner, Anti-Phishing, Antispyware, Device control and Gamer 
Mode. 

 

 

3. Norton  

Norton Security is the present name of the famous Norton Antivirus. It combines Norton Antivirus and Norton 
Internet Security to provide with protection from viruses, Internet threats, identity theft, and financial scams. This 
application is also available for smartphones, protecting them from unwanted access to our messages, contacts 
and photos. 
 

4. Avast 

Avast provides boot-time scanner, Network Shield, and e-mail. The detection capability of AlwilAvast! is very 
good and you can install the program in any edition of Windows. The installer of Avast is bundled with Google 
Chrome browser that is not necessary to continue using the antivirus program. Avast is available as freeware 
and paid editions. The free edition is lacking script blocker, push updates, the enhanced user interface, repairing 
of executable infected files, and antivirus tasks creation. The current UI of Avast is not attractive but Alwil, the 
maker of Avast, is planning to release a better UI in the upcoming v5. 

 

 

Some virus is so 
dangerous that it 
make the antivirus 
software also a 
virus. 

Remember 
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5. BitDefender 

Windows Defender is the well-known security tool from Microsoft that protects system and data against spyware 
and other malicious applications. Formerly named “Microsoft AntiSpyware”, Windows Defender is included by 
default in the latest 3 Windows editions (Vista, 7 and 8) and can be downloaded and installed separately on 
Windows XP and Windows 2003. 

 

6. KasperSky 

Kaspersky Internet Security protects computer against Internet threats. It also includes the traditional real-time 
anti-virus scanning. The application provides additional layers of protection during financial transactions, such as 
online banking and shopping, and also while using payment systems. 

 

7. Microsoft Security Essentials  

Microsoft Security Essentials is one of the most popular anti-malware programs. It can be installed for free in a 
licensed copy of Windows XP, Vista, or Windows 7. In Windows 8, Security Essentials is replaced with Windows 
Defender. For previous versions, Windows Defender works only as an anti-spyware. 

 

8. CalmWin 

Clamwin is the Windows version of ClamAV, the main Linux anti-virus on the market. ClamWin is flawed in many 
ways: it simply scans instead of offering real-time protection, it doesn’t really do non-virus malware and it’s not 
exactly easy to use. Still, having ClamWin around doesn’t cost anything, and can never have enough scanning 
tools. 

 

9. McAfee 

McAfee Security Scan Plus, and its predecessor McAfee Security Scan, are free diagnostic tools for systems that 
allow to simply and easily checking anti-virus software, firewall protection, and web security status on computer. 
This tool runs as a compliment to any existing security software and does not negatively impact the performance 
of computer. 

 
 

10. ESET Smart Security 

ESET Smart Security is an anti-virus program with features such as personal firewall and anti-theft. The personal 
firewall protect data while browsing through a public WiFi hotspot. The anti-theft feature lets you track and locate 
missing/stolen laptop. Also, the Internet security feature protects from fake sites. 

 

11. Malware Bytes 

Malwarebytes Anti-Malware is most popular anti-malware solution. First of all, it’s reliable. It’s a well-known fact 
that even security professionals resort to using Malwarebytes Anti-Malware in order to accurately detect, block 
and remove threats. 
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12. Symantec Antivirus 

Symantec Antivirus provides scalable, secured virus protection for workstations and network servers throughout 
the enterprise. Enhanced security features plus centralized policy management enable administrators to manage 
client and server groupings logically. In addition, administrators can create, deploy, and lock down security 
policies and settings to keep systems up-to-date and properly configured at all times. 
 
 

4. Procedure for Error Free Scanning of Windows 

It is very easy to scan windows from viruses.  

1. First of all download and install a registered Antivirus program from a trusted website.(Here we are installed 
Avast ) 
 

 
 

Download and Install Antivirus 
 

2. Update your anti-virus/anti-malware software installed on your computer. 
3. Before running a virus scan or malware scan, it needs to make sure the virus definitions are up to date. These 

regular updates tell antivirus software how to find and remove the latest viruses from computer. 
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Update Antivirus and Virus Definition 
 

4. Run a complete virus scan on entire computer. If you have a dedicated malware scanner that does more 
than look for viruses, run a full scan using that program. 
 

 

Perform a Full System Scan 

5. This will take time for scanning the whole computer. It depends on your data. If you have large amount of 
data then it will take several minutes to complete scan process. 
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Scanning Process 

6. If there is any virus detected then it will shows the virus select and apply the desired operation which you 
want to apply on viruses. 
 

 
 

Apply Action for Viruses 
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Learner’s Activity 
 

 Search for installed antivirus software in your computer and write its name.  
 

 Search some of the different free antivirus programs that are available on internet 
 

 Install any latest antivirus and scan your computer from viruses. 
 

 Take backing up your data on computer? 
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Learning Unit 8: Format External Mass Storage 

Overview 

External Mass storage is the device that is attached to the computer data storage and 
can be removed easily without opening the computer. Several types of mass storage 
devices available, including hard drives, optical disks, floppy disks, flash drives, and 
other pieces of technology such as secure digital (SD) cards (memory cards). Most 
types of storage devices can be used to store any type of file. This learning unit covers 
the procedure for formatting external mass storage devices like Flash drive, memory 
card etc. After completion of this learning unit you will be able to demonstrate the types 
of mass storage devices and their formatting. 

1. Precautions for Formatting External Mass Storage 

Before formatting any external mass storage device there are some precautions need 
to follow:  

1. Create a backup of your files on external mass storage data at a secure place 
depends on data size that the drive will carry. 

2. Scan the external storage with scanning software for avoiding malware or 
viruses. 

3. Create archives of the device so that large amount of data can compress into 
a single file for future use after formatting. 

2. External Mass Storage Devices 

Several different types of mass storage devices available, including hard drives, optical disks, floppy disks, 
flash drives, and other pieces of technology such as MP3 players and secure digital (SD) cards. Most types 
of storage devices can be used to store any type of file, but the ones in MP3 players can only display certain 
types of file if not connected to a computer. All of the mass storage devices require a computer to function 
properly, because a computer is needed to move files to and from the storage devices. 

 

Hard Drives: 

Hard drives are the most common types of mass storage devices. Almost every computer has at least one 
hardware installed inside the CPU casing. The scan disk offer a large amount of memory which can be accessed 
easily by the user. Universal serial bus (USB) portable hard drives are also available, which offer the storage of 
a hard drive in a more transportable form. Most hard disk drives use magnetic discs which store data on these 
magnetic discs. 

 

 

 

 

Don’t plug in your 
USB storage to any 
unknown computer, 
and don’t plug any 
external device to 
your computer 
without scanning. 

Remember 

 

Hard Disk 
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Optical Disks: 

Optical disks are commonly used storage devices. An optical disk is better known to 
most people as a compact disk (CD) or digital versatile disk (DVD), which has data 
"burned" onto it by a laser. Most computers provided with a CD/DVD drive which can 
also write data onto the optical storage devices.  

 

Floppy Disks: 

Floppy disks are an older class of mass storage devices, and while some computers 
can still play them, optical disks are much more popular. The memory of floppy disks 
is considerably lower than that found on optical disks and hard drives, but they are 
generally much cheaper to purchase and easily portable. Another advantage of floppy 
disks is they are universal, but they unfortunately run quite slowly, especially when 
compared to other devices. 

 

SD Cards /Memory Cards: 

Most digital cameras and smart phones use SD cards, which can feature a large 
amount of storage space, at least surpassing that of a CD or DVD. SD cards can 
usually display photographs and videos when plugged into a digital camera smart 
phone. 

 

Flash Drive: 

USB flash drives are often used for the same purposes, for which floppy disks or CDs 
were used, like for storage, data backup and transfer of computer files. They are 
smaller, faster, have thousands of times more capacity then floppy, and are more 
durable and reliable. 

 
 

3. Formatting a Mass Storage Device 

If you want to format your USB flash drive or flash memory card, you can follow these steps: 

1. Plug USB flash drive or memory card into the USB slot of computer. 

Normally your system should find it as a removable disk drive automatically. 

2. Open "My Computer" and right click the removable disk drive just inserted. 

 

Optical Disk 

 

 

Floppy Disk 

 

SD Card 

 

Flash Drive 
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Selecting USB Drive 

3. Click "Format" on the menu that pops up. 

 

Drive Options 

4. A dialogue box named "Format Removable Disk" should appear. 

Before formatting of 
a drive check the 
drive size if you 
have connected 
more than one 
removable devices. 

Remember 
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If you want to Perform Thorough Formatting 

Click the box next to "Quick Format" for quickly formatting the drive. You will still have access to all of the free 
space after formatting, but the original information will not be securely deleted, meaning it could possibly be 
retrieved. 

 

If you want to Perform Thorough Formatting 

5. Select "FAT 32" under the File System and make sure Quick Format is not 
selected. (If you are not sure, just leave all the selections as default.) 

6. Click the "Start" button. 

7. A pop-up will inform you that the format action will erase all the data in the flash 
memory. Make sure you want to erase all data on the disk before you click OK. The 
formatting process will start once you click "OK". 

 

File Allocation 
Table is a primary 
computer file 
system for various 
operating systems, 
mostly DOS, 
including DR-DOS, 
OpenDOS, 
freeDOS, MS-DOS, 
Microsoft Windows. 

FAT 

NTFS is the standard 
file system of Windows 
NT, including its later 
versions Windows 
2000, Windows XP, 
Windows Vista, 
Windows Server 2003, 
and Windows Server 
2008, Windows 7 and 
Windows 8. 

NTFS 



 Module 1: Maintain Computer System 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 77 

8.  Formatting will Complete after some Time. 

  

9. Now the Flash drive is ready to use. Check that the drive is empty now. 

 

  

Flash drive is a big 
source of inserting 
viruses into the 
computer. So 
always scan before 
opening it.  

Remember 
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Learner’s Activity 
 

 Compare different types of external mass storage devices like USB flash, external hard drive. 
 

 Format a USB flash drive. 
 

 Format a SD card /memory card according to given manual steps. 

 

  



 Module 1: Maintain Computer System 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 79 

Learning Unit 9: Troubleshoot Basic Software Errors 

Overview 

Software troubleshooting is the process of scanning, identifying, diagnosing and 
resolving problems, errors and bugs in software. The software troubleshooting process 
starts with identifying the problem, checking on possible issues that can cause such 
problems and then working on measures and alternatives to find a solution. This 
learning unit covers that what is software troubleshooting, describe the general 
software errors like computer bug, track or path corruption also will demonstrate the 
precautions about software troubleshooting. After completion of this learning unit, you 
will be able to describe what is software troubleshooting also will be able to troubleshoot errors in software. 

1. Software Troubleshooting 

Software troubleshooting is generally done to resolve technical problems in software. The software 
troubleshooting process starts with identifying the problem, checking on possible issues that can cause such 
problems and then working on measures and alternatives to find a solution. 

Typically, issues are resolved by a software developer or tester that reviews and 
optimizes software, removing bugs and errors from the source code. Software vendors 
also help in software troubleshooting by publishing periodic updates/patches for 
software, which can help in ensuring smooth software operation. Software 
troubleshooting can also be done when software needs to be configured correctly, such 
as resolving issues due to incorrect installation or restoring software after corruption or 
file deletion caused by a virus. 

There are many ways of troubleshooting software errors like Windows scan, windows optimizer, compress disk, 
disk defragmenter using control panel in windows. For troubleshooting common problems using windows: 

 

Troubleshooting Common Errors in Windows: 

Troubleshooting using Control Panel contains several troubleshooting programs that can automatically fix some 
common problems with computer, such as problems with networking, hardware and devices, using the web, and 
program compatibility. 

Although troubleshooters aren't designed to fix every problem, they are useful to often save your time and efforts. 

1. Open Troubleshooting by clicking the Start button then clicking Control Panel, and then, under System 
and Security, click Find and fix problems. 

Troubleshooting is 
done for smooth and 
error free working of 
computer. 

Remember 

Software 
troubleshooting 
means detecting 
and removing 
software errors. 

Software 

Troubleshooting 
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Troubleshooting Using Windows 

Troubleshooters can find and fix a variety of common problems 

When you run a troubleshooter, it might ask you some questions or reset common settings as it works to fix the 
problem. If the troubleshooter fixed the problem, you can close the troubleshooter. If it couldn't fix the problem, 
you can view several options that will take online to try and find an answer.  

2. General Software Errors or Bugs 

A software bug or error is a problem causing a program to crash or produce invalid 
output. A bug can be an error, mistake, defect or fault, which may cause failure from 
expected results. 

Most bugs are due to human errors in source code or its design. A program is said to 
be buggy when it contains a large number of bugs, which affect program functionality 
and cause incorrect results. 

Following are the most common software errors. 

 

Types of Errors with Examples: 

User Interface Errors: 

User interface errors creates Missing/Wrong Functions, the interface doesn’t know what the user expects.it 
generates Missing or Confusing information, Wrong content in Help text, Inappropriate error messages. 
Performance issues and Poor responsiveness. It is due to inappropriate use of key board.  

 

Boundary Related Errors: 

Boundary related errors generate within Boundaries in loop, space, time, memory, mishandling of cases outside 
boundary. 

 

Some bugs are so 
harmful that it 
corrupts the 
computer Hard disk 
tracks and boot 
sector. 

Remember 



 Module 1: Maintain Computer System 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 81 

Calculation Errors: 

Calculation errors generates due to Bad Logic, Bad Arithmetic, Outdated constants, Calculation errors, Incorrect 
conversion from one data representation to another, Wrong formula, Incorrect approximation.  

 

Control Flow Errors: 

Control flow errors generate due to Wrong returning state, Stack underflow/overflow, Failure to block or unblock 
interrupts, Comparison sometimes yields wrong result, Missing or wrong default and  Data Type errors.  

 

Hardware Produced Errors: 

There Errors generates due to Wrong Device, Device unavailable, Wrong operation or instruction codes.  

 

Path or Track Corruption of Hard Disk: 

Sometimes hard disk generates errors due to path or track corruption. It is due to some sever type of viruses or 
hard disk damages. Or when:  

1. User switches off (or resets) PC without shutting down properly. 
2. User attempts shutdown, but shutdown fails to complete. 
3. Power fails, or is accidentally switched off. 
4. PC spontaneously resets (e.g. bad power or power supply) 
5. Computer crashes or locks up, so that shutdown is impossible 

 

Simple Solutions to Common Computer Errors: 

Most of the time, problems can be fixed using simple troubleshooting techniques, like 
closing and reopening the program. It's important to try these simple solutions before 
resorting to more extreme measures. If the problem still isn't fixed, try other 
troubleshooting techniques. 

 

Problem: An Application is Running Slowly: 

Solution 1: Close and reopen the application. 

Solution 2: Update the application. To do this, click the Help menu and look for an option to check for 
Updates. If don’t find this option, another idea is to run an online search for application updates. 

 

Problem: An Application is Frozen: 

Sometimes an application may become frozen. When this happens, you won't be able to close the window or 
click any buttons within the application. 

Solution 1: Force quit the application. On a computer, Press (and hold) Ctrl+Alt+Delete on keyboard to open 
the Task Manager. 

Restarting a 
computer when it is 
slowdown is a good 
way to enhance its 
performance. 

Do you know! 
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 Select the unresponsive application and click End task. 
 

 

Using Task Manager 

Solution 2: Restart the computer. If you are unable to force quit an application, restarting computer 
will close all open apps. 

Problem: All Programs on the Computer Run Slowly: 

Solution 1: Run virus scanner. It may have malware running in the background that is slowing down the 
system. 

Solution 2: Computer may be running out of hard drive space. Try deleting any files or programs that you don't 
need. 

Solution 3: If using a PC, run Disk Defragmenter (called Optimize Drives in Windows 8). Doing so will make 
sure all pieces of each file or program are stored close together in your computer, so the computer will be able 
to access them more quickly. 

Sometimes 
computer runs 
slowly because of 
low memory space 
also for example 
when RAM is not 
working properly. 

Remember 
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Disk Defragmenter 

3. Applying Precautions for Troubleshooting Errors and System Testing and 
Structural Testing 

Precautions for Troubleshooting Errors 

There are many causes of errors in computer system. Some errors are related Windows operating systems and 
others just come with everyday use like creating and deleting files, adding and removing programs, and attaching 
printers, cameras and other devices. To get rid of all these errors you need to apply some precautionary 
measures : 

 Install updates of software at regular basis. This will help in reducing errors of computer. 

 Check the devices before installing and using it because hardware errors also disturb the working of 
computer. 

 Use Virus scan, anti-malware, for scanning viruses from computer at regular basis. 

 Create backup regularly and before repairing any software error. 

 There are many types of testing are used for software checking some of them are used by software 
developers and analyst like system testing ,structural testing. Others can be used by users like 
windows help etc. 

 You can also use web for online help if there is a complex type error occur in computer. 
  

What is System Testing? 

System testing means testing of the entire software. The main purpose of system testing is to detect whether the 
software meets its requirements or not. System testing is used to verify the working of the whole system all 
together. System testing involves both functional and nonfunctional testing. 

The formation about testing an integrated system to check that it meets or follows requirements that are specified 
is known as system testing. 
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Basic Purpose of System Testing is to: 

1. Ensure that a system or application meets its specification and any non-
functional requirements (such as stability and throughput) also meet the requirements 
with its users. 
 
2. Comprise a different tests series to fully exercise the computer-based system. 
 
3. Confirm an application's or system accuracy and completeness in performing 
the designed functions. 
 
 
 

 
What is Structural Testing: 

The structural testing is the testing of the structure of the system or component. 

 In structural testing the testers are required to have the knowledge of the internal 
implementations of the code. Here the testers require knowledge of how the software 
is implemented and works. 
 

 During structural testing the tester is concentrating on how the software does it. 
For example, a structural technique wants to know how loops in the software are 
working. Different test cases may be derived to exercise the loop once, twice, and many 
times. This may be done regardless of the functionality of the software. 

 

 Structural testing can be used at all levels of testing. Developers use structural testing in component testing 
and component integration testing, especially where there is good tool support for code coverage. 
Structural testing is also used in system and acceptance testing, but the structures are different. 

 
 
 

How to Use Windows Help : 

At some point, you're likely to stuck into a computer problem or confusing task. To figure it out, you'll need to 
know how to get the right help. 

 Using Windows Help and Support: 

Windows Help and Support is the built-in help system for Windows. It's a place to get quick answers to common 
questions, suggestions for troubleshooting, and instructions for how to do things. If you need help with a program 
that's not part of Windows, you'll need to consult that program's Help. 

 To Open Windows Help and Support: 

Click the Start button, and then click Help and Support. 

 

Get the Latest Help Content: 

If you're connected to the Internet, make sure Windows Help and Support is set to Online Help. Online Help 
includes new Help topics and the latest versions of existing topics. 

1. Click the Start button, and then click Help and Support. 
2. On the toolbar in Windows Help and Support, click Options, and then click Settings. 

System testing is a 
testing of entire 
software working 
and structural 
testing is about the 
structure of the 
software that how it 
is implemented. 

System Testing 

Windows Help and 
Support is one of the 
best features for 
troubleshooting 
errors. 

Remember 
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3. Under Search results, select the Improve my search results by using online Help (recommended) check 
box, and then click OK. The words Online Help will be displayed in the lower-right corner of the Help 
and Support window when you are connected. 

 Search Help: 

The fastest way to get help is to type a word or two in the search box. For example, to 
get information about wireless networking, type wireless network, and then press Enter. 
A list of results appears, with the most useful results shown at the top. Click one of the 
results to read the topic. 

 

Getting Help with Windows 

 Getting Help with a Program: 
Almost every program has its own built-in Help system. 

1. To open a program's Help system: 
2. On the Help menu of the program, click the first item in the list, such 

as "View Help," "Help Topics," or a similar phrase. (This text will 
vary.) 

3. Click the Help button. 
 
 
 

You can also access 
Help by pressing F1. 
This function key 
opens Help in 
almost any program. 

Do you know! 

Almost every 
program provides 
built in Help feature 
about that specific 
software. 

Remember 
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 Using Web Resources: 

The web contains a vast amount of information, so there's a good chance that the answer to your question lies 
somewhere in those billions of webpages. 

If you don't find what you need using a general search, consider searching websites that focus on Windows or 
computer problems. Here are four good places to look: 

 

Windows Website. This website provides an online version of all Help topics in this version of Windows, plus 
instructional videos, in-depth columns, and other useful information.  

 

Microsoft Help and Support. Discover solutions to common problems, how-to topics, troubleshooting steps, 
and the latest downloads 

 

Microsoft TechNet. This site includes resources and technical content for information technology professionals.  
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Learner’s Activity 
 

 Write the steps you will take if a program on a computer is completely unresponsive. 
 

 Write your last initiative to resolve the issue if you've tried everything and the problem still isn't fixed. 
 

 Write the difference between System testing and structural testing? 
 

 Set windows help to troubleshoot the software errors and write the steps you have followed in 
troubleshooting? 
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Learning Unit 10: Troubleshoot Basic Hardware Faults 

Overview 

There are many types of hardware faults occurs when uses a computer like computer 
doesn’t start  due to power cable, mouse or keyboard failure, printer or scanner doesn’t 
work properly. Finding and removing these hardware faults is called Hardware 
troubleshooting. This learning unit covers the basic hardware faults; it also covers the 
procedure for defining and troubleshooting of these faults. After completion of this 
learning unit, you will be able to demonstrate the basic hardware faults and able to 
troubleshoot and maintain your computer. 

1. Basic Hardware Faults 

Computer is an electronic machine and every machine needs proper maintenance and 
care if you don’t do this the computer hardware faults occur which causes many 
problems. There are many types of hardware faults occurs due to improper connectivity 
or failure of the devices. 

 A computer doesn’t start due to power cable failure or improper connectivity. 

 Mouse or keyboard doesn’t work properly. 

 Printer doesn’t start or work. 

 Scanner or any other connecting device doesn’t work properly. 

 Monitor or LCD doesn’t give display. 

 A hard drive failure occurs. 

2. Troubleshooting Hardware Faults 

Troubleshooting an Unresponsive Computer: 

 First check the cable. Unplug it from the computer and the outlet. Re-plug in both sides and try booting 
it again. 

 Check the wall outlet. Plug something else into the outlet and see if it works. 

 Turn off the system and wait 30 seconds and then try again. 

 Look at the keyboard for the indicator lights being lit up as the machine boots. 

 Sometimes the monitor has something to do with the system acting up. Unplug the power cord from the 
monitor and the wall and re-plug it. Unplug the cable from the computer to the monitor and re-plug it into 
the monitor. Try rebooting. 

 Listen to identify a beeping series if there is one to report it to the technical help. 

 

Startup Troubleshooting: 

If your computer is making noise or attempting to start up, but there is no video or no display on the 
monitor. Or there are No power lights on the monitor/computer. 

 Check to see if the power cables that are connected properly with computer and monitor. 

 Check there is no breakage in power cables of any device. 

 Check that power supply is picking the power or not. 

Hardware faults 
occurred due to 
careless use of 
computer or mal 
functioning of 
software. 

Remember 

Hardware 
troubleshooting 
means founding and 
removing errors 
from a computer or 
device. 

Hardware 

Troubleshooting 
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Troubleshooting a Keyboard: 

When a Keyboard doesn't respond and gives off a constant beeping noise when booting up then check the 
following: 

 Check the plug to make sure it's connected securely. 

 Try unplugging it and re-plugging it again. 

  If there is no response, check the indicator light on the keyboard. Is it on. Do the lights respond when 
pressing the caps lock or the num lock key? 

 Check to see if there is a key stuck on the keyboard. 

 

Troubleshooting a Mouse: 

When a mouse is not working properly or the mouse will only move one way, either vertically or horizontally.  

 Reboot the computer and check that it corrects the problem. If not, then will be insufficient memory. 

 Clean the mouse. 

 

Troubleshooting a Printer 

If the Printer is not printing. 

 

Check to See if the Printer Getting Power 

If there are no lights or no display on the front of the printer, the printer is not getting electricity or power. Check 
to make sure the power cable is plugged in both to the wall or power strip and to the back of the printer.  

 

Check to See if there is Paper Jam in Printer? 

 If the printer has paper in the paper tray, the paper may be jammed or not 
feeding properly. Take the paper out of the paper tray and check to see that 
the top piece of paper is not crinkled or bent. 

 If the printer is a DeskJet, lifts open the front cover and look to see if a piece of 
paper is halfway fed through. If there is, remove paper properly from the top 
and close the printer. 

 If the printer is a LaserJet, open the top of the printer and check for paper 
underneath the toner cartridge. If there is paper there, properly remove it, and 
place the toner cartridge again. 

 

Check to See if there Multiple Jobs in the Print Queue 

 If the printer is a local printer (i.e., there is a cable running directly from the printer to the computer you 
are printing from), power off the PC, power off the printer, count to 10, and then turn both the printer and 
the computer back on again. Sometimes this will allow the printer to start printing again. 

 

Always keep your 
hardware clean and 
keep it away from 
dust so it can work 
properly. 

Remember 
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Computer Hang Troubleshooting: 

If the cursor is stuck on the or system goes on Halt position or it may hang then do this: 

 Open Task Manager 

 Simultaneously press [Ctrl] [Alt] [Delete] keys. You will see a list of all tasks 
(programs) currently running. You may notice one program has "Not 
Responding" instead of "Running" listed next to it. Select this task and click the 
End Task button. 

 Another dialog box will open stating that the program is not responding. Choose 
End Now to close the program. 

 Reboot your computer (Warm Boot) 

 

Resetting a Computer that is Already Turned On: 

 Press [Ctrl] [Alt] [Delete] keys once to open the Task Manager. 

 Press [Ctrl] [Alt] [Delete] again to restart the computer. 

 Shut down your computer 

If you restart your computer and the problem isn’t resolved, than attempt to completely shut down the computer 
by pressing the power button. Let it set for 15-30 seconds then restart the computer. 

3. Maintenance of Hardware Devices on Regular Basis 

Computers are expensive, and with all major purchases you probably want to protect your investment. Luckily, it 
is not difficult to keep your computer healthy and in good working order. Maintaining a computer involves three 
things: keeping it physically clean, protecting it from malware, and backing up important files. 

 

Keep the Computer Physically Clean: 

When dealing with computers, dust isn't just unattractive—it can potentially destroy parts of your computer. By 
cleaning your computer regularly, you can help to keep it working properly and avoid expensive repairs. 

 

Cleaning the Keyboard: 

 Unplug the keyboard from the USB or PS/2 port. If the keyboard is plugged into the PS/2 port, firstly shut 
down the computer before unplugging it. 

 Turn the keyboard upside down, and gently shake it to remove dirt and dust. 

 Blow air to clean between the keys. 

 Moisten a cotton cloth or paper towel with rubbing alcohol, and use it to clean the tops of the keys. Do not 
pour alcohol or any other liquid directly onto the keys. 

 Reconnect the keyboard to the computer once it is dry. If you are connecting it to a PS/2 port, you will need 
to connect it before turning on the computer. 

 

Cleaning the Mouse: 

 Unplug the mouse from the USB or PS/2 port. If the mouse is plugged into the PS/2 port, you will need to 
shut down the computer before unplugging it. 

 Moisten a cotton cloth with rubbing alcohol, and use it to clean the top and bottom of the mouse. 

 F5 Key is used for 
Refreshing the 
computer.  

Do you know! 
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 If you have a mechanical mouse, remove the tracking ball by turning the ball-
cover ring counterclockwise. Then clean the tracking ball and the inside of the 
mouse with a cotton cloth moistened with rubbing alcohol. 

 Removing the tracking ball 

 Let all of the parts dry before reassembling and reconnecting the mouse. If you 
are connecting it to a PS/2 port, you will need to connect it before turning on the 
computer. 

 

Cleaning the Monitor/ LCD: 

 Turn off the computer. 

 Unplug the monitor from the power. If using a laptop, unplug the laptop. 

 Use a soft clean cloth moistened with water to wipe the screen clean. 

 

Cleaning Computer and Other Devices: 

From time to time, you should clean your computer case and the sides and back of the 
monitor to avoid buildup of dust and dirt. Here are a few tips you can use when cleaning 
these surfaces. 

 

Cleaning the Computer Case: 

 Dust is computer's main enemy. Use an antistatic wipe to lightly dust the computer casing. Don't use 
furniture cleaners or strong solvents. 

 Use air blower to remove dust stains from computer ports and inner parts of computer every month. 

 Spray cleaning solution like ammonia cleaner or glass cleaner on a paper towel. 

 A safe cleaning solution for computer surfaces, not computer screens is ammonia diluted with water or 
glass cleaner comprised mostly of ammonia and water. 

 

Keep it in Cool Place: 

Don't restrict airflow around computer. A computer can generate a lot of heat, so the casing has fans that keep it 
from overheating. Avoid stacking papers, books, and other items around the computer. 

Many computer desks have an enclosed compartment for the computer case. If you have this type of desk, you 
may want to position the case so it is not against the back side of the desk. 

 

  

Overheating is a big 
cause of damaging 
Hardware in 
computer. 

Do you know! 

Always unplug the 
wires from the 
computer before 
cleaning the devices 
and use soft cloth or 
tissue for dusting. 

Remember 
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Learner’s Activity 

 Does your computer have any hardware fault? If any remove it and write down the fault and 
troubleshooting steps. 
 

 Properly clean your devices attached to the computer. 
 

 Unplug the mouse from the computer and clean it. 
 

 Clean your System Unit, Screen, and keyboard and write the steps. 
 

 Troubleshoot a printer if its paper is jammed inside, write the steps. 
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Learning Unit 11: Configure Basic Internet Connectivity 

Overview 

The term internet means Network of Networks. Internet is used to send and receive email, browse the Web, 
watch movies, and more. Before accessing the Internet, there are three things needed, an Internet service, a 
modem, and a web browser. This learning unit covers the basic concept of internet, internet connection types; 
also it covers the procedure for internet connectivity. After completion of this learning unit, you will be able to 
demonstrate what is internet, how can you connect or check internet connections in your computer. 

1. What is Internet 

Network of networks or millions of computers connected together to communicate 
with each other for sharing data all over the world is called Internet. It is a global 
networking of computers all around the world for sharing data and information with each 
other. More than 190 countries are linked into exchanges of data, news and opinions. 
The number of Internet users represents nearly 40 percent of the world's population. 
The largest number of Internet users by country is China, United States and India. In 
September 2014, the total number of websites with a unique hostname online 

exceeded 1 billion. It was first developed by the Advance Research Project Agency (ARPA) of U.S government 
in 1969 for its military purposes, named ARPA net. The original aim was to create a network that would allow 
users of a research computer at one university to "talk to" research computers at other universities. Later on this 
networking increased and became a global network all over the world called Internet. 

2. Types of Internet Connections 

There are a lot of ways to connect laptops, desktops, mobile phones, gaming consoles and tablets to the Internet. 
Some of the most widely used Internet connections are described below. 

1. Wireless Connections: 
 
In wireless Connection Radio frequency bands are used in telephone or cable networks. Wireless connection 
can be accessed from any location that is within network coverage. Wireless connections are used through 
modem, which catches the Internet signals and sends them to other devices. 

 

2. Broadband Connections:  
 
In broadband connection high-speed Internet connection is provided through ISP’s 
(internet service providers).Broadband Internet uses multiple data channels to 
send large quantities of information. The term broadband is shorthand for broad 
bandwidth. Broadband Internet connections such as DSL and cable are considered 
high-bandwidth connections. Although many DSL connections can be considered 
broadband, not all broadband connections are DSL. 

 

 

 

Internet is a global 
networking of 
computers for 
communication. 

Internet  

According to Internet 
Live Stats, as of 
December 30, 2014 
there was an 
estimated 
3,037,608,300 
Internet users all 
over the world. 

Do you know! 
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3. Mobile Connections: 
 
Many cell phone and smartphone providers offer voice plans with Internet access. A Mobile Internet 
connection provides good speed and allows accessing the Internet. 

 

4. Dial-Up Connections: 
 
Dial-up connections require users to link their phone line to a computer to access the 
Internet. This particular type of connection also referred to as analog does not permit 
users to make or receive phone calls through their home phone service while using the 
Internet. 

 

5. Hotspots Connections: 
 

Hotspots are sites that offer Internet access over a wireless local area network (WLAN) through a router 
that connects to an Internet service provider. Hotspots utilize Wi-Fi technology, which allows electronic 
devices to connect to the Internet. Hotspots can be phone based or free standing, commercial or free to the 
public. 

 

6. DSL Connections: 
 
DSL stands for Digital Subscriber Line, uses a 2-wire copper telephone line connected to one’s home so 
the user can access the internet and make a call at the same time.  

 

7. Satellite Connections: 
 
In many remote areas where broadband connection is not yet offered, a satellite Internet option may be 
available. Similar to wireless access, satellite connection utilizes a modem. 

 

8. ISDN: 
 
ISDN (Integrated Services Digital Network) allows a user to send data, voice and 
videos over digital telephone lines or standard telephone wires. The installation of an 
ISDN adapter is required at both ends of the transmission on the part of the user as 
well as the Internet access provider. 

3. Connecting to Internet 

Setting Up a Broadband (DSL or Cable) Connection: 

For set up a Digital Subscriber Line (DSL) or cable connection, first need connection with an Internet service 
provider (ISP).  

This will need a modem, a router, or a device that combines the two. (Some ISPs will provide you with these 
devices; if your ISP doesn't, you'll need to buy them.)After this follow the steps below. 

Although dial-up has 
traditionally been the 
least expensive 
option, many ISPs 
have raised dial-up 
prices to be the 
same as broadband. 
This is intended to 
encourage people to 
switch to broadband. 

Remember 

What are the 
ISP’s?? And what 
are the most 
common ISP’s 
working in Pakistan? 

Do you know! 
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Plug the device into an electrical outlet. 

1. Plug one end of a phone cable into the wide area network (WAN) port of the device, and then plug the other 
end into the wall jack. The WAN port should be labeled "WAN."  
 

2. Plug one end of an Ethernet cable into the local area network (LAN) port on the device, and then plug the 
other end into the networking port of the computer. The LAN port should be labeled "LAN”. 

 

3. Start (or restart) the computer. 
 

4. Open the Connect to the Internet wizard by clicking the Start button, and then click on Control Panel. In 
the search box, type network, click Network and Sharing Center, click Set up a new connection or network, 
and then double-click Connect to the Internet. 

 

 

5. Follow the steps in the wizard and the internet connection will be established. 

 

When you connect 
to a wireless 
connection through 
Wi-Fi then this icon

 will appear in 
notification areaand 
when you connect 
you own wireless 

modem then 
icon will be appear 
in notification area. 

Remember 
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Viewing and Connecting to Wireless Networks: 

1. Open Connect to a Network by clicking the network or in the notification area. 
 

2. In the list of available wireless networks, click a network, and then click Connect. 
 

3. If you have your own wireless modem or Wi-Fi modem like EVO 3G Wingle then directly connect it into the 
computer USB port. Install its driver which is available with the device. After finishing installation simply 
browse the internet. 

4. Some networks require a network security key or passphrase. For connecting to one of those networks, ask 
your network administrator or Internet service provider (ISP) for the security key or passphrase. 
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Learner’s Activity 

 Did you use internet before this?  
 

 Research two or more Internet service providers (ISPs), and compare their service packages. What are 
the different connection speeds offered by each provider? 
 

 Try using a few different web browsers. Do they work differently? Which one was easier to use? 
 

 Do you have any devices (computers, mobile phones, etc.) that can connect wirelessly? Would it make 
sense to create a wireless network in your home? 
 

 Configure and install broadband DSL connection at your computer. 
 

 Configure a wireless connection at your computer. 
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Summary of Module 

 An operating system (OS) is a set of programs contains instructions that work together to coordinate all 
the activities among computer hardware resources. 

 A computer peripheral device is an external device that provides input and output for the computer. There 
are three types of peripheral devices one is Input that is use for providing input to the computer, second 
is output that is used for providing output and the last is that provides input and output both. 

 It is necessary to learn Installing and configuring the variety of peripheral devices, including mouse, 
microphone, scanner, gamepad, camcorder and other devices. 

 Application software is a type of software that can be used for a variety of tasks. It is not limited to one 
particular function. For example a word processor could be classed as general purpose software as it 
would allow a user to write a novel, create a restaurant menu or even make a poster. 

 A software update means to enhance the capability, stability and features of an existing version of the 
software. Updates usually download free of cost while upgrading means replace an older version of the 
same product with the newer version. 

 The proper way to uninstall a program is to use the uninstall routine that is provided with the program 
itself are from control panel. This will remove the files, Windows Registry information, and other 
configuration from your computer so that there are no conflicts in the future. 

 Scanning a computer means detect and remove viruses and malwares from the computer. 

 External mass storage is the storage device that is attached to the computer with a network / cable or 
can be removed without opening the computer case like floppy disk, hard disk, flash drive etc. 

 Software troubleshooting is the process of scanning, identifying, diagnosing and resolving problems, 
errors and bugs in software. It is a process starts with identifying the problem, checking on possible 
issues that can cause such problems and then working on measures and alternatives to find a solution. 

 Hardware troubleshooting means removing hardware faults are issues. A computer should keep clean 
and maintain at regular basis to avoid faults. 

 Internet is used to send and receive email, browse the Web, watch movies, and more. Before accessing 
the Internet, three things are needed, an Internet service, internet connectivity device, and a web 
browser. 
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Frequently Asked Questions (FAQs) 
FAQ 1: What are the common types of Operating system? 

Answer Most common types of operating system are Windows, Linux, Unix, Mac OS, Solaris, etc. 

FAQ 2: What are the Peripheral devices? 

Answer 
A computer peripheral device is an external device that provides input and output for the 
computer like keyboard, mouse, LCD, monitor, Printer, scanner web cam etc. 

FAQ 3: What is application software? 

Answer 
Application software is the software is used at offices, home and school etc., like word 
processing, spreadsheets, Database, Graphics software, designed to perform specific tasks 
for users. 

FAQ 4: What is a software update means? 

Answer 
A software update means to enhance the capability, stability and features of an existing version 
of the software. Updates usually download free of cost while upgrading means replace an older 
version of the same product with the newer version. 

FAQ 5: What is the right way to uninstall a program? 

Answer 
The proper way to uninstall a program is to use the uninstall routine that is provided with the 
program itself, or from using control panel. 

FAQ 6: What does scanning means? 

Answer Scanning a computer means detect and remove viruses and malwares from the computer.  

FAQ 7: What are computer viruses or bugs? 

Answer 
Computer viruses are small software programs that are designed to spread from one computer 
to another and to interfere with computer functioning. 

FAQ 8: What is external mass storage? 

Answer 
External mass storage is the device that is attached to the computer with a network/ cable and 
can be removed without opening computer case, like hard disk, USB flash drive, CD, floppy 
disk etc. 

FAQ 9: What is software troubleshooting process? 

Answer 
The software troubleshooting process starts with identifying the problem, checking on possible 
issues that can cause such problems and then working on measures and alternatives to find a 
solution. 

FAQ 10: What is internet and what are its basic parts for connectivity? 

Answer 
Internet is used to send and receive email, browse the Web, watch movies, and more. Before 
accessing the Internet, there are things needed, an Internet service, internet connectivity 
device, and a web browser. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  The most popular operating system for personal computers is ________. 

a.  Mac OS b.  Microsoft windows 

c.  Linux d.  Apple 

2.  An application can be installed using __________________. 

a.  CD b.  Flash drive 

c.  Internet d.  All a, b & c 

3.  Instead of a mouse, many laptops use a (n) ________. 

a.  Optical mouse b.  Touch-pen 

c.  Touchpad d.  Laser pen 

4.  Which of the following is a type of monitor port? 

a.  VGA port b.  Parallel port 

c.  Communication port d.  All 

5.  The main circuit board in a computer is called the ________. 

a.  RAM  b.  Motherboard 

c.  Power supply d.  None 

6.  A mouse can connect to the computer with a ________ connection. 

a.  USB b.  PS/2 

c.  Bluetooth d.  All of the above 

7.  To navigate through different folders in Windows, you'll use ________. 

a.  Lanucher b.  Windows explorer 

c.  Finder d.  None 
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8.  To guard against malware, is called ________. 

a. Antivirus b. Spyware 

c. Scanner d. None 

9.  
If a Windows program has become unresponsive, which keys do you press to open the Task 
Manager? 

a. Shift+Tab+ Enter b. Home+Control+Shift 

c. Space bar+F1+Tab d. Control+ Alt+Delete 

10.  DSL stands for:_________________ 

a.  Distributed standard line b.  Digital subscriber line 

c.  Dynamic standard line d.  None 

11.  For entering computer setup shortcut key is:______________ 

a.  F5 b.  F3 

c.  F2 d.  F10 

12.  LCD is a ____________ of device. 

a.  Input b.  Output 

c.  Both d.  None 

13.  If a computer is working slow  what type of fault it is considered________ 

a.  Hardware error b.  Software error 

c.  Both d.  None 

14.  Internet is a network of __________ computers 

a.  Millions of b.  Thousands of 

c.  Two or more d.  None 
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Answer Key 
MCQ Number Correct Answer 

1 b 

2 d 

3 c 

4 d 

5 b 

6 d 

7 d 

8 b 

9 a 

10 d 

11 b 

12 c 

13 b 

14 b 
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Module 2: Prepare Word Document 

Learning Outcomes 

After completion of this learning module learner will be able to: 

  Type Document 

  Set Up Page in a Word Document 

  Edit Word Document 

  Format Word Document 

  Save Word Document 

  Insert in a Word Document 

  Import Documents 

  Protect Document 

  Insert table in a word Document 

  Hyperlink data in a word Document 

  Perform Mail Merge in the Word Document 

  Insert Header /Footer in a word Document 

  Insert Section Header in a word Document 

  Set Style in Word Document 

  Insert Table of contents in word document 

 

  



Module 2: Prepare Word Document 

104 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

  



Module 2: Prepare Word Document  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 105 

Learning Unit 1: Prepare Word Document 

Overview 

 
In this learning unit you will learn how to open and save file with desired name and 
location in MS Word and how you can type in the document. After completion of this 
learning unit you will be able to type speedily and error free in MS Word.  
 
 

1. Typing Using Different Keyboard Keys 

The keys on their keyboard can be divided into several groups base on function: 

 Typing (Alphanumeric) Keys. These keys include the letter, number and special character keys on 
keyboard. 

 Control Keys. These keys are used separately or in combination with other keys to perform special 
actions. For example “Ctrl+S” used for Save file and “Ctrl+O” used to open a file. 

 Function Keys. The function keys are used to perform specific function tasks. They are labeled as F1, 
F2, F3, and so on, up to F12. The functionality of these keys differs from program to program. 

 Navigation Keys. These keys are used for moving around in documents or WebPages. They include 
the arrow keys, Home, End, Page Up, Page Down, Delete, and Insert. 

 Numeric Keypad. The numeric keypad is used for entering numbers quickly. 
The keys are grouped together like a calculator or adding machine.  

The following figure1 shows these keys are mentioned on a typical keyboard.  

 

Figure 1 
 
Typing Text: 

When you want to type in MS Word, you'll see a blinking vertical line (|). That's the 
cursor, also called the insertion point. It shows that from where the typing will start. 
You can move the cursor by clicking in the desired location with the mouse, by using 
the navigation keys, OR through space bar button. 

By Default MS Word 
Document open with 
the name 
“Document1”. 

Do you know! 

Different keyboards 
may have different 
layout.  

Remember 

If Number Lock is 
not ON then by 
pressing the keys on 
numeric pad will do 
the others things 
written on the keys 

Remember 
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The following table shows the working of Shift, Tab, Backspace, Enter, Caps lock and spacebar key.  

 

Key name How to use 

Shift 
Press Shift in combination with a letter to type an uppercase letter. Press 
Shift in combination with another key to type the symbol shown on the 
upper part of that key. 

Caps Lock 
Press Caps Lock once to type all letters as uppercase. Press Caps Lock 
again to turn this function off. Your keyboard might have a light indicating 
whether Caps Lock is on. 

Tab 
Press Tab to move the cursor several spaces forward. You can also press 
Tab to move to the next text box on a form. 

Enter 
Press Enter to move the cursor to the function of the next line. In a dialog 
box, press Enter to select the highlighted button. 

Spacebar Press the Spacebar to move the cursor one space forward. 

Backspace 
Press Backspace to delete the one character before the cursor, or the 
selected text/word. 

 

2. Typing By Using Numeric Pad on Keyboard 

 
Typically you use the numbers above the keyboard for entering numerical data. But if you have to enter a lot of 
numeric values you should know how to use the ten-keys located on the right side of the keyboard.  
 
Step 1: 
 
On a computer, make sure number lock is on. Press the Num Lock 
button until the corresponding light is on. 
 

 
Step 2:  
 
Place your middle finger on the 5 key. Often, there will be a small  
dimple or ridge on this key so that 
 You can easily find it by feel. 
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Step3: 
 
Place your index finger on the 4 and your ring finger on the 6. This is the 
"home row" position for ten-key work. Without looking at your hand, 
practice typing combinations of the home row numbers, 4, 5, and 6. 
 
 

 

 
Step.4: 
 
Work in the numbers above the home row. Type the 7 with your index 
finger, the 8 with your middle finger, and the 9 with your ring finger. Bring 
your fingers back to the home row when you are done with each of these 
digits. 
 
 

 

Step 5: 
 
Work in the numbers below the home row. Type the 1 with your index 
finger, the 2 with your middle finger, and the 3 with your ring finger. 
Return your fingers to the home row when you are done with each of 
these digits. 
 
 

 

Step 6: 
 
Type the 0 with your thumb. 
 
 
 
 
 

 

Step 7: 
 
Learn the decimal point key and work on entering decimal 
data. Type the decimal point with the ring finger. Practice typing decimal 
numbers. 
 
 
 
 

 

Step 8: 
 
Practice by feel the location of the 'enter' key, the + symbol, and the /, *, 
and - symbols. 
 
 
 
 
 

 

3. Using Left, Right, Up, Down Arrow Keys 

 
Arrow keys are keyboard keys located at the bottom of the keyboard to the left side of 
the numeric keypad on computer keyboards. Arrow keys are typically marked with 
arrows. These four keys are the left arrow (back arrow), up arrow, down arrow, and the 
right arrow (forward arrow).  
 
 Arrow Keys 

http://www.wikihow.com/Convert-a-Decimal-to-a-Fraction
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Arrow keys are used in many ways: 

 Move the text cursor on the screen. 

 Move a character in a computer game. 

 Select text. For example, holding down shift and pressing the arrow key in the direction you want to 
highlight text. 

 Move the mouse pointer using the keyboard instead of the mouse. 

4. Typing Using Keyboard and Mouse  

 
Step 1: The main keys on the keyboard are the letter keys. When you type just using these, you get lower-case 
print, and if you hold down a ‘shift key’ at the same time as you type, you’ll get UPPER-CASE letters. 
 
Step 2: You can move the cursor along this sentence without deleting anything by using the arrow keys or by 
directly clicking the left button of the mouse. 
 
Step 3: Now try typing a sentence: 
 
A QUICK BROWN FOX JUMPS OVER THE LAZY DOG 
 
This is a good sentence to practice because it contains all 26 letters of the English language. 
 

Step 4: If you make a mistake in your typing, you can remove it. 

 

To delete a letter, place your cursor just after the letter and click. Then press Backspace key from keyboard. Or 
place your cursor just before the letter, click and press Delete. 

Step 5: You can also type using the numbers on the main keyboard located on the row of keys above the top 
line of letters. 

Above these numbers are various symbols, which include ‘£’, ‘&’, ‘!’. To use these, hold down the Shift key while 
typing. So if you press ’7′ on its own, you get ’7′, but if you press ’7′ while you hold down the ‘Shift’ key, you get 
‘&’. 

Try typing: 

 

 

 
 

Extra symbols will 
also be found 
elsewhere on the 
keyboard: 

 

Note 
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5. Typing through Systematic Way 

Touch typing (also called touch type or touch method or touch and type method) is typing without using the 
sense of sight to find the keys. Specifically, a touch typist will know their location on the keyboard through muscles 
memory. Touch typing typically involves placing the eight fingers in a horizontal row along the middle of the 
keyboard (the home row) and having them reach for other keys. Both two-handed touch typing and one hand 
touch typing are possible. 

Lesson 1: 

The home row of the keyboard is the most important to the touch‐typist. 

When at rest the typist's fingers are positioned, lightly, on the A‐S‐D‐F keys for the left hand, and the J‐K‐L‐; 
keys for the right hand. 

• The left index finger will control the F and G keys, the right index finger will control the J and H keys. 
• The left middle finger will control the D key, the right middle finger will control the K key. 
• The left ring finger will control the S key; the right ring finger will control the L key. 
• The left little finger will control the A key, the right little finger will control the; key. 
• The spacebar is controlled by the right thumb.  

 

 

LF = little finger, RF = ring finger, MF = middle finger, IF = index finger 
 

When you are ready to begin, start an exercise and press the key requested. Try not to look at the keyboard. It 
will be difficult at first but as the exercise progresses you will find it becomes easier and your fingers will begin 
to move without you consciously deciding which finger is associated with which key 

 

Lesson 1 Exercise: 

Exercise 1: 

Please type 

asdfg hjkl; asdfg hjkl; ;lkjh gfdsa asdfg hjkl; ;lkjh gfdsa ;lkjh gfdsa 

 

Exercise 2: 

Please type 

ah had lag slag ah had lag slag ah had lag slag 

 

Before you begin 
typing make sure 
you are sitting up 
straight, your feet 
flat on the floor. 
Keep your elbows 
close to your body, 
your wrists straight 
and your forearms 
level. 

Remember 
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Exercise 3: 

Please type 

sad shall salad sad shall salad sad shall salad sad shall salad sad shall 

 

Exercise 4: 

Please type 

ash glad alas ash glad alas ash glad alas ash glad alas ash glad alas 

 

Exercise 5: 

Please type 

all flask half all flask half all flask half all flask half all flask half 

 

Lesson 2: 

The third row of the keyboard is the Q‐W‐E‐R‐T‐Y row. 

• The left index finger will control the R and T keys, the right index finger will control the Y and U keys. 
• The left middle finger will control the E key, the right middle finger will control the “I” key. 
• The left ring finger will control the W key; the right ring finger will control the O key. 
• The left little finger will control the Q key, the right little finger will control the P key. 

 

The QWERTY row has mostly used letters. Four of the five vowels, E‐I‐O‐U are to be found in this row. 

 

Lesson 2 Exercises: 

Exercise 1: 

Please type 

qwert yuiop qwert yuiop ; poiuy trewq poiuy trewq qwert yuiop qwert 
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Exercise 2: 

Please type 

till quail tight yell; will those feat lake hash till quail tight yell; will 

 

Exercise 3: 

Please type 

if do pit dug wary; quaff law stop lair gate here if do pit dug wary; 

 

Exercise 4: 

Please type 

go her with hit; fight tug quill day saw yippee go her with hit; fight tug 

 

Lesson  3: 

Once you have mastered the first row of the keyboard, the Z‐X‐C‐V‐B row, you will have learned all the alpha 
keys on the keyboard. 

The left index finger will control the V and B keys, and the right index finger will control the N and M keys. 

• The left middle finger will control the C key, and the right middle finger will control the, key. 
• The left ring finger will control the X key, and the right ring finger will control the. Key. 
• The left little finger will control the Z key, and the right little finger will control the / key. 
• The left shift key is controlled by the left little finger and the right shift key is controlled by the right 

little finger. 

 

In start you will find the downward stretching for the new finger positions awkward at first but it soon passes. 

 
Lesson 3 Exercises 

Exercise 1: 

Please type 
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king fan crick, chill block. back abbot. aflame/ mix king fan crick, chill 

 

Exercise 2: 

Please type 

zest win, thump skunk. plain muffin, knight/ exit zest win, thump skunk. 

 

Exercise 3: 

Please type 

daring. choke bishop. admit twine sultan, sing/ roman daring. choke 

 

Lesson 4: 

The exercises in this lesson focus on practicing the different character keys. 

 

 

LF = little finger, RF = ring finger, MF = middle finger, IF = index finger 
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Lesson 4 Exercises 

Exercise 1: 

Please type 

#15 @ $56.80 = 17%, 15*(12+3)=15^2, 2‐ !=4‐2 

 

Exercise 2: 

Please type 

if(total qty = 0) {echo "you did not order anything"}; 

 

Exercise 3: 

Please type 

if(document. images) && (preload Flag ==))  

{for var i=0} 

 

6. Gaining Knowledge about Typing Tutor 

Typing Master 

Typing master is a software with a lots of Lessons, Tests and Games to increase the 
typing speed. It is a well designed software that systamatically helps you to increase 
speed in a friendly way and inform you about the keys that are problamatic for you and 
suggest exercise for those problematic areas. 

The procedure to use Typing Mater has the follwing steps: 
Launch  Typing Meter is a handy window that analyze and measures your typing 
habit on the backend while you are working. 

1. Open the Typing Master Software from the all program. Enter the name to start the program. 

Launch  Typing 
Meter is a handy 
window that analyze 
and measures your 
typing habit on the 
backend while you 
are working. 

Do you know! 
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2. Launch Typing Meter window will be open, if you want to launch it then just click on launch or click 
Launch Later. 

 

3. On the Next page the Course window will be open from where you can select the desired lesson. 

Typing Meter 
launcher will not 
start working until 
the typing master 
software is open. 

Remember 
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4. After selecting the lesson next page will be open with the information about that lesson and the visual 
instructions of fingers position. Click on the Next button. 

 

5. Now the Exercise will start with the time. You can also Pause the lesson, it will stop counting time of 
typing speed.  
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6. As the time will over the Exercise Result will be open with the detail of your typing progress. 

 

 

7. Performing Online Typing Test 

To check the performance of typing speed,  online tests are available, you can check your typing speed through 
these exercises. Different websites are available to test the typing speed. Few of them are shown below:  

1. Open the web browser. 
2. Type the address in URL http://typing-speed-test.aoeu.eu/?lang=en 
3. The following page will be displayed with the written text to test you speed. 

http://typing-speed-test.aoeu.eu/?lang=en
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4. When you start the test the timer will be start to examine your speed and when you end, the clock will 
displayed the result on screen. 

 
 

Learner’s Activity 
 

Open and Save a Document 

 
1. Open MS word from Microsoft office. 
2. Click on the file tab button. 
3. Type some text in the document. 
4. Click on the save as option to save a file with desired name and location. 
5. Type the file name and click on the Save button in the dialogue box. 
6. Word file is created in the given location. 

  

Another link to 
check typing speed 
is http://typing-
speed-
test.aoeu.eu/?lang=
en 

Important 
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Learning Unit 2: Setup a Page in Word Document 

Overview 

The MS Word page Set-up includes elements such as the page size, margins (Left, 
right, up, bottom), number of columns, orientations.  

After completion of this learning unit, you will be able to set suitable page size, 
orientation and columns according to nature of text. 

 

1. Components of Page Set-up  

Before start working on the page set-up, the below shown is the picture of interface of MS Word document. 

 

To setup a page in MS Word a Page Layout tab is available in the Tabs. In page Layout  tab a group is available 
for the page setup as shown in picture below: 

 
 
In Page Set-up group the following options can be set: 
 

Page layout is the 
term used to 
describe how each 
page of your 
document will 
appear when it is 
printed. 

Do you know! 

In MS Word default 
paper size is US 
Letter (8.5”x11”) or 
A4 (8.27”x11.69”) 

Do you know! 
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Margin: 

Orientation: 

Paper on which text is printed could have two orientations – portrait and landscape. In portrait orientation, height 
of the paper is larger than its width whereas in landscape orientation, the width is larger than the height. 

 

Size: 

Books and magazines are printed in a variety of sizes. Different sizes of paper are required to set the requirement 
of printing. Microsoft Word allows you to choose a variety of paper sizes for your documents. MS Word offers a 
large menu of standard paper sizes to choose from and also allows setting of a custom paper size of your own. 

 

Columns:  

Columns are used in many types of documents, but most commonly used in 
newspapers, magazines, academic journals, and newsletters. Columns can improve 
document's organization and increase its readability. They also allow you to utilize all 
of the available space on the page. 

 

Breaks: 

Word has several different types of breaks you can add to your document to change the layout and pagination. 
Each type of break serves a different purpose and affects the document in different ways. 

1) Page breaks move text to a new page before reaching the end of a page,  
2) Section breaks create a barrier between parts of the document for formatting purposes.  
3) Column breaks split text in columns at a specific point. 

 

Hyphenation: 

In word processing, hyphenation refers to splitting a word that would otherwise extend beyond the right margin. 

 

2. Selecting Suitable Orientation of a Page 

The procedure to Setting up the orientation of a page has following steps: 

1. Open MS word document and click on the Page Layout  tab.  

Hyphens that you 
add explicitly by 
entering the dash 
character are called 
hard hyphens. 

Remember 
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2. Click the Orientation command in the page set-up Group. 
3. Click either Portrait or Landscape to change the page orientation. 

 

3. Applying Page Margins 

The procedure to Set-up the page Margin has the following steps: 

1. Opening the document you wish to modify. 
2. Clicking on Page Layout, located in the toolbar at the top of the screen. 
3. Clicking on the arrow beside Page Margins which is located in the Page Setup section. 

Landscape format 
means the page is 
oriented horizontally, 
while portrait format 
means it is oriented 
vertically. 

Do you know! 



Module 2: Prepare Word Document  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 121 

 

4. Selecting one of the pre-existing margins or customizing your own. 
5. Selecting OK. 
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4. Using Custom Margin  

1. From the Page Layout tab, click Margins. 
 
OR 
 

2. Click the small arrow in the bottom-right corner of the Page Setup group. The Page Setup dialog box 
will appear.  

 

 
3. Adjust the margin sizes for each side of the page (Top, Bottom, Right, Left), and then click OK.  
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5. Using Paper Size 

The procedure of using different page sizes has the following steps: 

1. Select the Page Layout tab. 

2. Click the Size command, and a drop-down menu will appear. The current page size is highlighted. In the 
picture below Legal is being applied. 8.5”*14”is the width and height of the page. 

 

3. Click the size option you want. The page size of the document changes. 

6. Inserting Columns 

The procedure to insert the columns in the page has the following steps: 

1. Select the text you want to format. 

2. Click the Page Layout tab. 

3. Click the Columns command. A drop-down menu will appear.  

 

4. Select the number of columns you want to insert. The text will then format into columns. In the picture 
below two is selected. 

You can remove the 
columns by clicking 
the Columns  
Command and 
selecting one for the 
number of columns. 

Do you know! 
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5. Same like this different Column Options can be applied. Left Column will be shown like the picture given 
below. 
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Learner’s Activity 
 

 Open a Word document 
 

 Change the page orientation 
 

 Change the paper size 
 

 Change the margins to narrow 
 

 Adjust the margins using custom margins 
 

 Set the page as two Columns 
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Learning Unit 3:  Edit Word Document 

Overview 

In this learning unit, you will learn the editing in the word document that how you can insert or delete a new 
word/paragraph and can spell checking through available dictionary. After completion of this learning unit, you 
will be able to edit word document such as insert or delete text, spell checking, word count etc…  

1. Perform Save as Function 

Save As function allows you to choose a name and location for your document. It's useful if you've first created 
a document or if you want to save with different name while keeping the original document. 

The procedure to save a word file through Save As function has the following steps: 

1. Open the word File 
2. Click the File tab. 
3. Select Save As. 

 

4. The Save As dialog box will appear. Select the location where you want to save the document. 
5. Enter a name for the document, then click Save. 
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2. Different Features of Editing  

Edit menu cannot be find in the Ribbon in MS 2010, because all the toolbars and menus are redesigned and 
relocated in it.  For example, the Select function stays in the Editing group of Home tab; the Paste function 
stays in the Clipboard group of Home tab.  

      

Cut: Removes the selection from the active document and places it on the clipboard. Short Key of Cut 
command is CTRL+X. 

Copy: Copies the selected text to the clip board 

Paste: Paste the contents of the clipboard at the insertion point (cursor) or whatever is selected. 

Clear: Deletes the selected object or text, but does not place it on the clipboard. 

Select All: Selects all text and graphics in the active window. 

Find: Searches for specified text in the active document. 

Replace: Searches for and replaces specified text and formatting. 
 

In window 7 
normally the Word 
file will be saving in 
Documents Library.  

Do you know! 
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3. Copying and Pasting Text 

The procedure to Copy and paste the text has following steps: 

1. Select the text you want to copy. 

2. Click the Copy command on the Home tab. You can also right-click your document and select Copy  

 

3. Place your insertion point where you want the text to appear. 

 

4. Cutting and Pasting Text  

1. Select the text you want to copy. 

2. Click the Cut command on the Home tab. You can also right-click the document and select Cut. 

 

3. Place your insertion point where you want the text to appear. 

 

Dragging and Dropping Text: 

1. Select the text you want to copy. 

Short Cut key to 
copy text is 
CTRL+C. Short Key 
to paste text is 
CTRL+V 

Remember 
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2. Click and drag the text to the location where you want it to appear. The cursor will have a rectangle under 
it to indicate that you are moving text. 

 

3. Release the mouse button, and the text will appear. 

 

5. Finding Text 

1. From the Home tab, click the Find command. The navigation pane will appear on the left side of the 
screen. 

 

2. Type the text you want to find in the field at the top of the navigation pane. 

3. If the text is found in the document, it will be highlighted in yellow, and a preview will appear in the 
navigation pane. 

If text does not 
appear in the exact 
location you want, 
you can click 
the Enter key on 
your keyboard to 
move the text to a 
new line. 

Remember 
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4. When you close the navigation pane, the highlighting will disappear. 

 

6. Replacing Text 

1. From the Home tab, click the Replace command. The Find and Replace dialog box will appear.  

 

2. Type the text you want to find in the Find what field. 

3. Type the text you want to replace it with in the Replace with field. 

4. Click Find Next and then replace to replace text. You can also click Replace All to replace all instances 
within the document. 

 

7. Learning about Track Changes 

Word document can be set to mark and track changes you make to a document so that you or another author 
can later review the changes. When reviewing, you or another author can choose to accept or reject the changes. 
For each change that is tracked, Word stores the exact modification that was made as well as the name of the 
author, the date and the time of the change. This information is displayed when you review the revisions. 

 
 

When you have your 
mouse over a 
tracked change, 
Word displays the 
author, date, time 
and the type of 
change such as 
inserted or deleted. 

TIP 
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Switching On Tracking Changes: 

1. Click on the Review Tab. 
2. Go to the Track Changes options in the Tracking Section. 
3. Once click on the Track Changes button, it will turn an orange color to indicate that the tracking changes 

has been turned on. 
 

 Any text that is deleted becomes colored and crossed-through.  

 Any new text that is added is either:  
 
1) colored and inserted within the text  

 
OR 
 

2) Shown in the extended right margin in a balloon.  
 

 Any line of text that contains any edits is indicated by a vertical line in the left margin.  

 

 

8. Tracking Changes with Balloons 

Any new text that is added, when tracking changes is switch on, will either be inserted in line with the text or 
shown in the extended right margin in a bubble: 

1. Go to the Review tab and locate the Tracking group.  

2. Click on the show Markup Button and then click on Balloons command button.  

3. Select the option you require from the three offered to you.  
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Accepting/Rejecting Changes: 

1. Locate the revision and click anywhere onto it.  

2. Alternatively, use the Next or Previous command buttons to jump to each revision in turn  

 

3. To ACCEPT the change click on the Accept button. 

4. To REJECT the change click on the Reject button.  

Showing Markup: 

If you find the display of the marks when you are trying to decide whether to accept or reject the changes you 
can choose different ways to view the proposed changes to your document.  

 Final Showing Markup: This shows the document with all the proposed changed included.  
 

 Final: This shows the document with all the proposed changes included minus the markup  
 

 Original Showing Markup: This shows the original document with the proposed changes included 
with the markup  

 Original: This shows the documents before any changes were made and without the markup. 

 

 

 

Note, if you do not 
select any text Word 
will assign the 
comment to the 
word closest to the 
cursor positioned in 
your document. 

Note 
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Comments: 

Comments provide you with a useful way to leave notes about parts of the document without any note text of the 
document text. You could leave notes about text you need to check up on or edit. Also, your proof reader or 
supervisor could leave notes for you. 

 

Inserting Comments: 

1. Select the text you wish to write the comment for. 

2. Go to the Review tab and locate the Comments group.  

3. Click on the New Comments button.  

 

 

Deleting Comments: 

1. Right click the comment and then select Delete Comment  

 

To Delete all the Comments in a Document : 

1. Go to the Review tab and locate the Comments group  

2. Click on the lower part of the Delete command button  

3. Select delete all comments in document. 

 

9. Editing Options 

Word Count: 

When you type in a document, Word automatically counts the number of pages and words in your document and 
displays them on the status bar at the bottom of the workspace. 
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Count the Number of Pages, Characters, Paragraphs, and Lines 

The Word Count dialog box displays the number of pages, paragraphs, and lines in your document, and also 
the number of characters, either including or excluding spaces. 

 On the Review tab, in the Proofing group, click Word Count. 

 

 

Set Language: 

If you created a document that contains text in different languages, and you want to use the appropriate language 
dictionaries to check the spelling of each language you have included, then you have to set the proper language. 

To procedure to set proper language has following steps: 

1. Create a New Word document, or open an existing document having text in English US and English 

UK. 

2. Select the text for which you’d like to change the proofing language.  

 

3. From the Review ribbon, Click Language and Set Proofing Language. 

If you don't see the 
word count in the 
status bar, right-click 
the status bars, then 
click Word Count. 

Do you know! 
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4. Choose English (U.K.) or English (U.S.) and Click OK. U can choose different languages as well.  

 

5. The text wil be changed. 
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Reviewing Pane: 

The Reviewing Pane displays all of the changes that currently appear in document, the total number of changes, 
and the number of changes of each type. 

 

Spell Checking: 

By default, Word automatically checks document for spelling and grammar errors, so you may not even need 
to run a separate spelling and grammar check. These errors are indicated by colored wavy lines. 

 The red line indicates a misspelled word. 

 The green line indicates a grammatical error. 

 The blue line indicates a contextual spelling error. This feature is turned off by default. 

 

The Reviewing Pane 
is another way that 
you can check for 
any hidden changes 
and comments 
before sending on 
the document to 
other people. 

Note 
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Spelling can be checked by right clicking to the end of last character of the word or from Review tab>Proofing 
Group>Spelling & Grammar button. 
 

10. Working with Text Editing 

Inserting Text in a File 

To insert text to your document, use the keyboard or the mouse to position the cursor where you want to add 
your text. If any text is selected, your typing will over-write the selected text. 

The procedure to insert the text in a file has the following steps: 

1. Move your mouse to the location where you want text to appear in the document. 

2. Click the mouse. The insertion point appears.  

 

3. Type the text you want to appear. 

 

Deleting Text: 

1. Place the insertion point next to the text you want to delete. 

2. Press the Backspace key on your keyboard to delete text to the left of the insertion point. 

3. Release the mouse button. You have selected the text. A highlighted box will appear over the selected 

text. 

 

  

The whole 
page/Paragraph can 
also be deleted by 
selecting text and 
pressing backspace 
key just once. 

Note 
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Learner’s Activity 
 

 Open an existing Word document 
 

 Turn on Track Changes 
 

 Delete some text 
 

 Add some text 
 

 Change some of the text formatting 
 

 Experiment with the Display for Review command 
 

 Accept all of the changes 
 

 Review the document 
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Learning Unit 4: Format Word Document 

Overview 

 
In this learning unit you will learn about the formatting of body text and headings such 
as font styles, colors, alignment and page number. After completion of this learning 
unit, you will be able to format the paragraphs and pages according to the 
requirements. 
 

1. Features of Formatting 

To create and design effective documents, you need to know how to format text. 
Formatted text can emphasize important information and help to organize document. 

In Word, there are several options for adjusting the font of text, including size, color, 
and inserting special symbols. You can also adjust the alignment of the text to change 
how it is displayed on the page. The text formatting toolbar is given below with the 
options related to text formatting.  

 

 

 

2. Formatting Text 

1) Changing Font Style: 

The procedure to change the font style has the following steps: 

1. Select the text you want to modify. 

Text to Table option 
is only available in 
the insert menu 
when text is 
selected. 

Remember 

The selected Table 
is converted into 
Text. Each row gets 
converted into a 
paragraph. The text 
in each cell of the 
row gets separated 
by tabs. 

Do you know! 
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2. Click the drop-down arrow next to the Font box on the Home tab. The Font drop-down menu appears. 
3. Move the mouse pointer over the various fonts. A live preview of the font will appear in the document. 

 

4. Select the appropriate font style... The font will change in the document. 

 

2) Changing Font Size:  

1. Select the text you want to modify. 

2. Click the drop-down arrow next to the Font Size box on the Home tab. A drop-down menu appears. 

3. Select the desired font size from the menu.  

 
3) Change Case: 

You can change the text from upper case to Lower Case or vice versa from the Change Case option. 

1) Select the Desired text. 

2) Click the drop-down arrow of change case box (next to shrink font option). 

You can also use 
the Grow 
Font and Shrink 
Font commands to 
change the size. 

 

Do you know! 
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3) Select the desired case. 

 

 

3. Paragraph Setting  

Many options are available in MS Word for Paragraph setting. 

1) Changing Font Color: 

The procedure to change the font color has the following steps:  

1. Select the text you want to modify. 

2. Click the Font Color drop-down arrow on the Home tab. The Font Color menu 
appears. 

3. Move the mouse pointer over the various font colors. A live preview of the color 
will appear in the document. 

4. Select the font color you want to use. The font color will change in the document. 

More colors can be 
used from the \More 
Color option at the 
bottom of the list. 

Do you know! 
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Highlighting Text:  

The text can also be highlighted from the Text Highlight Color Option located in the 
Font Group. 

 

 

 

To remove the text 
Highlight effects 
click the option No 
Color. 

Remember 

Mostly these options 
are used to make a 
heading.               To 
remove effect of 
these commands 
select the text and 
click the options 
once again. 

Do you know! 
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4. Using Bold, Italic and Underline Command 

1. Select the text you want to modify. 

2. Click the Bold, Italic, or Underline command in the Font group on the Home tab. 

 

Changing Paragraph Allignment: 

1. Select the text you want to modify. 

2. Select one of the four alignment options from the Paragraph group on the Home tab. 

 Align Text Left: Aligns all selected text to the left margin 

 Center: Aligns text an equal distance from the left and right margins 

 Align Text Right: Aligns all selected text to the right margin 

 Justify: Aligns text equally on both sides and lines up equally to the right and left margins; used 
by many newspapers and magazines 

 

 

When you're editing 
a list, and 
press Enter to start 
a new line, the new 
line will 
automatically have a 
bullet or number. 
When you've 
reached the end of 
your list, 
press Enter twice to 
return to normal 
formatting. 

Remember 
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Using Bullets and Numbering: 

When you want to organize lists in Word, you can format them as either bulleted or numbered lists. Word offers 
a variety of bullet options that allows to customize lists to suit your needs. 

The procedure to create a bulleted list has following procedure: 

1. Select the text you want to format as a list. 

2. Click the Bullets or Numbering drop-down arrow on the Home tab. 

 

3. Select the bullet or numbering style you want to use, and it will appear in the document. 

4. To remove numbers or bullets from a list, select the list, then click the Bullets or Numbering commands. 

 

Multilevel List: 

Multilevel lists allow you to create an outline with multiple levels. 

You can then use the Multilevel List command to choose the types of bullets or numbering that are used. 

The procedure to use multilevel list have the following steps: 

1. Select the text you want to format as a multilevel list. 

2. Click the Multilevel List command on the Home tab. 

3. Click the bullet or numbering style you want to use. It will appear in the document. 

4. Position your cursor at the end of a list item, then press the Enter key to add an item to the list. 

1. To change the level of list place the insertion point at the beginning of the line. 
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2. Press the Tab key to increase the level.  

 

3. Hold Shift and press Tab to decrease the level. 

 

Setting Line Spacing of a Paragraph: 

Line spacing refers to the distance between the lines in a paragraph. Different line spacing options are available 
in the paragraph group of Home tab. Line spacing of a paragraph can be adjust by clicking on the appropriate  
value from the drop down command on line spacing option.  

Already applied line 
spacing option 
appears with the 
sign on the left 
side of spacing 
value. 

Note 



Module 2: Prepare Word Document 

146 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 

 

5. Adding Page Numbers  

The procedure to insert the page number in the document has the following steps: 

1. From the Insert tab, click Page Number. A drop-down menu will appear. 

2. Select the desired page number style and it will appear in your document. 
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Formatting Page Numbers 

1. Select the header or footer that contains the page number. 

2. From the Design tab, select the Page Number command. 

3. Click Format Page Numbers. 

 

4. From the dialog box, select the desired Number format. 

 

5. Next to Start at, enter the number you want the page numbers to start with. 
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6. Separate Heading in the Text  

The most easy and best way to add heading in the word document is to use Styles. You can use the Built-In 
styles available in Styles Group in Home tab or can customize your own styles.  

To use the Built-In styles for heading has the following steps: 

1. Select the Text you want to make as Heading.  
2. Click the proper styles of Heading. 

 

 

3. The style will be applied on the selected text. 

 

You can customize 
any give styles 
according to your 
requirement by right 
clicking on the style 
and selecting the 
Modify option. 

Do you know! 



Module 2: Prepare Word Document  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 149 

Using Appropriate Styles of Font: 

Styles and themes are powerful tools in Word that can help you easily create professional-looking documents. 
A style is a predefined combination of font style, color, and size of text that can be applied to selected text.  

Applying a Style: 

1. Select the text you want to format. 

 

2. In the Style group on the Home tab, However each style to see a live preview in the document.  
3. Select the style you want. The selected text appears formatted in the style. 

 

To apply a Style Set: 

Style sets include a combination of title, heading, and paragraph styles. Style sets allow you to format all of the 
elements of your document at once, rather than formatting your title and headings separately. 

1. Click the Change Styles command on the Ribbon. A drop-down menu will appear. 

2. From the drop-down menu, select Style Set. 
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Figure 2. 1 

 

3. Select the Style Set you want and the change will be reflected in the entire document. 

 
 

  



Module 2: Prepare Word Document  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 151 

Learner’s Activity 
 

 Open an existing Word document. Write some text on the page 
 

 Change the font size of text to “12” 
 

 Change the font style of some text to “Arial” 
 

 Change the font color of some text 
 

 Make a heading of the paragraph and set its alignment to Centre and underline it 
 

 Try various cases using the Change Case command 
 

 Try the four alignment commands 
 

 Set the line spacing to “1.15” 
 

 Apply bulleted text 
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Learning Unit 5: Save Word Document 

Overview 

In this learning unit you will learn that how to save a file with different name and location. 
After completion of this learning, you will be able to save files with different methods on 
different storage locations.  

1. Method of Saving a File 

When you make a new document you will need to save it so that in future you can open and edit it. Word offers 
many ways to save a document. 

Save a File through Short Key: 

The procedure to save a document for the first time through CTRL+S has the following steps: 

1. Click the Save command  on Quick access toolbar or press the CTRL+S from the keyboard. 

 

2. The “Save As” dialogue box will be appears on the screen. Select the location where you want to Save 
the Document. 

3. Enter the name and press “Save” button. 
5. The file will be saved  

 

Save a file through File Tab: 

A File can also Save by clicking on the File tab and selecting the option Save or Save as. 

Files with same 
names cannot be 
saved at a same 
location in the 
computer. 

Remember 
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2. Storage Device 

When data is entered and processed in a computer, it needs to be stored on any storage device in computer. 
You can store data permanently on the computer hard disk or any other storage device. 

A storage device is any computing hardware that is used for storing, porting and extracting data files and objects. 
It can hold and store information both temporarily and permanently. 

3. Memory and Its Capacity Unit  

Memory unit is: 

 The amount of data that can be stored in the storage unit. 

 That in which storage capacity is expressed in terms of Bytes. 

Following are the storage units: 

 

Reno. Unit Description 

1 Bit (Binary Digit) Bit is the smallest memory unit in computer. 1 character takes 
space of 1 bit. 
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2 Nibble A group of 4 bits is called nibble. 

3 Byte A group of 8 bits is called byte. A byte is the smallest unit which 
can represent a data item or a character. 

4 Word A computer word, like a byte, is a group of fixed number of bits 
processed as a unit which varies from computer to computer 
but is fixed for each computer. 
The length of a computer word is called word-size or word 
length and it may be as small as 8 bits or may be as long as 96 
bits. A computer stores the information in the form of computer 
words. 

 

 
 
Some higher storage units are as follows: 
 

 
 

Sr.No. Unit Description 

1 Kilobyte (KB) 1 KB = 1024 Bytes 

2 Megabyte (MB) 1 MB = 1024 KB 

3 Gigabyte (GB) 1 GB = 1024 MB 

4 Terabyte (TB) 1 TB = 1024 GB 

4. Difference between Save and Save as Option 

Save and Save As option works same when you are saving a file for the first time. Both save the file with a name 
and a selected location. When you have to save the changes in existing document “Save” button is used. 

While “Save As” option is used to save the file with different name and a location. 

 

Save a File with “Save As” Option: 

“Save As” command used to save a revised document to a new name or location, keeping the original file as it 
was before revisions. For example you want to save an existing file with new name “MS Word” and in “Local 
Disk (D :)”. 

 

The procedure to save a file has the following steps: 

1. Left click on the File Tab. 
2. Click the option “Save As”. 
3. A small window will appear. Change the location and name of the file and press save button. 
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4. File will be saved in the Local Disk (D :) with the name “MS Word”. 
5. Close the file. 

Saved file can be open by clicking on the file menu and selection close option. 

To open the saved file from the storage device has the following steps: 

1. Open the Microsoft Word. 
2. Click on the File tab and then click the Open option. 
3. Small window will appear on the screen, select the location from the left side pane, where file has been 

saved. 
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4. The file will be open. 

 

Save a file with Save Option: 

When you open an existing document and make any changes in it. The changes made in the document can be 
save by clicking on the Save option from the File tab. Save option just save the changes in the document. 
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Learner’s Activity  
 

 Open a New Document, save it with the name Computer Operator and locate the File on the Desktop 
 

 Open this document again. Write a paragraph in it and save changes in it 
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Learning Unit 6: Insert in a Word Document 
 

Overview 

In this learning unit you will learn to insert different types of objects in the document. After completion of this 
learning unit you will be able to insert pictures, clipart, charts, header footer and tables in your document. 

 

1. Objects in the Word File  

Different object are available that you can insert in the MS Word Document. These options can be open from the 
Insert tab. 

 

2. Inserting Objects  

Adding clip art, shape and pictures to your document can be a great way to illustrate important information or 
add decorative accents to existing text.  

Inserting Pictures: 

The procedure to insert a picture has the following steps: 

1. Place the cursor where you want to insert the picture. 

2. Select the Insert tab. 

3. Click the Picture command in the Illustrations group. The Insert Picture dialog box appears. 
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4. Select the desired image file, and then click Insert to add it to your document. 

 

 To resize an image, click and drag one of the corner sizing’s handles. The image will change size while 
keeping the same proportions.  

 

Inserting Clip Art: 

There are built-in clip art images for just about every topic. 

The procedure of inserting Clip Art in the document has following steps: 

1. Select the Insert tab. 

2. Click the Clip Art command in the Illustrations group of Insert tab. 

By dragging the 
middle size handlers 
on all the sides, 
image can be re-
size vertically or 
horizontally. 

TIP 
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3. The clip art options appear in the task pane to the right of the document. 

 

4. Enter keywords in the Search for: fields that are related to the image you want to insert. 

5. Deselect any types of media you do not want to see and click button Go. 

 The Clip Art menu will be displayed. 

 

 Left Click on the Clip art that you want to insert. The image will be displayed on the page. 
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Inserting Shape: 

Word's large shape collection allows you to organize and design the image you want. The procedure to insert the 
shapes in the document has the following steps: 

1. Select the Insert tab. 

2. Click the Shapes command.  

 

3. Select a shape from the drop-down menu. 

4. Click and drag the mouse until the shape is drawn. 

 

5. Release the mouse button. 

Inserting Smart Art: 

Smart Art allows you to visually communicate information rather than simply using text.  

You can add text to 
any shape by right 
clicking in the shape 
and selecting the 
option “Add Text”. 

Remember 
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1. Place the insertion point in the document where you want the graphic to appear. 

2. Select the Insert tab. 

3. Select the Smart Art command in the Illustrations group. A dialog box appears. 

 

4. Select a category to the left of the dialog box, and review the Smart Art graphics that appear in the center.  

5. Select the desired Smart Art graphic, and then click OK.  

 

6. The selected smart Art graphic will be displayed on the page. 

Any shape can be 
deleted by selecting 
the shape and 
pressing the Delete 
key from the 
keyboard. 

Remember 

You can add shape 
(Before, after, above 
below) by right 
clicking the shape 
and selecting the 
Add Shape option. 

Do you know! 



Module 2: Prepare Word Document  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 163 

 

7. Click in the shapes and type the text. 

Inserting Chart: 

 In Microsoft Word, you can insert many types of data charts and graphs, such as 
column charts, line graphs, pie charts, bar charts, area graphs, scatter graphs etc.  

The procedure of inserting a graph in the document has the following steps: 

1. On the Insert tab, in the Illustrations group, click Chart. 

 

2. In the Insert Chart dialog box, click the arrows to scroll through the chart types. 
3. Select the type of chart that you want and then click OK. 

 

4. Chart will be displayed on the page and at the same time an excel sheet will be open with dummy values. 

Once Chart is 
created you can edit 
the values by 
selecting the chart 
and clicking the 
chart Tool 
tab>Design>Edit 
Data. 

Important 
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5. Enter the values in the excel sheet, the chart will automatically adjust according to the values. 
6. When data is entered in excel sheet close it. 

Adding Symbols and Equations: 

You can type mathematical equations in MS word Document. These can include fractions, integrals, matrices, 
mathematical symbols, etc. 

1. On the Insert tab, in the Symbols group, click the arrow next Equation. 

 

2. Click the equation that you want, or click Insert New Equation to type an equation. 

Symbols:  

You can use the Symbol dialog box to insert symbols that are not on your keyboard, as well as Unicode 
characters. 

Word Art: 

You can add effects to the text inside the text box, which is known as WordArt. 

A quick style will automatically apply several effects to your text at once. You can then refine the look of your 
text by adding or modifying text effects. 
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1. Select the text box, or select some text inside of the text box. The Format tab will appear. 

2. Click the Format tab. 

3. Click the Quick Styles command in the WordArt Styles group. A drop-down menu will appear. 

 

Converting Simple Text to Word Art: 

Text that is formatted as WordArt, it needs to be inside of a text box. However, there's a shortcut that allows you 
to convert text into WordArt even if it's not in a text box. 

1. Select the text you want to convert. 

2. Click the Insert tab. 

3. Click the WordArt command. The Quick Styles drop-down menu will appear. 
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More Insert Option: 

More Insert options are available in MS Word as Insert Table, Cover page, Blank Page, Header,Footer, Hyperlink, 
Bookmark etc. 
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Learner’s Activity 
 

1. Create a new Word document 

 

2. Insert a shape 

 
3. Change the shape to a different shape 

 
4. Change the fill color 

 
5. Change the outline color 

 
6. Try various shadow effects 
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Learning Unit 7: Import Document 

Overview 

 
In this learning unit you will learn how to import data of different formats within the document from computer or 
online. After completion of this learning unit you will be able to import different types of data with different 
resources. 
 

1. Importing in Word File  

Object Linking and Embedding (or OLE for short) is a technique used to insert data from one program into 
another. You’ll create a simple spreadsheet to illustrate the process, and place it in to Word document. 

The process to embed an object in MS Word has the following steps: 

1. Open MS Word file. 
2. Select the Insert ribbon, choose Object. 

 

3. A dialogue box will be open, select the format in which you want to embed the file. 
4. For example choose the MS Excel worksheet and click Ok. 
5. An blank Excel Sheet will be open, 
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6. Enter the data in the Excel sheet and close it. Data will be automatically added in the MS Word sheet. 

 

7. Similarly you can add different format objects in the MS Word Sheet. 
 

2. Using References for Imported Material  

A bibliography is a list of all of the sources you have used (whether referenced or not) in the process of 
researching your work. In general, a bibliography should include: 

 the authors' names 

 the titles of the works 

 the names and locations of the companies that published your copies of the sources 
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 the dates your copies were published 

 the page numbers of your sources (if they are part of multi-source volumes) 

To insert a bibliography using the Bibliography tool, you must first enter references and sources. 

The procedure to insert Bibliography has the following steps: 

1. Open your document in Microsoft Word 2010 and click on the References tab.  
2. Place your cursor where you want the citation inserted. Select your style of references in the Style menu, 

 

3. Click on the Insert Citation button to produce the drop-down menu shown below, and select Add New 
Source 
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4. A Create Source window will appear. Choose the source type from the drop-down menu.  Enter the 
source information in the fields provided and click OK. 

 

5. Note that a reference has been entered. Follow Steps again to insert your remaining references.  
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Learning Unit 8: Protect the Word Document 

Overview 

 
In this learning unit you will learn how to protect the document by restricting its formatting and its editing. After 
completion of this learning unit you will be able to protect your document through password and applying 
restrictions. 
 

1. Limiting Formatting of Word Document 

Restricting and protecting a document ensures that you have the complete authority over its progress. 

If you want that other reviewers suggest changes and make comments to a document, at that time it may possible 
that you want to restrict them from making editing and changing the formatting. 

Word allows you to restrict all or some of the themes and styles, as well as permitting reviewers to change some 
of the themes and styles. 

The procedure of applying restrictions on the document has the following steps: 

1. Click “Restrict Editing” in the “Protect” group of the “Review” tab. 

 

2. The “Restrict Editing” pane displays to the right of the main text. 
3. In the “Formatting restrictions” section, select “Limit formatting to a selection of styles,” and click the 

“Settings…” link. 
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On the “Formatting Restrictions” dialog box, all styles in the “Checked styles are 
currently allowed” box are selected by default. To select only certain styles to be used 
in the document, you can use the “None” button to de-select all the styles and then 
select the ones you want to allow. You can also use Word’s recommended minimum 
styles to allow by clicking “Recommended Minimum.” Choose additional restrictions 
in the “Formatting” section at the bottom of the dialog box, if desired, and click “OK” 
when done.  

Before these 
restrictions can be 
applied, you must 
start enforcing 
protection 

Remember 
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The following dialog box displays asking if you want to remove styles that are not allowed. We recommend you 
do not. It may turn out that you want to use these styles in the document in the future. Other reviewers will not 
be able to change them or apply them. 

Click “No” to keep the styles that are not allowed in your document. 

 

 

2. Restrict Editing in a Document  

You can restrict the type of editing reviewers can perform on a document.  

1. On the “Restrict Editing” pane, select the “Allow only this type of editing 
in the document” check box. 
 

2. Select an option from the drop-down list to indicate the type of editing that you 
want to allow in your document. You can allow other reviewers to only track 
changes, enter comments, or fill in forms. You can even restrict the 
document such that other people can only read it and make no changes. 

 
3. If you want users to edit portion of the document content then select the 

content and under Exceptions (options), select the users you want to give 
permission of editing. If you want to add users for this, click more users.  

When someone will 
try to edit the 
document, Restrict 
Formatting and 
Editing bar will 
appear, but they can 
find the regions 
which they can edit. 

Do you know! 
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Once you’ve restricted formatting and editing for the document as desired, you must 
tell Word to start enforcing the protection for it to take effect. In the “Start 
enforcement” section of the “Restrict Editing” pane, click “Yes, Start Enforcing 
Protection. 

 

Passphrase can be entered to make your document password protected. If you want to encrypt document and 
allow authorized users to remove protection when they want, then enable User authentication. Click OK and 
save the document. 

 

 

3. Saving a Document with a Password 

The procedure to save a word document by assigning a password has following steps: 

1. Open Microsoft Word 2010 document. Click on File Tab. 
2. Click on Info option. 

A password is not 
necessary and does 
not fully protect the 
document (the 
document is not 
encrypted). It simply 
helps to prevent 
people from turning 
off the formatting 
and editing 
restrictions. 

Note 
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3. Click on the Protect Document button under Permissions tab. 
4. Select the Encrypt with Password option. 

 

5. A window will pop up asking you to put in the desired password. Set a Password for Word document 
and click “OK” button. 
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6. It’ll again ask to “Re-enter password”, so type it again and click “OK” button. 
7. After password protecting your document, save the changes by pressing CTRL+S Buttons from your 

keyboard or go to File Tab of your document and click Save option. 
 

4. Opening a Password Protected Document  

To open your password protected document, simply double click the document and a pop up box will appear and 
prompt you to enter the password. Simply enter the password that you have set-up for this file and click “OK”. 
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Learning Unit 9: Insert Table in a Word Document 

Overview 

In this learning unit you will learn how to insert tables from different methods in your document and its formatting. 
After completion of this learning unit you will be able to make tables and format tables. 

1. Inserting Table 

A table is a grid of cells arranged in rows and columns. Tables can be customized and are useful for various 
tasks such as presenting text information and numerical data.  

Inserting a Blank Table: 

The procedure to insert a blank table in MS Word has following steps: 

1. Place your insertion point in the document where you want the table to appear. 

2. Select the Insert tab. 

3. Click the Table command. 

4. Hover your mouse over the diagram squares to select the number of columns and rows in the table. 

 

5. Click your mouse, and the table appears on the page. 
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2. Inserting Table through Different Options  

Table can be inserted from the Insert Table option located in the table tool and from draw table option. 

Inserting Table through Dialogue Box: 

The procedure to insert the table through Insert Table tool has the following steps: 

1. Place the cursor where you want to add table. 
2. Click on the Insert tab and then click on the arrow of Table. 

 

3. Select the option Insert Table…. A dialogue box will appear. 

 

4. Set the number of Rows and Columns and click OK. 
5. Table will be inserted on the page. 
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Inserting a Row OR Column: 

1. Place the insertion point in a row below the location where you want to add a row. 

 

2. Right-click the mouse. A menu appears. 

3. Select Insert Insert Rows Above. 

 

4. A new row appears above the insertion point. 
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Deleting Row or Column: 

The procedure to delete a row/column has the following steps: 

1. Select the row or column. 

2. Right-click your mouse. A menu will appear. 

3. Select Delete Cells. 

 

4. Select Delete entire row or Delete entire column, then click OK. 

 

Formatting of  A Table: 

Once you have make the table different formatting can be applies on the table.  

Setting Table Style: 

1. Click on the table. The Design tab will appear on the Ribbon. 

2. Select the Design tab and locate the Table Styles. 

3. Click the More drop-down arrow to see all of the table styles. 
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4. Hover the mouse over the various styles to see a live preview. 

5. Select the desired style. The table style will appear in the document. 

 

 

3. Inserting Table with Five Rows and Six Columns 

To insert the table in the document follow these steps: 

1. Open word file and click on the point where you want to insert the table. 
2. Click on the Insert tab and click on the down arrow of Table Option. 
3. Hover the mouse to the Six boxes vertically and 5 boxes horizontal and click.  

 

4. Table will be inserted on the page. 
5. Click in the each cell and write some text. 

Tab button can be 
used to jump from 
one cell to other for 
entering text. 

Important 
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6. To apply the style on the table click anywhere in the table, the Table Tools ribbon will be displayed on 
the title bar. 

7. Select any table style from the Table Style tab. 
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Learner’s Activity 
 

 Make a table with 6 Columns and 5 Rows 
 

 Enter the values in it 
 

 Apply a border of Green color on table with shaded Heading Row 
 

 Practice to merge two Columns and again split it 
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Learning Unit 10: Hyperlink Data in a Word Document 

Overview 

 
In this learning unit you will learn how to associate data as a hyperlink in the document. 
After completion of this learning unit you will be able to access data using hyperlink.  

1. Hyperlink in the Word File 

The procedure to insert a hyperlink has the following steps: 

1. Select the text or image you want to make a hyperlink. 

2. Right-click the selected text or image, then click Hyperlink. You can also right-
click in a blank area of the document and click Hyperlink.  

3. The Insert Hyperlink dialog box will open. You can also get to this dialog box 
from the Insert tab by clicking Hyperlink. 

4. If you selected text, the words will appear in the Text to display: field at the top. 
You can change this text if you want. 

5. Type the address you want to link to in the Address: field. 

 

 

6. Click OK. The text or image you selected will now be a hyperlink. 
 

To follow a hyperlink 
in Word, hold down 
the Control key and 
click the hyperlink. 

Important 

Hyperlinks have two 
basic parts: 
the address of the 
webpage, email 
address, or other 
location they are 
linking to; and 
the display text (or 
image). 

Important 

After you create a 
hyperlink, you 
should test it. If you 
have linked to a 
website, your web 
browser should 
automatically open 
and display the site. 

TIP 
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Removing a Hyperlink: 

1. Right-click the hyperlink. 

2. Click Remove Hyperlink. 

 

 

2. Opening and Closing of Hyperlinked Data  

When a hyperlink is created in the document you can open it to see the attached document/website.  

The procedure to open and close the hyperlink data has the following step: 

1. Open the document in which hyperlink is created. 
2. Press Ctrl+Click button to follow the link behind the hyperlink. 

 

 

3. The linked document/ Website will be open. 
4. Close the opened window of the linked page, the page having the hyperlink will be displayed. 

 

 

Bookmark names 
can contain letters, 
digits, and the 
underscore 
character (_), but 
they must begin with 
a letter and cannot 
contain a space. 

Important 
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3. Bookmark, Cross Reference, Hyperlink  

Bookmark: 

Bookmark specifies the location of a point or of a block of text or other content within a document.  

Cross Reference: 

If you are writing a long document, you may want to include references from one part to another. To avoid having 
to update pagination, headings or figure numbers, you can use Word’s cross-reference feature. Since Word 
inserts cross-references as hyperlinks, you can also use them to jump to the target. Cross-references are limited 
to a specific number of forms: the text, paragraph (or footnote/endnote) number, or page number of the cross-
referenced location, while hyperlink can display any text you want. Cross-references are internal only and 
hyperlinks can refer to an external document  
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Learning Unit 11: Perform Mail Merge in a Word 
Document 

Overview 

 
In this learning unit you will learn how to use mail merge function. After completion of this learning unit you will 
be able to perform mail merge function according to available data. 
 

1. Purpose of Mail Merge Function 

 
Mail Merge is a powerful tool for writing and sending a personalized letter or e-mail to many different people at 
the same time. You can also use it to create envelopes or labels with each recipient' information. Mail Merge 
imports data from another source such as Excel and then uses that data to replace placeholders throughout your 
message with the relevant information for each individual you are messaging. You can use it to quickly create 
personalized messages for hundreds of people at once. 
 

2. Mail Merge Function Using given Data  

Mail merge mainly consists of two files, the Main Document and the Data Source. The 
Main Document contains the information that will remain the same in each record, and 
the Data Source contains all the variable information, in the form of fields. This is the 
information that will change in the Main Document when the merge is completed. Along 
with the information that remains the same, the Main Document also contains merge 
fields, which are references to the fields in the Data Source.  

If you have an existing file and you want to use mail merge, then follow these steps: 

1. Go to the Mailings Option to start the Mail Merge. 
2. Click on the mail merge option and select the document type (select Normal 

Word Document). 
3. Now click on the Select Recipients to select the recipient. There are 3 option available for this step: 

 

 Create New List: to create new list of recipient click on this option. This sets up the name, 
mailing address etc. of the recipients and then stored in a Word table, which can easily be 
transferred to an Excel Data Source later if required. 
 

 Use Existing Field: Let’s you browse to and open a word, Excel, Access or text file Data Source. 
 

 Select from Outlook Contacts…Use an Outlook or Outlook address book as the Data Source. 
 

4. Select Create New List option to create a list of recipient. A new window will be open. Enter the values 
with required fields and click “OK”. 

When you save the 
main document at 
this point, you are 
also saving the data 
source and 
attaching the data 
source to the main 
document. 

Remember 
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5. Click OK to return to the main document. 
6. Save the main document.  
7. Type the name that you want to give to your main document, and then click Save. 

 

3. Making Labels and Address Books 

The procedure to make labels has the following steps: 

1. To start the mail merge for labels, you should have a list of all the addresses. Make a list in Excel sheet 
including all fields that you want to add in label and save it. 

2. Open Ms Word 2010 and click on the Mailings tab. 
3. Click on Start Mail Merge and then select Labels.  

 

4. When you click on Labels, a Label Options window opens. Go ahead and select the Label vendors. 

This electronic 
postage option 
requires that you 
have a postage 
software program 
installed on your 
computer. 

Note 
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5. Then select the labels you want and click OK. 
6. Select Recipients and then select Use Existing List and use the excel sheet of address list. 
7. Point to the location where the excel spreadsheet is located.  

 

8. Select the appropriate Table. 

Please check the 
check mark next to 
the first row of data 
that contains column 
headers. You should 
have column 
headers otherwise 
you will only see A, 
B, C, etc. and it will 
be very difficult for 
you to figure out 
which column is the 
first name and which 
one is the zip code. 

Important 
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9. After you click OK, your Word 2010 document should look like this. You should see each separate label. 

 

10. Now click on the Address Block to specify address elements and then click OK. 
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11. Now you can see Address Block on your first label. Then click on Update Labels option in Write & 
Insert Field Group, to apply changes on all labels. 

12. Now click on Finish & Merge! But before you print the documents, click on Edit Individual Documents.  
13. Make sure all is selected and click OK. This will make sure all of your records from the spreadsheet are 

being added to the mail merge. 

 

 

4. Different Attributes of Mail Merge  

1. Open the word Document and type the text or graphics want to include in your letter. 
2. Select the Letter type from Mail Merge Option. 
3. Select Use existing list from the Select Recipient option. 
4. Add the field codes where you want the variable information to appear. In the Mail Merge task pane, you 

have four options: 
5. Address block: Use this option to insert a formatted address. 

 

 Greeting line: Use this option to insert a formatted salutation. 

 Electronic postage: Use this option to insert electronic postage.  

Make sure that your 
cursor is where you 
want to insert the 
information from 
your data source 
before you Add field 
Codes. 

Important 
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 More items: Use this option to insert individual merge fields. When you click More Items, 
the Insert Merge Field dialog box appears.  The below diagram show the field codes that we 
enter 

 

6. When you finish editing the main document, click Save or Save As on the File menu.  
7. Click on the Preview Results option in the Preview Result tab. Preview Result option allows you to 

preview your merged data. 

 

Changing the Format of Merge Data: 

To format merged data, you must format the merge fields in the main document. Don’t format the data in the Data 
source because the formatting can not retained when you merge the data in main document. To change the 
format of the merged data, follow these steps: 

1. In the main document, select the field that contains the information that you want to format, including the 
enclosing merge field characters (<< >>). 

2. Select the option that you want in the Font group on the Home tab. 
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5. Procedure of Mail Merge  

If you have to send a thanks letter to your friends using mail merge option firstly you have to write a thanks giving 
letter. After writing letter start Mail Merge. 

The procedure to start a mail merge has the following steps: 

1. To start your mail merge, click on the Mailings tab, then click on the Start Mail Merge icon and 
select Letters. 

 

2. Next, click on the Select Recipients icon and select Use Existing List. 
3. Select the Sheet1$ option, make sure the check box is checked next to First row of data contains 

column headers, and then click OK. 
4. Next, position your cursor to a location where we are going to insert the salutation and type 

in Dear <space>. 

 
5. Now you can insert merge fields. You can do it automatically by clicking Address Block or Greeting 

Line option. With your cursor being located right after “Dear”, click on the Insert Merge Field Option. 
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6. Select Salutation and first-name field .Your merge field should now appear in your document. 

 

7. Same like this you can add different fields on the letter and can format them. 
8. To see the actual address in your letter you need to finish the merge. To do so, make sure you are in 

the Mailings tab, click on the Finish & Merge option and select Edit Individual Documents. 
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Learner’s Activity 
 

 Write an Invitation Letter for wedding 
 

 Make a list of Recipient in excel 
 

 Also use Label for each recipient 
 

 Use Greeting line or insert fields in letter 
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Learning Unit 12: Insert Header/Footer in a Word 
Document 

Overview  

In this learning unit you will learn how to use header and footer in the document. After 
completion of this learning unit you will be able to insert header, footer and page 
number in the document. 

 

1. Purpose of Header and Footer 

Header: Header is the text included in the top margin of the page separated from the main body of the text. A 
header usually includes information such as the title of the book, the author and/or the name of the chapter 
reading. It may also include the page numbers. A header used continuously throughout the document is known 
as a running header, in publishing. The left hand page (verso) includes the title and the right hand page (recto) 
includes the title of the subsection or the chapter. In academic writing, the header may contain the name of the 
author and the page title. 

Footer: Footer is the bottom margin of the page which is separated from the main body of the text. Like the 
header, the footer may also run throughout the document and it is usually reserved for the page numbers. Any 
annotations to the main text may also be included at the bottom of the page as a reference, which is called a 
footnote. The page footer is different from the footnotes. Footnotes are relevant only to the text of the specific 
page. 

2. Inserting Header & Footer 

The procedure to insert header and footer in the document has following steps: 

1. Open the MS Word document. 
2. Place the cursor on the upper portion of the page outside the margin and double click. 
3. The thin, dashed blue line in the bottom of your header, and everything above is the area where you can 

type your header text. 
4. Type the text that you want to add in the header. 
5. Double Click on the page to close the header section. The header will be applied on all the pages of the 

document. 

The footer can also be applied on the lower part of the page outside the margin. 

3. Difference between Header & Footer  

 The header is the top most portions separated from the main body containing text for general information 
about the text. 
 

 The footer is the equivalent to the header which is placed at the bottom of the page, and it is usually 
reserved for the page numbers and the footnotes to the main text. 

Design Tab of Header Footer: 

When you click to insert header/Footer option, the following design tab of Header/Footer opens. 

You can format the 
text in the header 
section and can 
insert shapes. 

Do you know! 
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From this tab you can insert pictures, clipart, date & time etc in header/ Footer. And different options can be 
adjust through this. 

 

4. Procedure of Inserting Header and Footer 

1. To set up a header and footer for your document, click on the Insert tab at the top of Word. Now locate 
the Header & Footer panel: 

 

2. Click on the Header item and you'll see a drop down list appear: 
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3. The items on the list are Headers that are built in to Microsoft Word. There are some nice Headers on 
the list, 

4. To create your own header select the first item on the list, Blank. The top of your page will then look like 
this: 

 

5. Notice that a new tab has appeared - the Design tab. The panels on the tab are: Header & Footer, 
Insert, Navigation, Options, Position, and Close. 

6. The thin, dashed blue line is the bottom of your header, and everything above is the area where you can 
type your header text (or insert images). 

There is already a selected area with the words "Type text" in it. However, this is the first page in document. You 
don't want any header on the first page, as it doesn't look very good. You want the headers to start on page two. 
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So have a look at the Design tab, and locate the Options panel. Left click inside the check box next to Different 
First Page: 

 

7. Now type the text that you ant to write in the Header. You can add shapes and change formatting of text 
in header. 

 

8. At the last, click the close Header Footer button in the design tab. 

 

5. Inserting Page Number and Date in Footer  

1. Double-click anywhere on the header or footer to unlock it. The Design tab will appear.  
2.  From the Design tab, click the Date & Time command.  

 

3. Select a date format in the dialog box that appears. 
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4. Place a check mark in the Update Automatically box if you would like it to always reflect the current 
date. Otherwise, it will not change when the document is opened at a later date.  

5. Click OK. The date and time now appears in the document.  

Page Number: 

Word can automatically label each page with a page number and place it in a header, footer, or side margin. 

1. From the Insert tab, click Page Number. A drop-down menu will appear.  
2. Select the desired page number style and it will appear in your document.  

 

If you're unable to 
select Different 
First Page, it may 
be because an 
object within the 
header or footer is 
selected. Click in an 
empty area within 
the header or footer 
to make sure 
nothing is selected. 

Important 
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Format Page Numbers: 

1. Select the header or footer that contains the page number. 

2. From the Design tab, select the Page Number command. 

3. Click Format Page Numbers.  

 

4. From the dialog box, select the desired Number format.  

 

If you've created a 
page number in the 
side margin, it's still 
considered part of 
the header or footer. 
You won't be able to 
select the page 
number unless the 
header or footer is 
selected. 

Do you know! 
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5. Next to Start at, enter the number you want the page numbers to start with.  
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Learner’s Activity 

1. Create a new Word document. 

2. Create a blank header. 

3. Add your name in the header of a document and draw a line under this. 

4. Right-align the text in the header. 

5. Select a built-in footer with date and page Number. 

6. Don’t show page number on front page. 
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Learning Unit 13: Insert Section Break in a Word 
Document 

Overview 

 
In this learning unit you will learn about the concept and usage or Section Break. After completion of this learning 
unit you will be able to use section break in the document and usage of its attributes. 
 

1. Purpose of Section Break 

Section Breaks: create a barrier between parts of the document for formatting 
purposes.  

Section breaks in Microsoft Word 2010 can be used for following purposes 

 Use page numbering that starts at 1 for each section of your document (for 
example, different chapters in the same document). 

 Display text in two columns for only a portion of your document and then return 
to the default one column afterwards. 

 Display different header and footer information for different parts of your 
document. 

 

 

2. Inserting Section Break in a Word Document  

The procedure to divide the page into section has the following steps: 

1. Position the insertion point in the position where you want to start a new section. 
2. On the page layout menu, click Break. 

The Break dialog box is displayed. 
3. Under Section break types, click the option that describes where you want the next section to begin. 
4. Click OK. 

A section break 
stores the section 
formatting for the 
text above it, and 
also means the end 
of the section 
containing the text 
above the section 
break. 

Section Break 
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3. Difference between Section Break and Page Break  

Page Breaks: help to separate content between pages. After a page break, the following text will start at the 
beginning of the next page. It tells the printing device where to end the current page and begin the next. 

Section Breaks: split your document into sections, enabling you to have different formatting for each section: 

Section properties include the following settings: 

 Page Orientation (Portrait/Landscape) 

 Margins 

 Columns 

 Line Numbering 

 Vertical Alignment 

 Headers & Footers 

 Page Numbering 

 Paper Size 

 Paper Source. 

Different Attributes of Break 

When you click the Break command to insert a section break, Word displays the Break dialog box, which offers 
you a number of options. The Break tab in the page layout has the following options: 

You will have to 
switch to Normal 
view (or enable the 
Show/Hide button 
(¶) in any other 
view) before you can 
visibly see the 
positions of each 
section break. 

Important 
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Page Breaks:  

Only start you on the next page, all formatting will be kept the same from your original page to your new one.  Use 
this when you want to just start typing on a new page but want all the formatting same. 
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Column Break:  

If you’ve formatted your document with columns (such as a newsletter), you know that your text will automatically 
flow from one column to the other. You can also insert your own column breaks if you want which gives you more 
control over the formatting of your document.  

 

Text Wrapping:  

Select the text beside the picture, and select Text Wrapping.  This will let you keep this 
text together with consistent formatting, and will flow the rest of the document around 
this section. 

 

Next Page: 

If you choose this option, word breaks the page before the insertion point but shift the contents to the Next page. 

 

 

Continuous: 

If you choose this option, or if Word automatically applies it, Word inserts a section break before the insertion 
point and then begins the new section on the same page. 

Paper size and 
page orientation 
settings on adjacent 
sections which are 
separated by 
Continuous section 
break remain the 
same. Two or more 
section can be 
different in line 
spacing, margin 
setting and number 
of columns. 

Remember 
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Even Page:  

Choosing this option, Word inserts the section break (the double-dotted line) before the insertion point (in Print 
Layout view), and begins the new section on the next even-numbered page. 

 

 

Odd Page: 

It has all the effects and uses as the Even page option, EXCEPT that the new section begins on the next odd-
numbered page.   
 

4. Using Breaks  

The procedure to use any break command in your document has the following steps: 

1. Open the document. 
2. Place the pointer on the insertion point where the break is required. 
3. Select page layout tab and click the break command down arrow and select the required break. 

4. The break will be applied on the document. 

 

  

This type of section 
break is most ideal 
for use for chapters 
(or other major 
sections such as 
Appendix, Index, 
Glossary, etc) that 
begin on even-
numbered pages. 

Note 
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Learning Unit 14: Set Style in a Word Document 

Overview 

 
In this learning unit you will learn how to apply appropriate styles in your document and how you can edit the 
styles given in the word Document. After completion of this learning unit the student will be able to set styles on 
the document according to the requirement. 
 

1. Setting Styles on the Document  

The procedure to set the styles on the document has the following steps: 

1. Select the text you want to format 

 

2. In the Style group on the Home tab, hover over each style to see a live preview in the document. Click 
the More drop-down arrow to see additional styles.  

 

3. Select the style you want. The selected text appears formatted in the style. 
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Applying Set Styles: 

Style sets include a combination of title, heading, and paragraph styles. Style sets allow you to format all of the 
elements of your document at once, rather than formatting your title and headings separately. 

The procedure to apply set styles has the following steps: 

1. Select the text. 

2. Click the Change Styles command on the Ribbon. A drop-down menu will appear. 

3. From the drop-down menu, select Style Set.  

 

4. Select the Style Set you want and the change will be reflected in the entire document. 
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2. Purpose of Setting Styles and its Utlilties 

Styles and themes are powerful tools in Word that can help you easily create professional-looking documents. A 
style is a predefined combination of font style, color, and size of text that can be applied to selected text. A 
theme is a set of formatting choices that can be applied to an entire document and includes theme colors, fonts, 
and effects. 

Different options are available to set and modify styles in the style group. 

Modify Style: 

 Any given style can be modified by right clicking on the style and select modify. 
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 Make the desired changes to the formatting. If you want, you can also change the name of the style.  

 

 Click OK to apply the modifications to the style. 

Create New Style: 

To create new style in the document follow these steps: 

1. Click the arrow in the bottom-right corner of the Styles group. This opens the Styles task pane.  
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2. Select the New Style button at the bottom. A dialog box will appear. 

3. Enter a name for the style, and set the text formatting the way you want.  
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4. Click OK, and the new style will appear in the task pane. 

 

Applying different styles on Document: 

Apply different styles on the document to see the difference between them. 

1. In the below diagram Fancy style from set style has been applied.  

 
 

After applying a 
specific style you 
can change its font 
and color from 
change style tab. 

Note 
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Learner’s Activity 
 

1. Open an existing Word document 
 

2. Apply several different styles to different parts of your document 
 

3. Apply a style set to your entire document 
 

4. Modify an existing style 
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Learning Unit 15: Insert Table of Contents in a Word 
Document 

Overview 

In this learning unit you will learn how to insert table of contents in the file. After completion of this learning unit 
you will be able to insert table of contents from different available options. 
 

1. Inserting Table of Contents in File 

The procedure of inserting table of contents has the following steps: 

1. Open the existing document and click on the References tab at the top of the screen. 

 

2. Place your cursor at the beginning of the document. This is the place where the table of contents will be 
inserted. Click on the Table of Contents icon and select Automatic Table 1 

 

3. Notice that a table of contents has been inserted at the head of your document. 
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2. Insert Table of Contents using Headings 

The procedure to insert table of contents using heading toolbar has the following steps: 

1. Open existing Word document. 
2. Select the heading and apply heading style from the styles group in Home tab. 

 

3. Same like that apply heading styles on all the heading that you want to add in table of contents. 
4. Click where you want to add table of contents. 
5. Click on the Table of Contents icon and select Automatic Table 1. 
6. Notice that a table of content has been added in the document. 
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3. Purpose of Using Table of Content 

A table of contents makes it easy for you, your collaborators, and viewers to quickly 
navigate to a section of your document. Each item in your table of contents links to the 
titled sections of your document that use the heading styles.  

Creating a table of contents in a Microsoft Word document is a two-step process. First, 
identify the text that you want to appear in the Table of Contents. Second, tell Word to 
insert the Table of Contents. Having created your Table of Contents, you can then 
customize it in several ways, to suit your needs. 

You cannot generate any automatic tables without first using styles effectively 
throughout your document.  If you want an automatic table of contents you need to 
label all of your chapter titles and front matter headings (e.g. “Dedication” and 

“Acknowledgements”) in the style Heading 1.  All major headings within your chapters should be labeled Heading 
2.  All subheadings should be labeled Heading 3, and so on. 

Microsoft Word can scan your document and find everything in the Heading 1 style and put that on the first level 
of your table of contents, put any Heading 2’s on the second level of your table of contents, and so on. 

 

 

 

 

 

 

If you don't like the 
way the heading 
styles look (eg, you 
want a different font 
or font size or color), 
don't format the text 
directly. Instead, 
modify the heading 
style. 

Remember 
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4. Features of Table of Content  

Update Table of Content: 

If you added or removed headings or other table of contents entries in your document, you can quickly update 
the table of contents. 

1. On the References tab, in the Table of Contents group, click Update Table. 

 

2. Click Update page numbers only or Update entire table. 

Delete a table of contents: 

1. On the References tab, in the Table of Contents group, click Table of Contents. 

2. Click Remove Table of Contents. 
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Summary of Module 

  Touch is typing without using the sense of sight to find the keys. Used to increase the typing speed. 

  Formatting of text Include the size, style, alignment of the text. 

  The MS Word page Set-up includes elements such as the page size, margins (Left, right, up, bottom), 
number of columns, orientations. 

  Restricting and protecting a document ensures that you have the complete authority over its 
progress. Data can restrict for formatting and editing in MS Word. 

  Word document can be set to mark and track changes you make to a document so that you or another 
author can later review the changes. 

  Through Insert tab pictures, clip Art, shapes, smart Art etc. can be add in the document. 

  Word document can be save using Save, Save As options in the File tab and using short Key 
CTRL+S. 

  Tables can add in the document to locate the images in their exact locations. Word tables are the 
perfect easy way to display complex visual information in a page easily. 

  Adding hyperlinks to your document can help readers quickly access contact information, other parts 
of the document and any additional information online that you want to share. 

  Mail Merge is a powerful tool for writing and sending a personalized letter or e-mail to many different 
people at the same time. 

  Header is the text included in the top portion of the page separated from the main body of the text. 

Footer is the bottom portion of the page which is separated from the main body of the text. 

  Section Breaks: create a barrier between parts of the document for formatting purposes. 

  Style sets include a combination of title, heading, and paragraph styles. Style sets allow you to format 
all of the elements of your document at once, rather than formatting your title and headings 
separately. 
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Frequently Asked Questions (FAQS) 

FAQ 1:  What do you mean by touch typing? 

Answer 
Touch type is the ability of typing without looking at the keyboard. While using touch-typing, 
all fingers are used instead of just a few fingers and it increases speed dramatically. 

FAQ 2:  Write names of Page Orientation? 

Answer Portrait and Landscape. 

FAQ 3:  What is the Shortcut Key to Save a file? 

Answer CTRL+S, is used to save a file. 

FAQ 4:  Which color indicates the spelling mistake in Word document? 

Answer Red color wavy line below the text indicates the spelling mistake. 

FAQ 5:  Can we embed a file of other format in MS Word Document? 

Answer 
Yes, files with different file formats can be embedded in the MS Word document by using 
Object button in the Insert Tab. 

FAQ 6:  Why we use comments in the MS Word file? 

Answer Comments provide useful way to leave notes about parts of the document.  

FAQ 7:  For which purpose Bookmark is used? 

Answer 
Bookmark is used to locate a specific point in the document. Using bookmark you can directly 
jump to a point within the document. 

FAQ 8:  What is Smart Art? 

Answer Smart Art allows you to visually communicate information rather than simply using text. 

FAQ 9:  From which tab you can apply page number on the document? 

Answer Through Insert tab>Header & Footer group, page number option is available. 

FAQ 10:  Can you automatically add table of Contents in the Word File? 

Answer Yes, you can add table of contents in the document from reference tab. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  Landscape is______? 

a.  A font style b.  Page Layout 

c.  Paper Size d.  Page Orientation 

2.  To use Mail Merge, you will need a ________. 

a.  Heading Style b.  Stamp Field 

c.  Recipient List d.  Navigation Pane 

3.  To add text to the top of every page, you should use a ______. 

a.  Right Margin b.  Footer 

c.  Header d.  Left Margin 

4.  In Word 2010, WordArt is always inside a ___________. 

a Text Box b List box 

c Column d Table 

5.  Shortcut Key to copy the selected text is __________. 

a CTRL+S b 
CTRL+C 
 

c CTRL+V d CTRL+Z 

6.  The Columns command is located on the ______ tab. 

a Insert b Page Layout 

c Home d Review 

7.  You can change the font size with the ___________. 

a Font Size Box b Shrink Font Command 

c Grow Font Command d All of the Above 
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8.  To save an edited document while keeping the original version, use ___________. 

a Save  b Save AS 

c ALT+F4 d Close 

9.  
To use more than one type of Margin and number of columns within a document, you 
should use_________. 

a Section Break b Page Break 

c Even Break d Odd Break 

10.  The ________ wavy line indicates a contextual spelling error. 

a Blue b Green 

c Red d Yellow 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 c 

3 c 

4 a 

5 b 

6 b 

7 d 

8 b 

9 a 

10 a 
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Module 3: Preparing Spreadsheet 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Create workbook 

  Insert Sheet 

  Apply Basic formulas/ Functions 

  Create Chart / Graphs 

  Filter Data 

  Format Cells 

  Edit Worksheet 

  Insert Page break 

  Split Cells 

  Merge Cells 
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Learning Unit 1: Create Workbook  
 

Most spreadsheet editing is now performed using computer software, such as Microsoft Excel or Apple Numbers. 
There are certain types of spreadsheets commonly used to provide versatility in work. 

1. Two-Dimensional Spreadsheets 

Two-dimension spreadsheets consist of "cells"-a box holding one piece of data-arranged in rows and columns like 
a table. 

2. Three-Dimensional Spreadsheets 

Modern spreadsheet applications allows for more than one two-dimensional sheets effectively stacking related 
spreadsheets on top of each other and introducing a third dimension. 

3. Arithmetic Spreadsheets 

Spreadsheets often utilize arithmetic functions, such as automatically adding up all the values of one particular 
column. These functions are necessary for budget and invoice spreadsheets. 

4. Logical Spreadsheets 

Some spreadsheets utilize logic functions, rather than arithmetic functions, to allow for deductive of inductive 
reasoning. 

Overview 

This learning unit covers the procedure for creating workbook and spreadsheet, the 
basic concept of Spreadsheets, types of spreadsheets in Excel and procedure for 
creating workbook in Excel. After completion of this learning unit You will be able to 
explain the types and uses of worksheets and the procedure of creating a worksheet. 

 

1. Using Electronic Spreadsheet Program  

A spreadsheet is a very interactive computer application for organization, analysis, manipulation and storage of 
data in tables.  It is an electronic document in which data is arranged in the rows and columns of a grid 
and can be manipulated and used in calculations. What makes a spreadsheet software program unique is its 
ability to calculate values using mathematical formulas in cells. 

2. Types and Uses of Excel Sheets  

Each Workbook is a 
collection of 
Worksheets, Each 
worksheet is a 
collection of rows 
and columns. 

Remember 
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5. Object-Oriented Spreadsheets 

Instead of using two-dimensional cells, some spreadsheets are organized by objects, which are variables with a 
number of attributes attached. This allows the data to be viewed, analyzed and mapped in a number of different 
ways. 

Uses of Spreadsheets 

Here are some of the most commonly uses of spreadsheets. 

1. Spreadsheets are used for simple lists and complex numerical calculations.  

2. Spreadsheets change the information into detailed graphs to show a visual representation of the data. 

3. Spreadsheets provide many sorting options to filter information.  

4. Spreadsheet software is very versatile and can be used for both very simple and very complex tasks. Adding 
or deleting items from a list, so the lists can be used many times. 

5. The management of more complex data, such as earnings, expenses, budgets and other accounting, is 
also made easier. 

6. Spreadsheet Software includes features that can calculate complicated math, including everything from 
basic addition and subtraction to percentages, taxes and multi-step problems. This makes spreadsheets 
essential for businesses, self-employed people and anyone who needs to keep an account of expenses and 
income. 

7. Spreadsheet software also includes graphs and charts from the data provided within the table. This is good 
for presentations, such as business meetings and research projects, and offers a fresh view of the data. 
These graphs and charts are customizable and can be specific or general depending on the settings and 
options chosen. 

8. The information generated in a spreadsheet can easily be incorporated into electronic presentations, web 
pages, or printed off in report form. 

3. Creating a Workbook 
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Creating a new workbook 

To create a new workbook, there are three different ways  

1. It can open through a blank workbook.  
2. It can also base a new workbook on an existing workbook. 
3. Or it can create by using any other template. 

1. Opening a new, Blank Workbook 

 Open MS Excel Software by double clicking on its icon. 

 Click the File tab. 

 Click New. 

 Under Available Templates, double-click Blank Workbook. 

 

Creating New workbook 

        It can also add and remove worksheets as needed. 

2.  Creating a New Workbook on an Existing Workbook 

1. Click the File tab. 
2. Click New. 
3. Under Templates, click New from existing. 
4. In the New from Existing Workbook dialog box, browse to the drive, folder, or Internet location that 

contains the workbook that wanted to open. 
5. Click the workbook, and then click Create New.  

Keyboard 
shortcut, to quickly 
create a new, blank 
workbook, press 
CTRL+N. 

Do you know! 
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Creating Workbook with existing one 

3.  Creating a new Workbook on a Template 

1. Click the File tab. 
2. Click New. 

Do one of the following: 

1. To use one of the Sample Templates 

 Provided with Excel, under Available Templates, click Sample Templates and then double-click 
the template that is needed. 

 To use a recently used template, 

 Click Recent Templates, and then double-click the template that wanted to open. 

2. To use your own Template 

 On the My Templates, and then on the Personal Templates tab in the New dialog box, double-
click the template that you want. 

Every workbook in 
Ms Excel contains 3 
worksheets by 
default. 

Remember 
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Creating with own Template 
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Learning Unit 2: Insert Sheet 
 

The Excel Window 

Many items on the Excel screen are standards in most of the Microsoft software programs like Word, 
PowerPoint, and previous versions of Excel, while some elements are specific to Excel. 

 

Main Parts of Excel Sheet 

1. Workbook 

It is also called a spreadsheet, the workbook is a unique file created by Excel. 

Overview 

A worksheet or sheet is a single page in a workbook created with an electronic 
spreadsheet program such as Excel. A worksheet is used to store, manipulate, and 
display data. Each worksheet is composed of a very large number of cells which 
are the basic place for data in a file or workbook. This learning unit covers the 
procedure for describing different parts of a worksheet area and how to insert a new 
worksheet in Excel. After completion of this Learning Unit you will be able to 
describe different parts of spreadsheet work area, and to demonstrate the 

procedure of inserting new worksheet in Excel. 

1. Main parts of Spreadsheet Work Area 

Every workbook in 
Ms Excel contains 3 
worksheets by 
default. 

Remember 
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2. Title Bar 

 

Title Bar 

The title bar displays both the application name and the spreadsheet file name. 

3. Menu Bar 

 

 Menu Bar, Tabs 

The menu bar displays all of the menus available for use in Excel .The contents of any menu can be displayed 
by left-clicking the menu name. 

4. Column Headings 

 

Column Headings 

Each Excel spreadsheet contains 256 columns. Each column is named by a letter or combination of letters. 

5. Row Headings 

 

Row Headings 
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By default number of rows in office 2010, It Consists 65,536 rows in   Each spreadsheet. 

6. Name Box 

 

Name Box 

It will show the address of the current selection or active cell. 

7. Formula Bar 

 

Formula Bar 

The formula bar displays information entered in the current or active cell. The contents of a cell can also be 
edited in the formula bar. 

8. Cell 

 

Cell in Excel sheet 

Press Shift+F11 
Keys and you will 
see a new blank 
sheet similar to 
above sheet is 
opened. 

Do you know! 
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A cell is an intersection of a row and column. Each cell has a unique cell address. Like, In the picture above, 
the cell address of the selected cell is B3. The heavy border around the selected cell is called the cell pointer. 

9. Navigation Buttons and Sheet Tabs 

 

Navigation Buttons and Work Sheets 

Navigation buttons allows moving to another worksheet in an Excel workbook. They are used to display the 
first, previous, next, and last worksheets in the workbook. 

10. Workbooks and Worksheets 

A workbook automatically shows in the workspace when Microsoft Excel opened. Each workbook contains 
three worksheets. A worksheet is a grid of cells consisting of 65,536 rows and 256 columns. 

Creating New Worksheet 

When Microsoft Excel starts, three new blank sheets always open. But if the user wanted to start another new 
worksheet while working on another worksheet, or closed already opened worksheet and want to start a new 
worksheet. Here are the steps to create a new worksheet: 

1. Creating New Worksheet in After Previous: 

1. Click on the button mentioned below in figure. The new sheet will be inserted. In this method a new 
sheet will be inserted after the previous sheet. 

2. Basics of Creating a Spreadsheet  
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Inserting New Worksheet in a Sequence 

2. Creating new Spreadsheet on a Specific Place: 

  1. Right Click the Sheet Name and select Insert option. 

 

Creating Worksheet at a Specific Place 
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2. Now the Insert dialog will appeared with select Worksheet option as selected from the general tab. 
Click Ok button 

 

Select New Worksheet 

The new worksheet will be created. 

 

Newly Created Sheet 
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Entering Data in Cell 

It is very easy to enter data in a worksheet. 

 Click on the cell where the data will be inserted. 

 Type the data in cell or it can also be typed in formula bar. 

 The data will be inserted in the desired cell. 
  

3. Entering Data in MS Excel Worksheet 
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Learning Unit 3: Apply Basic Formulas and Functions 
 

Overview 

There are a lot of formulas and functions used in Excel for calculations it is necessary 
to understand the basic difference of these to concepts. A formula is a statement written 
and calculated by a user and A function is a built-in code designed to calculate specific 
values. MS Excel is used for creating both formulas and functions. This learning unit 
covers basic concept of creating Formulas and functions and how to use these 
Formulas and Functions in Excel. After completion of this learning unit you will be able 
to demonstrate the procedure to apply different types of formulas and functions in an 
Excel sheet.  

1. Basics of Creating Formulas 

In Excel, each cell can contain one formula. When formula is entered in a cell, Excel calculates the result of that 
formula and displays the result of that calculation .When entering a formula, make sure Excel knows that what is 
want to do. Start a formula by typing the = (equals) sign, then the rest of the formula. If the equal sign doesn't 
type the first, then Excel will assume that the user is typing either a number or a text. A formula can start either 
with a plus (+) or minus (-) symbol. 

Formula 

A formula is a statement written and calculated by a user. Formulas can be as simple or as complex as the user 
wants. A formula may contain values, references to cells, defined names, and functions. 

All formulas must start with the equal sign. Like  “=B4*C4” 

Function 

A function is a code designed to calculate specific values and is used inside formulas.  

Functions are typed along with parenthesizes at both sides, where in the arguments (if any) are listed in between. 
There are different types of functions are available in excel like Sum, IF, Average, Max, Min. 

 “ =SUM( F4:G4) “ 

Creating Formulas 

There are different methods used for creating or inserting formulas in Excel. It can insert through predefined 
formulas, using cell references or it can create through using point and click method. 

It is important to 
understand how 
to create simple 
formulas and use 
of cell references, 
to maximize the 
capabilities of Excel. 

Remember 
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  Excel uses different standard operators for equations, such as  

 a plus sign for addition ( + ) 

 minus sign for subtraction ( - ) 

 asterisk for multiplication ( * ) 

 forward slash for division ( / ) 

 caret for exponents ( ^ ) 

 

Using Basic Formulas 

To Create a Simple Formula in Excel: 

1. Select the cell where the answer will appear. 

2. Type the equal sign (=). 

3. Type in the formula that is wanted to be calculates. 
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Creating Simple Formula 

4. Press Enter. The formula will be calculated, and the value will be displayed in the cell.  

 

Creating Simple Formula 

Sometimes ###### sign appears when a formula is calculated. This means the column is not wide 
enough to display the cell content. Just Increase the column width to show the cell content. 

 Creating formulas with cell references 

The cell where the formula being applied contains a cell address, it is called a cell reference. Creating a 
formula with cell references is useful because it can update data in worksheet without having to rewrite the 
values in the formula. 

If the result of a 
formula is too large 
to be displayed in a 
cell, it may appear 
as hash or number 
signs (#######) 
instead of a value. 

Do you know! 
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To create a formula using cell references: 

1. Select the cell where the answer will appear. 
2. Type the equals sign (=). 
3. Type the cell address that contains the first number in the equation. 
4. Type the desired operator in formula. For example, Addition + sign. 
5. Type the cell address that contains the second number. 

 

Inserting Formula Using Cell Reference 

6. Press Enter. The formula will be calculated, and the value will be displayed in the cell. 

 

Using Cell Reference 
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 Creating a formula using  point-and-clicking: 

In this method the formula will be added through point and click. In this method after inserting equal sign cell 
reference will be included in formula by clicking on the desired cell. 

1. Select the cell where the answer will appear. 
2. Type the equals sign (=). 
3. Click the first cell to be included in the formula which is wanted to be included. 
4. Type the operator according to formula. For example, type the multiplication sign (*). 
5. Click the next cell in the formula. 

 

Using Point and Click 

6. Press Enter. The formula will be calculated, and the value will be displayed in the cell. 

 

Using Point and Click method 

 Editing a Formula: 

1. Click on the cell that is wanted to be edit. 
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2. Insert the cursor in the formula bar, and edit the formula as desired. Or it can also edit by double-
clicking the cell to view and edit the formula directly from the cell. 

3.  Press Enter. 
4. The new value will be displayed in the cell. 

 

Using Formula Bar 

 

2. Using Functions in Excel  

Basic functions 

A function is a predefined built-in formula that performs calculations in a particular order using specific 
values. One of the major benefits of functions is that they can save time because we do not have to write 
the formula. Excel has hundreds of functions. 

A Function has different parts. To use these functions correctly, It is necessary to understand the 
different parts of a function and how to create arguments in functions to calculate values and cell 
references. 

The parts of a function: 

 Each function in Excel has a specific order called syntax It is necessary to understand the order of the 
function to work correctly. The basic syntax to create a formula with a function is : 

 insert an equals sign (=) 

 function name (SUM, for example, is the function name for addition),  

  Argument. Contains the information about formula to calculate, such as a range of cell 
references. 
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A Function's Parts 

Working with arguments: 

Arguments must be enclosed in parentheses. Individual values or cell references inside the parentheses 
are separated by commas. 

 Colons create a reference to a range of cells.  

For Example  

 AVERAGE ( H4:K4) 

 

Using Simple Functions: 

Creating a basic function in Excel: 

1. Select the cell where the answer will appear. 
2. Type the equals sign (=), then enter the function name (SUM, for example). 
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Creating Basic Function 

3. Enter the argument inside the parentheses. 

 

Using SUM Function 

4. Press Enter, and the result will appear. 

 

Using AutoSum to Select Common Functions: 

The AutoSum command allows to automatically returning the results for a range of cells for common 
functions like SUM and AVERAGE. 

Using AVERAGE Function: 

1. Select the cell where the answer will appear. 
2. Click the Home tab. 
3. In the Editing group,  
4. Click the AutoSum drop-down arrow and select the function you want (Average, for example). 
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Using Auto Sum Function 

5. A formula will appear in the selected cell. If logically placed, AutoSum will select your cells. 

 

 

 

Using AVERAGE Function 

6. Press Enter, and the result will appear. 

 

Using Complex Functions: 

Using IF Function: 

 Select the cell where the function will be applied. 

 Click on  button or go on Formulas tab, then Insert Function. 

 Select the IF functions from the list. 
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Using IF Function 

 Click OK button. 

After Clicking OK a window will appear. 

 

Using IF Function 

 Give the logical test, then True or False conditions in the given boxes. 

 Click OK the function will be applied. 
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Learning Unit 4: Create Chart / Graphs 
 

 

Overview 

This learning unit covers the procedure for creating different types of charts. After completion of this learning unit 
You will be able to describe different types of Charts/ Graphs and to describe the procedure of creating and 
modifying these charts and their elements and also using of sparklines in Excel. 

1. Charts/Graphs and their Use in Excel 

A chart is a tool that is used in Excel to present data graphically. A chart, also called 
a graph, is a graphical representation of data, in which the data is represented by 
symbols, such as bars in a bar chart, lines in a line chart, or slices in a pie chart.  A 
chart can represent numeric data, functions or some kinds of qualitative structure and 
provides different information. There are many types of chart / Graphs used in Excel.  

A chart is a visual representation of data. By using elements such as columns, or 
lines, a chart displays series of numeric data in a graphical format. 

Excel Chart Types 

MS Excel has different types of charts as shown in the picture below. 

 

Chart Types 

Identifying the Elements of a chart 

A chart consists of different parts. These are: 

Charts are (called 
graphs in math 
class) visual 
representations of 
worksheet data. 

Do you know! 
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Elements of a Chart 

1. Chart Title 

A chart Title describes what the chart is illustrating. 

2. Vertical Axis 

The vertical axis is also known as the y axis. It is the vertical part of the chart. IN the above picture, 
a column chart, the vertical axis measures the height or value of the columns, so it is also called the value axis. 
However, in a bar chart, the horizontal axis would be the value axis. 

3. Horizontal Axis 

The horizontal axis is also known as the x axis. It is the horizontal part of the chart. In the above picture, the 
horizontal axis identifies the categories in the chart, so it is also called the category axis. However, in 
a bar chart, the vertical axis would be the category axis. 

4. Data Series 

The data series consists of related data points in a chart. If there are multiple data series in the chart, each will 
have a different color or style. Pie charts can only have one data series. In the above picture, the green columns 
represent the Romance data series. 

5. Legend 

The legend identifies which data series represents through which color. For many charts it is necessary, but 
for some charts it may not be necessary and can be deleted. In the above picture, the legend allows viewers to 
identify the different book genres in the chart. 
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2. Creating a Chart in Excel 

Creating a Chart 

1. Select the cells that are wanted to chart, including the column titles and row labels. These 
cells will be the source data for the chart. 

 

Creating Chart 

2. Click the Insert tab. 

3. In the Charts group, select the desired chart. 

 

Selecting Chart  

4. Select the desired chart type from the drop-down menu (Clustered Column, for example). 
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Selecting a Chart type 

5. The chart will appear in the worksheet. 

 

Inserting Chart 

Using Different Charts in Excel 

The steps for creating a basic column chart in Excel are: 

 Select the data which wanted to be in the chart. Insert row and column headings but not the title for the 
data table. 

 Click on the Insert tab of the Ribbon. 

 In the Charts box of the ribbon, click on the Insert Column Chart icon to open the drop down list of 
available chart types. 

 Hover mouse pointer over a chart type to read a description of the chart. 

 Click on the desired chart. 

A plain, unformatted chart that displays only the columns, representing the selected series, a default chart title, 
a legend, and axes values, will be added to the current worksheet. 
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Column Chart 

Working with Sparklines in Excel 

Sparkline is a New feature in Microsoft Excel 2010. A sparkline is a small type of chart in a worksheet 
cell that provides a visual representation of data. Sparklines are used to show trends in a series of 
values, such as seasonal increases or decreases, economic cycles, or to highlight maximum and 
minimum values. It is necessary to position a sparkline near to its data for best impact. 

  

Creating Sparklines 

Generally, there is one sparkline for each row, but it can create as many as needed in any location. Just 
like with formulas, it is usually very easy to create a single sparkline and then use the fill handle to 
automatically create sparklines for the remaining rows. 

1. Select the cells where sparklines will be applied.  
2. Click the Insert tab. 
3. In the Sparklines group, select Line. A dialog box will appear. 

 

Inserting Sparklines 
 

4. Make sure the insertion point is next to Location Range. 
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5. Click the on the desired cell.  

 

Insertion Point of Sparklines 

6. Click OK. The sparkline will appear. 

 

Inserting Sparkline 

Changing the Sparkline Type 

1. Select the Sparkline that is wanted to change. 

2. Locate the Type group in the Design tab. 

3. Select the desired type. 

 

 



Module 3: Preparing Spreadsheet  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 257 

Changing Sparkline Style 

4. The Sparkline will update to reflect the new type. 

 

Column Type Sparkline 

 

3. Modifying Chart Elements 

When a Chart is inserted the Chart Tools, Format tab in Excel 2010 contains command buttons that make it 
easy to format any selected chart element. Excel gives a choice of methods for selecting individual chart 
elements. 

Selecting Individual Chart Elements: 

 Click the element directly in the chart to select it. 

 Use the ScreenTip that appears at the mouse pointer to identify the chart object. 

 Click the name of the chart element. 

 On the Chart Elements drop-down list in the Current Selection group on the Format tab. 

 After selection of an element, it can cycle through and select the other chart elements by pressing any 
of the arrow keys. 

 

Modifying Elements of a Chart 
 

When an element is selected in the chart itself a selection handle appear around it and its name appears in the 
Chart Elements box on the Format tab. 



Module 3: Preparing Spreadsheet  

258 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

1. Changing in any Chart Element Using Chart Tool Format Tab 

After  select a chart element, can be made any of the following changes to it: 

 Format the element by selecting the appropriate command button. 

 In the Shape Styles group or by clicking the Format Selection button to open the Format dialog box 
and use its options to make the desired changes. 

2. Moving Chart Element 

It is easy to move any element of a chart by select and drag the element. 

 Move the element within the chart by positioning the arrow head pointer over the element and then 
dragging it around. With some elements, such as the legend, selection handles are used to resize or re 
orient the object. 

3. Removing any Chart Element 

It is very easy to Remove the element from the chart by pressing the Delete key. 

 Select any element in the chart which is wanted to be removed. 

 Press the delete key from the key board. 

4. Changing the Display of Chart Axes 

The chart axes can easily be modified. There are two axes on a chart. 

 Vertical Axes 

 Horizontal Axes. 

Modifying Horizontal Axes 

1. Select the horizontal Axes. 
2. Under the chart tools group, click on Layout tab. 
3. Click on Axes drop down button. 
4. Click on second option Primary horizontal Axes. 
5. Select and apply the desired option from the sub menu (For example, show axes left to right). 
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Modifying Horizontal Axes 

6. Axes will be changed. 

Modifying Vertical Axes 

1. Select the Vertical Axes. 
2. Under the chart tools group, click on Layout tab. 
3. Click on Axes drop down button. 
4. Click on second option Primary vertical Axes. 
5. Select and apply the desired option from the sub menu (For example, show axis in Million).  

 

Modifying Vertical Axes 

Only one title can 
add to a chart. If you 
want to use a 
second title or a sub 
title, you can draw a 
text box on the 
chart, and move it to 
the location that you 
want. 

Do you know! 
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6. Axes will be changed. 

5. Adding Data Labels to a Chart 

The data labels are added to an Excel chart to help identify the values shown in each data point of the data 
series. Excel provides several options for data labels formatting. 

Use the following steps to add data labels to series in a chart: 

1. Click anywhere on the chart that is wanted to modify. 

2. On the Chart Tools Layout tab, click the Data Labels button in the Labels group. 

A menu of data label placement options appears: 

 None: This is the default choice; it means you don't want to display data labels. 
 Center: This is used to position the data labels in the middle of each data point. 
 Inside End: This option is used to position the data labels inside the end of each data point. 
 Inside Base: This is used to position the data labels inside the base of each data point. 
 Outside End: This is used to position the data labels outside the end of each data point. 

6. Applying Data Labels  

 Select the place where data label wanted to be placed. 

 On the Chart Tools Layout tab, click Data Labels and then More Data Label 
Options. 

 The Format Data Labels dialog box will appear. It can use the options on the 
Label Options, Number, Fill, Border Color, Border Styles, Shadow, Glow and Soft Edges, 3-D 
Format, and Alignment tabs to customize the appearance and position of the data labels. 

 A label can be changed to show the Series Name, the Category Name, or the Value. 

 Customize and change any additional options and then click Close.  

To quickly remove a 
legend or a legend 
entry from a chart, 
select it, and then 
press DELETE. 

Do you know! 
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Data Labels  

7. Adding or Removing Titles in a Chart 

For making a chart easy to understand, titles can be added to it, such as a chart title and axis titles, to any type 
of chart. Axis titles are generally available for all axes that can be displayed in a chart. Some chart types (such 
as radar charts) have axes, but they do not display axis titles. Chart types that do not have axes (such as pie 
and doughnut charts) cannot display axis titles either. 

 

Adding Chart Title 

A chart and axis titles can also be linked to corresponding text in worksheet cells by creating a reference to 
those cells. Linked titles are automatically updated in the chart when the text is changed in corresponding 
worksheet. A chart titles can be removed if it does not need. 

 

When you click one 
of the display 
options, the legend 
moves, and the plot 
area automatically 
adjusts, to 
accommodate it. If 
you move and size 
the legend by using 
the mouse, the plot 
area does not 
automatically adjust. 

Remember 
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8. Adding a Chart Title Manually 

1. Click at the chart to which the Title wanted to add. 

2.  Chart Tools, the Design, Layout, and Format tabs will appear. 

3. On the Layout tab, in the Labels group, click on Chart Title. 

4. Click on Centered Overlay Title or Above Chart. 

5. In the Chart Title text box, type the text that is wanted to be added. 

9. Adding a Legend to a Chart 

Show or hide a legend 

1. Click the chart in which the legend is wanted to show or hide. 
2. Click on Chart Tools, Design, Layout, and then Format tabs. 
3. On the Layout tab, in the Labels group, click Legend. 

 

4. Do one of the following: 
5. To hide the legend, click None. 
6. To display a legend, click the display option that is want. 

Modifying Legend Entries on the Worksheet 

1. Click the cell that contains the name of the data series that appears as an entry in the chart legend. 
2. Type the new name, and then press ENTER. 
3. The new name will automatically appear in the legend on the chart. 
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Learning Unit 5: Filter Data  
 

Data can be filtered from different columns in Excel. For this purpose there is an Advance filter option is 
provided under the DATA tab. For creating filter from using different columns do the following: 

1. Create the  criteria field in an area, like in the example given below 

:  

Advance Filtering   

Overview 

Filtering is a technique used in Excel to pick up a specific data that is required.  Filtering 
data in a spreadsheet means to set conditions so that only certain data is displayed. It 
is done to make it easier to focus on specific information in a large database or table of 
data. This learning unit covers that what is filter and what are its uses in Excel also it 
will cover the procedures of applying filter using different methods. After completion of 
this learning unit you will be able to apply filter using more than one column, using Auto 
filter applying and reapplying a filter. 
 

1. Filtering Data 

 
Filters are used to narrow down the data in a worksheet and hide parts of it from view. 
It may sound a little like grouping, filtering is different because it allows us to qualify 
and display only the data that is of interest. For example, you could filter a list of 
Students to view only those who get the marks in between 300 and 340 out of 500. You 
could also filter a list of Employees who got the salary above 30,000.Filters can be 
applied in different ways to improve the performance of a worksheet. It can filter text, 
dates, and numbers. It can use even more than one filter to further narrow the results. 
 

2. Filtering Data by more than One Column 

To see more items 
in the list, drag the 
handle in the 
bottom-right corner 
of the filter gallery to 
enlarge it. 

Remember 

A Filter button 
means that a filter is 
applied. 

Do you know! 
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2. Select the data range that want to filter, and click Data tab then Advanced. 

 

3. In the Advanced Filter dialog box, click button beside Criteria range to select the criteria. 

 

Giving Criteria Range  

4. Then click OK, and it displays the filtered results. 

 

Advance Filter Result  

Using AutoFilter, you can create three types of filters: by a list values, by a format, or by criteria. Each of these 
filter types is mutually exclusive for each range of cells or column table. For example, you can filter by cell color or 
by a list of numbers, but not by both; you can filter by icon or by a custom filter, but not by both. 

 Using Auto Filter: 

1. Click inside a table, and then choose Filter in the Sort & Filter group of the Data tab 

3. Using Auto Filter and three types of Filters 
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Filtering Data  

1. Click OK. 

2. In the table header, the filtering arrow changes to this icon  that indicates a filter is applied.  

Selecting from a list of values     

3. Click the arrow  in the table header of the column that is wanted to filter. 
4. In the list of text or numbers, uncheck the (Select All) box at the top of the list. 
5. Check the boxes of the items that is wanted to show in the table. 

 

 

            Select List of Values  

Filtering by Criteria: 

1. Click the arrow  in the table header of the column that is wanted to filter. 
2. Click Number Filters, if the column has numbers. 
3. Pick the desired filtering option, and then enter filtering conditions. 
4. For example, to show numbers that is above a certain amount, pick Greater Than Or Equal To, and then 

enter the number in the box. 
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Customized Auto Filter 

(To filter by two conditions, enter filtering conditions in both sets of boxes, and pick And for both conditions to be 
true, and Or for either of the conditions to be true.) 

Filtering by Format 

Filters can also be applied on colors if there is used of Conditional formatting. 

1. Click the arrow   of the column that has color formatting or conditional formatting applied. 
2. Click Filter by Color and then pick the cell color, font color, or icon wanted to filter by. 

 

Applying Filter by Color 

Once data have filtered or sorted in a range of cells or table column, it can either reapply a filter or sort to get up-
to-date results, or clear a filter to redisplay the entire data. For example if the date and time change the data in 
filter data will also be changed. 

Reapplying a filter 

 Determine if a filter is applied, note the icon in the column heading: 

4. Reapplying a Filter  
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1. A drop-down arrow Filter drop-down arrow   means that filtering is enabled but not applied. 

2. A Filter    icon means that a filter is applied.  

 

          Reapplying a Filter  

When a filter is reapply, different results appear for the following reasons: 
 
Data has been added, modified, or deleted to the range of cells or table column. 

Date and Time Filter: 

The filter is a dynamic date and time filter, such as Today, This Week, or Year to Date. 

 

Changing in Date or Time Filter  

Filter and sort 
criteria are saved 
with the workbook 
so that you can 
reapply both the 
filter and sort each 
time that you open 
the workbook. 

Remember 
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Changing in Date or Time Filter 
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Learning Unit 6: Format Cell 
 

Overview 

Formatting a cell means changing the style size alignment of a cell. Cell formats allows 
changing the way cell data appears in the spreadsheet. It is important to keep in mind 
that it only alters the way the data is presented, and does not change the value of the 
data. This unit covers the procedure of formatting a cell, adding or deleting a column or 
a row. After completion of this Unit, you will learn how to change the color and style of 
text and cells, align text, and apply special formatting to numbers and dates.  
 

1. Adding or Removing Columns and Rows 

Sometimes it is necessary to remove or add some of the columns or rows before or after the specific location. 

Inserting a table row or column 

Do one of the following: 

To insert one or more table rows. 

Select one or more table rows above which it is wanted to insert one or blank table rows. 

To insert one or more table columns. 

Select one or more table columns to the left or right of which it is wanted to insert one or moreblank table columns. 

1. On the Home tab, in the Cells group, click the arrow next to Insert. 

 

Inserting Rows and Columns 

Do one of the following: 

1. To insert table rows, click Insert Table Rows Above. 
2. To insert a table row below the last row, click Insert Table Row Below. 
3. To insert table columns, click Insert Table Columns to the Left. 
4. To insert a table column to the right of the last column. 
5. Click Insert Table Column to the Right. 

Deleting rows or columns: 

1. Select one or more table rows or table columns that wanted to delete. 

Keyboard 
shortcut, to quickly 
create a new, blank 
workbook, press 
CTRL+N. 

Do you know! 
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2. On the Home tab, in the Cells group, click the arrow next to Delete, and then click Delete Table 
Rows or Delete Table Columns. 

 

Deleting rows and Columns  

 

2. Editing Contents of a Cell 

 
Inserting, deleting, or replacing cell contents 
 
1. Insert characters: 
Click on the cell where wants to insert text, and then type the new characters. 

 
2. Delete characters: 
Click in the cell where wants to delete the text, and then press BACKSPACE, or select the characters and then 
press DELETE. 
 
3. Replace specific characters: 
Select the text and then type the new text. 
 
4. Cancel or undo edits: 
Press ESC to cancel any edits that made to the cell contents. 
 
5. Adjusting Cell Contents: 
Sometimes, a cell might display #####. This can occur when the cell contains a number or a date and the width 
of its column cannot display all the characters that its format requires. Then the cell will display #####. To see 
the entire contents of the cell with its current format, It is necessary to increase the width of the column. 
 

 
 

Adjusting Cells  
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6. Changing the width of a column: 
 

1. Click on the desired cell to change the column width. 
2. On the Home tab, in the Cells group, click Format. 
3. Under Cell Size, do one of the following: 

 
To fit all text in the cell 

4. Click AutoFit Column Width. 
 

To specify a larger column width. 
 

5. Click Column Width, and then type the width that wants in the Column width box. 

 
 

Sett Column and Rows Width 
 
7.Wrapping text in a cell 

1. Click the cell in which you want to wrap the text. 
2. On the Home tab, in the Alignment group, click Wrap Text. 

 

 
Wrap Text  

Clearing the Contents of a Cell 

Simply Select the cell and press the delete key the contents will be delete. 

 

  

If you want to 
appear text on 
multiple lines in a 
cell. Wrap the text in 
cell. 

Do you know! 
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Learning Unit 7: Edit Worksheet 
 

Overview 

Each Excel workbook contains at least one or more worksheets. If you want to work with a large amount of 
related data, use worksheets to help organize the data and make it easier to work with. This learning unit covers 
the procedure of editing like copying, pasting, moving the worksheet data. After completion of this learning unit 
you will be able to describe to add, delete, copy, and move worksheets also will describe the procedure of 
splitting a worksheet, applying grammar check and many more. 

1. Editing Worksheet 

Editing a worksheet means changing the contents of the worksheet like copy, paste or moving the data so 
that it can be easy to read. 

Copy, Paste, Move a Sheet 

 

1. Copying or Moving a Worksheet 

A worksheet can be moved or copied to other location. If an extra copy required then the worksheet will be copied 
to the same workbook or a New workbook. Like this worksheet can also be moved to the New workbook or at 
the same workbook. 

For copying a worksheet 

1. Right click on the desired worksheet which wanted to be copied. 
2. Click on copy or move option. 
3. A dialogue box will appear. 

 

Copying or Moving a Worksheet  

4. Check the option, create a copy. 
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Copying or Moving a Worksheet 

5. Select the location of the worksheet where wanted to be copied.  
6. Click OK. 

 
2. Moving a worksheet using Drag and Drop 

1. Click the worksheet wants to move. 

2. Drag the worksheet icon until a small black arrow  appears where the worksheet to be moved. 

 

Moving a Worksheet  

3. Release mouse, and the worksheet will be moved. 

3. Deleting a Worksheet 

For deleting any extra r un necessary worksheet. 

1. Right click on the desired worksheet which is wanted to be removed. 
2. Click on delete option. 
3. The worksheet will be removed. 
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Deleting a Worksheet  

2. Editing Worksheet Contents  

Moving or copying cells and cell contents 

Cut, Copy, and Paste commands are used in Microsoft Office Excel to move or copy 
entire cells or their contents. Or it can also copy specific contents or attributes from 
the cells. For example, it can copy the resulting value of a formula without copying the 
formula itself, or it can copy only the formula. 

 

1. Move or copy entire cells 

Excel moves or copies the entire cell, including formulas and their resulting values, cell formats, and comments. 

1. Select the cells that want to move or copy. 
2.  On the Home tab, in the Clipboard group, do one of the following: 

 

3. To move cells, click Cut . 
4. Also can press CTRL+X. Keyboard shortcut 

5. To copy cells, click Copy . 
6. Can also press CTRL+C. 
7. Select the upper-left cell of the paste area. 

8. On the Home tab, in the Clipboard group, click Paste . 
9. Can also press CTRL+V. 

 

You can move the 
contents by 
selecting the 
contents than drag 
and drop them. 

Remember 
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2.  Relative and Absolute Cell Reference. 

By default, a cell reference is relative. For example, when you refer to cell A4 from cell C4, you are actually 
referring to a cell that is two columns to the left, and in the same row (4). A formula that contains a relative cell 
reference   changes as you copy it from one cell to another. 

As an example, if you copy the formula =A2+B2 from cell C2 to D2, the formula in D2 adjusts downward by one 
row and becomes =A3+B3. If you want to maintain the original cell reference in this example when you copy it, 
you make the cell reference absolute by preceding the columns (A and B) and row (2) with a dollar sign ($). 
Then, when you copy the formula (=$A$2+$B$2) from C2 to D2, the formula stays exactly the same. 

3. Applying Undo and Redo Option: 

Sometimes it needs to go back one step or repeat some step at this situation use Undo and Redo commands 
or buttons. 

1. For Undo Press CTRL+Z or press  button on Quick Access tool bar. 

2. For Redo an action press CTRL+Y or  button on Quick Access tool bar. 

 

4. Checking Spelling and Grammar in Worksheet: 

Press F7 or Click on Review tab then click on Spelling and Grammar option. 

 

Using Printing Command: 

1. Select the worksheet that wants to be print. To print multiple worksheets, click the first worksheet, hold 
down the Ctrl key, then click the other worksheets wanted to select. 

 

2. Click the File tab. 
3. Select Print to access the Print pane. 
4. Select Print Active Sheets from the print range drop-down menu. 
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Print Active Worksheet  

5. Click the Print button. 

5. Print the Entire Workbook: 

1. Click the File tab. 
2. Select Print to access the Print pane. 
3. Select Print Entire Workbook from the print range drop-down menu. 

 

Print Entire Workbook  

4. Click the Print button. 

 6. Print a Selection or Set the Print Area: 
1. Select the cells that want to print. 
2. Click the File tab. 
3. Select Print to access the Print pane. 
4. Select Print Selection from the print range drop-down menu. 
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Printing a Worksheet  

Changing Page Orientation: 

1. Click the File tab. 
2. Select Print to access the Print pane. 
3. Select Portrait Orientation or Landscape Orientation from the orientation drop-down menu. 

 

Changing Page Orientation  

7. Adding a Comment on a Cell: 

A comment can be added to a cell for its description. 

1. Click on Review tab. Then click on new Comment. 
2. A comment will be added to the cell. 
3. Write the description of the cell in the comment box. 
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Adding a Comment 

4. For removing a comment click on Delete comment option. 

8. Adding Currency and Percent Symbols: 

For adding currency or % percent signs with the data change the type of data as accounting or Percentage 
under the Numbers Groups on the Home tab. 

 

Adding Currency or Percentage Signs  
 

3. Formatting a Worksheet  

 
Formatting means changing the color, size, style, of a worksheet contents. For changing the contents of a 
worksheet is defined in previous lessons also. 
 

1. Write the text in the worksheet. 
2. Select the text and change the font style, font size color etc. 
3. Apply changes .and save the worksheet. 
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Formatting a Worksheet 
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Learning Unit 8: Insert Page Breaks 
 

Overview 

Page breaks are used to view the preview of a page where the page breaks when the page is printed. This 
Learning unit covers the procedure for inserting, deleting, moving page breaks. After completion of this learning 
unit you will be able to describe the page breaks, insertion deletion and moving page breaks. 

1. Using Page Break Preview  

Page breaks are dividers that divide a worksheet into separate pages for printing. Ms 
Excel insert automatic page breaks based on the paper size, margin settings, scale 
options, and the positions of any manual page breaks that are inserted. To print a 
worksheet with the exact number of pages, adjust the page breaks in the worksheet 
before print it. 

 

 

Using Page Break Preview Option : 

1. Select the worksheet or the area which is wanted to be print. 
2. On the View Tab, click on Page Break Preview button. 
3. Sett the rulers if the print is out of area. 
4. Click ok. 

 

 

Using Page Break Preview 
 

Page breaks are 
used to view the 
preview of a page 
where the page 
breaks when the 
page is printed. 

Do you know! 
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2. Inserting a Page Break  

Insert a Page Break 

1. Select the worksheet that you want to modify. 
2. On the View tab, in the Workbook Views group, click Page Break Preview. 

 

3. Click OK. 

To Insert a Horizontal Page Break: 

Select the row below where wanted to insert the page break. 

To Insert a Vertical Page Break: 

Select the column to the right of where you want to insert the page break. 

4. On the Page Layout tab, in the Page Setup group, click Breaks. 

 

Inserting Page Breaks  

5. Click Insert Page Break. 

 

3. Working with Page Breaks 

1. Moving a Page Break 

 
1. Click the File tab. 
2. Select the worksheet that wants to print. 
3. On the View tab, in the Workbook Views group, click Page Break Preview. 
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4. To move a page break, drag the page break to a new location. 

  

2. Deleting a Page Break: 

1. Select the worksheet that wants to print. 
2. On the View tab, in the Workbook Views group, click Page Break Preview. 

 

Using Page Break Preview  

To Delete a Vertical Page break 

Select the column to the right of the page break that wanted to delete. 

To Delete a Horizontal Page Break 

Select the row below the page break that you want to delete. 
 

3. On the Page Layout tab, in the Page Setup group, click Breaks. 
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Inserting Page Breaks  

4. Click Remove Page Break. 

 

3. Resetting all Page Breaks: 

1. Click the worksheet that wants to print. 
2. On the View tab, in the Workbook Views group, click Page Break Preview. 
3. Click OK. 
4. On the Page Layout tab, in the Page Setup group, click Breaks. 
5. Click Reset All Page Breaks. 

4. Returning to Normal View 

For returning to Normal view after finishing work with the page breaks, on the View tab, in the Workbook 
Views group, click Normal. 

 

Returning to Normal View  

5. Display or Hide Page Breaks in Normal View 

1. Click on the File tab. 

Click on the View Tab, and then Click on Normal View. 
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Learning Unit 9: Split Cells 
 

Overview 

Splitting means separate text or cells into two or more parts. One of many features of Microsoft Office Excel is 
the ability to merge or unmerge cells within a worksheet. When working in Excel, you can use the tools to split 
data among two or more cells within a chart or spreadsheet. This is a very good feature in Ms Excel. This learning 
unit covers the procedure for splitting the column text into separate columns. After completion of this learning unit 
you will be able to demonstrate the procedure of splitting text of a column into two different columns.  

1. Spreading the Column’s Data  

Split cells spread the text across multiple cells. This is the opposite of concatenate, where it can combine text 
from two or more cells into one cell. 

Splitting Text to Columns:  

 

Splitting Columns 
 

1. Select the column of the data. 

2. Click on DATA tab. 

3. Click on Text to Column that contains the text wants to split. 

 

 

Text to Column  

4. It starts the Convert Text to Columns Wizard.  

5. Click Delimited, than Next. 

Splitting is used to 
split your worksheet 
to view multiple 
parts of worksheet 
at once. 

Do you know! 
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6. Check Space, and uncheck the rest of the boxes. 

 

Splitting Data  

1. Click Next. 

2. In this step, pick the format for the new columns, select the format, such as Text. 

 

Selecting Data Format  

 

2. Collapse the Dialogue Box  

1. Click the  button to the right of the Destination box to collapse the dialog box. 

2. Select the cells in the workbook where wanted to paste the split data. (For example, if you are dividing a full 
name into a first name column and a last name column, select the appropriate number of cells in two adjacent 
columns.) 



Module 3: Preparing Spreadsheet  

286 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 

Selecting Column to Paste Data  

1.   3. Click the  button to expand the dialog box, and then click Finish. 

 

Expand Button 

 

Split Data  
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Learning Unit 10: Merge Cells 
 

Overview 

Merging means creating a big cell by merging vertical or horizontal rows and columns. This learning unit covers 
the procedure for merging and un merging the cells. After completion of this learning unit you will be able to 
demonstrate the procedure of merging and un merging the cells in Excel. 

1. Merging Cells 

When the cells merge into two or more adjacent horizontal or vertical cells, the cells become one larger cell that 
is displayed across multiple columns or rows. In the following example, using the Merge & Center command 
centers the text in the merged cell. 

1. On the Home tab, in the Alignment group, click Merge and Center.  

 

Merging Cells 

The cells will be merged in a row or column, and the cell contents will be centered in the merged cell.  

To Merge Cells without Centering 

2. Click the arrow next to Merge and Center, and then click Merge Across or Merge Cells.    

If the Merge and 
Center button is 
unavailable, the 
selected cells might 
be in Edit mode, or 
the cells might be 
inside an Excel 
table. To cancel Edit 
mode, press ENTER 

Remember 
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Merging Cells 

3. To change the text alignment in the merged cell, select the cell, and then click any of the alignment 
buttons in the Alignment group on the Home tab. 

 

Merge Cells 
 

2. Un Merging the Cells 

 
For splitting a merged cell, it must be selecting it first. 
 

1. Select the merged cell that wants to unmerge. 

2. When the cells are select a merged cell, the Merge and Center button  also appears selected in 
the Alignment group on the Home tab. 
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3. For splitting the merged cell, click Merge and Center , or click the arrow next to Merge and Center, 
and then click Unmerge Cells. 

4. Or Press CTRL+Z for undo. 
 

 
 

Merge Cells  
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Learner’s Activities 

Creating New Worksheet 

Description This learning activity consists of an interactive session in the class about 
creating a new worksheet inserting data in worksheet modifying data in 
worksheet and learns about different parts of a worksheet. 

Time 40 minutes. 

Purpose To highlight the procedure for creating a new work sheet and modification of a 
worksheet elements. 

Instructions for Learner 1. Ask learners how to create a new workbook. 
2. Ask learners how to insert a new worksheet in a workbook. 
3. Ask learners are they able to create their own worksheet at any specific 

place. 
4. Ask the learners are they able to modify the elements of a worksheet. 

 

Creating Chart Data in Worksheet 

Description This learning activity consists of an interactive session in the class about 
creating charts data in worksheet modifying data in charts and learns about to 
change different elements of a chart. 

Time 40 minutes. 

Purpose To highlight the procedure for creating a chart using data and then change the 
elements of this chart. 

Instructions for Learner 1. Ask learners how to create a chart. 
2. Ask learners how to modify the chart elements. 
3. Ask learners are they able to create their own modified chart. 
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Summary of Module 

  Spreadsheet is an electronic document in which data is arranged in the rows and columns of a grid 
and can be manipulated and used in calculation 

  Each worksheet is composed of a very large number of cells which are the basic place for data in a 
file or workbook. 

  A formula is statement written and calculated by a user and A function is a built-in code designed to 
calculate specific values 

  A chart is a visual representation of data. By using elements such as columns, or lines, a chart 
displays series of numeric data in a graphical format. 

  Filtering is a technique used in Excel to pick up a specific data that is required used in a 
spreadsheet to set conditions so that only certain data is displayed 

  Spreadsheets that are not formatted can be difficult to read. Formatted text and cells draw attention 
to specific parts of the spreadsheet and make the spreadsheet more visualized and easy to 
understand 

  Editing a worksheet means copying, pasting, moving a worksheet or its contents. 

  Page breaks are used to view the preview of a page where the page breaks when the page is 
printed. 

  Splitting means separate text or cells into two parts. One of many features of Microsoft Office Excel 
is the ability to merge or unmerge cells within a worksheet. When working in Excel, you can use the 
tools to split data among two or more cells within a chart or spreadsheet. 

  When the cells merge into two or more adjacent horizontal or vertical cells, the cells become one 
larger cell that is displayed across multiple columns or rows 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is the Difference between workbook and worksheet?  

Answer Workbook is a collection of worksheets. 

FAQ 2:  What is a Ribbon? 

Answer A Ribbon is a Combination of Groups and commands. 

FAQ 3:  What is the shortcut key to insert new worksheet? 

Answer Shift+F11. 

FAQ 4:  What is a Formula? 

Answer A formula is a statement which calculates the value of a cell. 

FAQ 5:  What is a Function? 

Answer A Function is a predefined formula. 

FAQ 6:  What is a Chart? 

Answer A chart is a graphical representation of data. 

FAQ 7:  What are sparkline? 

Answer A sparkline is a small type of chart that provides a visual representation of data. 

FAQ 8:  What does Merge Cells means? 

Answer Merging means to combine two or more cells in a row or column. 

FAQ 9:  What is Formatting a Cell? 

Answer Formatting a cell means to change the cell color, size, style, alignment etc. 

FAQ 10:  What is the benefit of a filter? 

Answer Filter is used to narrow down the data in a worksheet. 
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  Shortcut key to save a worksheet: 

a.  CTRL+S b.  CTRL+S+/ 

c.  CTRL+Y d.  None 

2.  For Undo an Action: 

a.  CTRL+Y b.  CTRL+Z 

c.  CTRL+U d.  None 

3.  For merging two or more cells together, use the ___________ command. 

a.  Wrap Text b.  Merge and Center 

c.  Auto Sum d.  None 

4.  When a formula contains the address of a cell, it is called a ___________. 

a.  Address Book b.  Group 

c.  Cell address d.  Cell Reference 

5.  Worksheets can be ___________. 

a.  Name b.  Color Coded 

c.  Rename d.  All 

6.  A cell reference that does not change when copied or filled is called a ___________. 

a.  Absolute reference b.  Relative Reference 

c.  Concrete Reference d.  None 

7.  If you want to arrange your data alphabetically then used ___________. 

a.  Sort b.  Filter 

c.  Alphabetize d.  None 

8.  To automatically group and summarize the data, you can use the ___________ command. 

a.  Auto Group b.  Group 

c.  Sub total d.  Combine  

9.  Use ___________ to narrow down the data in your worksheet or hide parts of it from view. 

a.  Borders b.  Functions 

c.  Filters d.  All 

10.  Shortcut key For Redo: 

a.  CTRL+Z b.  CTRL+R 

c.  CTRL+Y d.  None 
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Answer Key 
MCQ Number Correct Answer 

1 a 

2 b 

3 b 

4 d 

5 d 

6 a 

7 a 

8 a 

9 c 

10 c 
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Module 4: Prepare Presentation 
 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Prepare Slide Master 

  Insert Slide 

  Design Slide 

  Apply Animation  

  Apply Sound Effects 

  Format Slide 
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Learning Unit 1: Prepare Master Slide 

Overview 

Slide Master is a special feature in PowerPoint that allows quick modifications of the 
slides and sliding layouts in presentation. This learning unit covers the procedure for 
preparing the Slide Master. After completion of this learning unit, you will be able to 
demonstrate the procedure for preparing Slide Master orientation and layout of the 
Slide Master.  
 

1. Slide Master 

A slide master is the top slide that stores information about the theme and slide layouts of a presentation. It 
includes the background, color, fonts, effects, and positioning. By using Slide Master, affects can be added 
in every slide. Individual slide layouts can also be modified using this feature. 

2. Key Benefits of Using Slide Master 

The key benefits of using slide master is: 
 

 Modifying backgrounds:  Using slide master watermark or logos can be added to every slide in a 
presentation or modify the background graphics of an existing PowerPoint theme. 

 

 Customizing text formatting: Using Slide Master, Text formatting can be done in all slides at once rather 
than formatting text on each slide. 
 

 Creating unique slide layouts: Using slide master customized layouts of slides can be possible. 

3. Creating and Editing a Slide Master 

Creating a Slide Master: 

 
Insert a New Slide Layout:  
 

1. Click on the View tab of the ribbon. 
2. Click on the Slide Master button 
3. Navigate to Slide Master View, From the Slide Master tab. 
4. Click the Insert Layout command. 

 
Inserting Slide Master 

Every presentation 
contains at least one 
slide master. 

Remember 
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Customizing the Slide Master 

 

Customizing means changing in pattern and layout of a slide. 
 

1. Inserting a New Placeholder 

 
 

Inserting a New Placeholder 
 

1. Click the bottom half of the InsertPlaceholder command, and then select the desired placeholder 
type. 

 

 
Adding Placeholder 

 
2. Click and drag to draw the placeholder on the slide. The user can add more placeholders required. 

 
2. Changing text color/alignment on Slide Master: 

 
1. Select the View tab from the Menu Bar. 

2. Click the Slide Master View command in the Presentation Views group. The Slide Master tab 
will appear active. 

3. Select the slide master for all slides, if it is not currently selected. 

4. Select the text you want to modify, and format it how you want.  

Placeholders are the 
boxes with the 
dotted borders 
contain contents. 

Do you know! 

Placeholder is the 
area where you can 
add objects, 
pictures, charts, 
textboxes etc. 

Do you know! 
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5. Select the Home tab. The slide master and supporting layouts will remain in the slide task pane 
on the left because Slide Master View is the current view. 

6. Click the Font Color command in the Font group. 

7. Hover over each font option to display a live preview on the Slide Master. 

 

 
 

Changing Color of a Text in Slide Master 

 
8. Select a font color from the menu options. The font color change will appear on all the slides 

in the task pane on the left. 

9. Click an alignment command to change the alignment of the selected text. 

 
 

Changing Text Alignment 
 

10. Click the Slide Show view or Normal view command at the bottom of the window to exit Slide 
Master View and see the changes in the presentation slides. 

 

3. Inserting  Logos & Pictures on Slides: 
 
1. Select the View tab from Menu Bar 
2. Click the Slide MasterView command in the Presentation Views group. The Slide Master tab will 

appear active. 
3. Select the slide master for all slides, if it is not currently selected. 
4. Select the Insert tab. 
5. Click the Picture command in the Illustrations group. The Insert Picture dialog box will appear. 
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Inserting a Picture or Logo in a Slide 
 

6. Locate the picture file on the computer. 
7. Select the picture file. 
8. Click Insert. The picture will appear on the slide master. 

 

 
 

Locating Pictures 
 
9. Click the picture and while holding down the mouse button, drag it to the desired location on the 

slide. Release the mouse button. 
10. The picture will be inserted. 

 

4. Use of Multiple Slide Master in a Presentation 

 
To add more than one theme in presentation, it requires multiple slide masters. Each slide master represents 
each theme. For example, in the image that follows. 
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Slide Master 1 

Adding another Slide Master to a Presentation 

1. On the View tab, click Slide Master. 
2. On the Slide Master tab, do one of the following: 
3. From the Edit Theme group, click Themes, and then under Built-in, select a theme. 
4. From the Edit Master group, click Insert Slide Master. 

 
 

Slide Master 2 
 
In the above image there are two different layouts applied in the same presentation. 
 
 

5. Removing Built-in Slide Layouts 

To remove the default layout/built-in layout follow these steps: 

 
1. Select the slide which is to remove. 
2. Click on delete button. 
3. The slide will be deleted. 

 

A slide master can 
be reuse to another 
presentation by 
copying and pasting 
it. 

Do you know! 
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Removing a Slide 

 

6. Applying Theme to a Presentation 

To apply a built in theme on a presentation following are the steps:   

1. Applying a Built-in Theme 

1. Click on the Design Tab. 
2. Select Built-In, click the desired theme. 
3. The selected theme will be applied. 

 

Applying Built-in Theme 

 2. Applying a Customized Theme 

1. Click on the Design tab. 

2. Click Browse for Themes 

3. Locate the desired theme. 
 

 

Browsing a Customized Theme 
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4. Select themed document stored in a different location. 
 

 

Applying a Customized Theme 

3. Downloading a Theme from Office Online 

1. To download free themes from Office Online 
2. Click More Themes on Microsoft Office Online.  
3. Select the desired theme and apply. 

 

Browsing a Theme Online 
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7. Applying Page Orientation Settings 

Changing the orientation of all slides 

      1. A presentation can have only one orientation (either landscape or portrait).  

 

Portrait page orientation Landscape page orientation 

1. Changing all the slides in a presentation to portrait orientation:,  
2.  

3. Click Page Setupfrom the File menu 

4. Click Portrait . Under Orientation. 

 

  

By default 
orientation of a page 
is landscape. 

Remember 
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Learning Unit 2: Insert Slide 
 

Overview 

 
This learning unit covers the procedure of inserting slides using different methods in a presentation. After 
completion of this unit you will be able to demonstrate the procedure for adding slides in a presentation. 
 

1. Add One or More Slides in a Presentation 

 
One or more slides can be added in a presentation easily. Following are the steps:  
 

1. Open Ms Power point. 
2. Under the Home tab. 
3. Click on New slide. 
4. Select the desired layout of a slide. 
5. The slide will be inserted.  

 

 
 

Inserting a New Slide 
 

2. Inserting Duplicate Slide to/from other File 

 
A duplicate slide can also be added from any other file with same format. 
 

1. Open both files (source and destination). 
2. Click on the slide which wanted to be added on other file. 
3. Click and drag the slide and drop it to the destination slide. 
4. Save the slide with source file formatting. 

 

 
 
  

Duplicate slide can 
be added by copy 
and paste the 
existing slide again. 

Remember 
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Learning Unit 3: Design Slide 
 

 

Overview 

This learning unit will cover the procedure for designing a slide. After completion of this learning unit, you will be 
able to demonstrate the procedure to design slide and change the design, color, fonts, effects and background 
etc.  

1. Creating a Slide Design Template 

 
1. Insert a slide in a blank document 
2. Click the Design Tab from the main menu 
3. The design templates have different options. 

 

 
 

Creating a Slide Template 
 
4. Click the theme and choose appropriate theme from the available list or add new theme from the saved file. 
5. For creation of new theme select customize Background option and choose on choice background form 

the list. 
6. Click the variant option. 
7. Click Font and select appropriate Font 
8. Click Color and select suitable color scheme 
9. Click Background styles and select desired background 
10. Click Effect and select appropriate effect 
11. Click size of the Slide ,it shows two options ,choose one option 

 

 
 

Inserting New Slide Design 
 
12. Newly created slide deign is shown in the task pane. 



Module 4: Prepare Presentation  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 307 

2. Switching to Slide Master 

 
     1. Click Slide Master from the view tab on the menu bar. 
     2. The designed slide template is copied to the Slide Master 
     3. This design is automatically applied to all Slides. 
 

 
 
 

3. Save as a New Template 

 
1. To save the new template click File from the main Menu 
2. Select Save as option 
3. Click brows 
4. Click presentation template  folder in MS office  
5. Select design template as the file type  
6. Click save 

 

 
 

Save as a New Template  
 

4. Save the template in Design Template Folder 

 
1. Open the power point presentation. 
2. Open blank slide. 
3. Click design from Main menu. 
4. Click Browse from themes, select file template saved. 
5. Open the saved template that is selected as a design for new presentation. 
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5. Save Template in New Presentation Task Pane 

 
1. Click the new from file menu 
2. Click recent presentation 
3. Newly created Save template is selected in new presentation 

 

 
 

Save the Template in Templates Folder 
 

  

When you create a 
presentation, and 
then save it as a 
PowerPoint template 
file, save it to the 
template folder 

Remember 
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Learning Unit 4: Apply Animation 
 

Overview 

Animations are visual effects applied to individual items on the slide such as graphics, titles or bullet points. 
Animation can help to make a PowerPoint presentation more dynamic, visually interesting, automation and to 
grab the audience's attention. The most common types of animation effects include entrances, exits, emphasis 
and motion paths 

1. Meaning and Usage of Animation  

Animations in MS Power point refers to the way that items, such as text boxes, bullets, or images move onto a 
slide during a slideshow.  

Types of Animations: 

 Entrance effects:  Make an object fade gradually into focus, fly onto the slide from an edge, or bounce 
into view. 

 Exit effects: Making an object fly off of the slide, disappear from view, or spiral off of the slide. 

 Emphasis effects: Making an object shrink or grow in size, change color, or spin on its centre. 

 Motion Paths: Make an object move up or down, left or right, or in a star or circular pattern (among other 
effects).  

There are many uses of animation in PowerPoint.  

 Animation move individual options onto or off of the slide. 

 Can reveal points on slides in a staggered way (i.e. one bullet displayed at a 
time) to keep the audience focused only on the point. 

 Can automate the presentation so it runs on its own. 

 Can use animation to focus on important points, to control the flow of information. 

 Can increase viewer interest in presentation. 

 Can communicate messages or ideas more effectively. 

2. Applying an Animation to Slides  

1. Select the text or object to apply animation 
2. Click the Animations tab from main menu 
3. Click an animation effect from the Animation group gallery. 
4. Click the More arrow to see more options 
5. Animation Applied to the object. 
6. Click Effect Options and select the effect to, how animation have effects. 
7.  To specify the timing of the effects, on the Animations tab, use the commands in the Timing group. 

Too much animation 
can be distracting.  

Remember 
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Apply Animation to Slide Master 

Apply the animation to the Slide Master and it will appear on all slides. 
 

1. Open presentation in PowerPoint 
2. Click Slide Master from the View tab 
3. Click the main text box that contains the bulleted list On the Slide Master. 
4. Click the Animations tab. 
5. Select the animation that for the list. 
6. Click Custom Animation,  
7. Click Add Effect, click Entrance, and then click Blinds. 
8. Click the View tab, and then click Normal. 

 

 

Animations Applied to Slide Master reflects in all the Slide 

Applying Transition to a Slide 

Slide transitions are like the effects used in films to change from scene to scene. 

1. Select the Slide 
2. Choose an effect from the Transition gallery In the Animations tab under the Transition to This 

Slide group. 
3. Use the arrow to scroll through the options. PowerPoint will show a preview of the transition when 

mouse is over a gallery item. 
 

 

Previously selected 
an animation for an 
element on the 
page, the animation 
will be shown 
automatically. 

Do you know! 
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Applying Transition to a Slide 
 
To set the speed of a transition,  

 
1. Select a speed from the Transition Speed pull-down menu. 
2. To apply transition settings to all of your slides, click Apply to All. 
3. To set the clicking option 
4. Clicking the mouse of the "On Mouse Click" option is checked. 

 

 
 
 

3. Perform Custom Animation on one Slide 

A custom animation allows you to consider the objects or the text boxes in a slide, one at a time, and to animate 
them as desired by the person not as given in the software.  

1. Select the slide to which the animation is to be applied. 

2. Select the Animations tab and the Animation Pane button from the Main menu. The Animation Pane 
appears on the right side of the screen. 

 

3. Click on an element of the slide that is to be animated.                 

4. For example, select a title, bulleted list, or graphic. 

5. Click Add Effect.  

 A menu appears with a list of effect categories.  

6. Entrance effects control how the element enters the slide.  
7. Emphasis effects make the element do something after it enters the slide.  

8. Exit effects control how it leaves the slide.  

9. Motion paths allow you to specify where the element travels on the slide. 

 

Quick method to 
change speed of 
PowerPoint 
animation set the 
precise speed of 
next slides. 

Do you know! 
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10. Select one of the effects. Details about the effect appear in the Animation Pane. 
11. In the Start field, use the drop-down menu to select an event which will trigger the animation. 

12. In the Direction field, use the drop-down menu to select a direction for the animation. The significance 
of the direction depends on animation type. 

13. In the Speed field, use the drop-down menu to select a speed for the animation. 

 
 

 
 

4. Applying Custom Animation to all Slides 

To apply a custom animation to all slides 

1. Click the Slide Master. 
2. Click custom Animation 
3. Custom Animation will be applied to all slides 

 
  

Animation pane 
allows viewing and 
managing all the 
effects on the 
current slide. 

Remember 
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Learning Unit 5: Apply Sound Effects 
 

Overview 

 
Sound is the special feature in Power point to make a presentation more attractive and 
effective. This learning unit covers the procedure of applying different types of sounds 
on a presentation. After completion of this unit you will be able to demonstrate the uses 
of sounds its types and procedure of applying sound effects in your presentation.  
 

1. Using Sound Effects in Presentation 

 
PowerPoint allows adding sound in a presentation using different methods. This can be done by using a sound 
file from computer, choosing from hundreds of sounds available through the clip organizer, or playing tracks 
from an audio CD or from a recorded voice. Customized and Built –in sound effects can be added to a 
presentation. 
 
Sound can be added from three different sources. 
 
Inserting  a Sound File from Computer: 
 

1. Select the slide where the sound will be added. 

2. Select the Insert tab. 

3. Click the drop-down arrow on the Sound command in the Media Clips group. 

 

 
 

Inserting Sound Clip 
 

 4. Select Sound from File from the menu. The Insert Sound dialog box will appear. 

 
Selecting Sound from File  

5. Locate the sound file on computer. 

6. Select the file.  

Sounds can be 
added from a CD or 
a recorded voice. 

Remember 
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Selecting  File 
 

8. Click OK. A sound icon and a dialog box will appear. 

 

 

 
Inserting a Sound File from Clip Art 

1. Select the Insert tab from Menu bar. 

2. Click the drop-down arrow on the Sound command in the Media Clips 
group. 

3. Click on Clip art audio option. 

4. Select any of the clip media from the list like claps cheers, telephone 
etc. 

 

 
 
 

 

You can add a song 
a clip or a recorded 
voice to your 
presentation. 

Do you know! 

To repeat a sound 
until you stop it, or to 
play it for the 
duration you need to 
specify to options. 

Remember 
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2. Association of Animation with a Sound Effects  

 
A sound can also be added to any animation also. For example if you want to play a sound at any specific 
animation you can easily applied a sound to it. 
For this purpose following are the steps. 
 

1. Select the desired object. 
2. Click on Animation tab. 
3. Apply the desired animation on the selected object. 
4. Then click on Insert tab. 
5. Click on Audio button. Select the desired method through which sound will be applied. 
6. Select the sound. 
7. A sound icon will appear on slide. 
8. Set the properties for its application on slide from the playback tab on Menu bar. 
9. The sound will be added to animation. 

 
 

Association of Animation and Sound 

 

3. Association of Different Sound Effects with Different Slides 

 
In power point different sound effects can be added to different objects. 
For example you can add different sound effects at each slide in a presentation.  
 

1. On a slide select the object at which sound will be added. 

2. Click on insert tab then click sound button. 

3. Select the method through which you want to add sound. 

4. Select the and apply it. 

5. Repeat the steps for all the desired objects at which the sound will be added. 

6. Set the properties of the sound from playback tab on Menu bar. 
 

 
 

Association of Animation with Different Sound 

Sounds can be 
associate with 
different objects in a 
presentation. 

Do you know! 
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Learning Unit 6: Format Slide Master 
 

Overview 

Formatting in slide is changing the color, size, style, design of slide. This unit will cover the procedure of formatting 
a Slide Master. After completion of this, You will be able to demonstrate the procedure of formatting a Slide 
Master in different ways. 
 

1. Formatting Master Title  

 

Formatting Master Title Text  

 

1. Click on the master title style to select it.  

2. From the Slide Master tab, select the Fonts dropdown in the Edit Theme area.  

 
 

3. Select the desired font, font style, font size, effects, and color. 

4. Click OK when finished selecting the font attributes for the title style. 

5. Click elsewhere on the slide to deselect the title style and view the font formatting. 

6. Repeat the steps as needed. 

7. Select each text style and follow steps 2 through 6 to format the appearance of the text. 

2. Formatting Slide 

 
Opening Slide Master 

 

1. From the menu, selecttheView tab. 

2. Select Slide Master. 

 
 

3. A new Slide Mastertab will automatically appear. 

Formatting Text 

 

1. Click on the master title style to select it.  

2. From the Slide Master tab, select the Fonts dropdown. 

 

Formatting relates to 
the objects 
properties like 
changing the size, 
color, font, style and 
alignments of a text 
or objects. 

Remember 
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3. Select the desired font, font style, font size, effects, and color. 

4. Click OK. 

5. Repeat the steps as needed.  

6. To change the bullets for each level of text, click on the text to select it and from the Home tab, expand 
the Bullets and Numbering menus.  

 
Formatting Slide  

 

Moving and Resizing Text Areas 

 

1. Click on a text area. A border appears with resize handles.  

2. To resize the text area, click and drag a resize handle while keeping the mouse clicked. A dotted line 
shows the new size of the area.  

3. To move the text area, move the mouse pointer over the text area. The mouse pointer becomes a four-
headed arrow.  

4. Click and drag the text area to a new location. 

 

Working with Footers and Special Placeholders 

 

The Slide Master contains placeholders for date/time, slide number, and footer. These can be moved around, 
resized, and reformatted.  

1. From the Menu bar, select the Insert tab. 

2. Then select Header and Footer. 

 
 

3. The Header and Footer box appear.  

You can change the 
type of bullets like 
images or any other 
format from symbol 
according to your 
need. 

Do you know! 
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4. Click on the Slide number check box if the slides wanted to be numbered. 

5. Type text in the Footerbox if it desired. 

6. Click the Don’t show on title slide check box if it does not want the placeholders to appear on the title 
slides. 

7. By default, the date/time does not appear even though the placeholder is turned on. This is because 
Fixed is the default setting and the Fixed box is blank.  

8. To make the date/time appear, type the date in the Fixed box or click Update automatically to set up an 
automatic date/time on each slide. Click the drop down menu to select the desired date/time format. 

9. Click Apply to Allto apply the footers and placeholders to all slides. 

 

Changing the Background 

 

1. From the menu bar, select the Slide Master tab. 

2. Then select Background >Background Styles.dropdown menu. The Background window appears. 

 
 

3. Select a predefined color.  

4.  Color selections can be previewed before applying. 

5. Click to apply the background selection to the slide master.  

 

Return to Normal view  

 

1. After defining slide master formats, return to the normal view. Close Master 
View from the ribbon.  

 
 

Header footer can 
be applied by double 
clicking on the 
header or footer 
place. 

Do you know! 

Normal view is 
where you will work 
most frequently to 
create your slides. 

Remember 
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3. Delete or Change Properties of a Slide Format 

 
A slide formatting can also be customized. For example if you want to change the size of a text box or color of a 
text then you can customize its properties. 
 

1. Select the object. 
2. Right click then go to the Size and position option. 
3. Change the desired properties. 
4. Click ok. 

 

 
 

Change the Properties of Slide Format  
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Learner’s Activities 

Description This learning activity consists of an interactive session in the class about the 
importance of Slide Masters and how to apply and customize these Slide 
Master view in PowerPoint presentation 

 

Time 40 minutes. 

 

Purpose To highlight the importance of Slide Masters and their use in PowerPoint. 

 

Instructions for Learner 1. Ask learners how to apply customize Slide Master. 

2. Ask learners are they able to add another slide to a Slide Master from other 
presentation. 

3. Ask learners are they able to create their own Slide Master. 

 

 

 

Description This learning activity consists of an interactive session in the class about 
Custom animation and transition to apply effects on presentation for making it 
more attractive and effective. 

Time 40 minutes. 

 

Purpose To highlight the importance of animation and transition in PowerPoint. 

 

Instructions for Learner 1. Ask learners how to apply customize animation. 

2. Ask learners are they able to apply animation and transition to slides. 
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Summary of Module 
  

  Microsoft PowerPoint is the software that incorporates with images, sounds, videos, text, and charts 
to create an interactive presentation. 

  A slide master is the top slide that stores information about the theme and slide layouts of a 
presentation. It includes the background, color, fonts, effects, and positioning. 

  Most PowerPoint presentations are created from a template, which includes a background color or 
images, fonts and slide layouts. 

  A design template is created so that even though different slide types can have different layoutsand 
graphics. 

  Animation can help to make a PowerPoint presentation more dynamic, visually interesting, 
automation and to grab the audience's attention. 

  Sound is the special feature in Power point to make a presentation more attractive and effective 

  Formatting in slide is changing the color, size, style, design of slide. 

  Transitions are the motion effects that add movements to the slide show when it is viewed. 

  Animations can be applied to text, images, shapes, and graphics so they play in slide show. 

  A PowerPoint template is a pattern of a slide or group of slides that contains layouts, themes, colors, 
theme fonts, theme effects, background styles and contents also. 

 

  

http://presentationsoft.about.com/od/l/g/layout.htm
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Frequently Asked Questions (FAQs) 

FAQ 1:  Name the different tabs in PowerPoint? 

Answer File, Home, Insert, Design, Animation, Slideshow, Review, and View 

FAQ 2:  What is the Ribbon in PowerPoint? 

Answer The Ribbon consists of tabs, Each Ribbon has group of commands. 

FAQ 3:  What is slide master view? 

Answer Slide master view allows to quickly modifying the slide layouts in presentation. 

FAQ 4:  What is animation? 

Answer 
Animation is a set of effects which can be applied to objects in PowerPoint so that they will 
animate in the slide show. 

FAQ 5:  What are the methods of applying sound effects in a presentation? 

Answer 
There are three methods to add sound in a presentation. 
1. Insert from File, 2.Insert from record sound 3. Insert from a CD audio track. 

FAQ 6:  What is a slide in a presentation? 

Answer Slide is a single page of a presentation created with software such as PowerPoint. 

FAQ 7:  What is a slide show? 

Answer 
Slide show is a collection of pages arranged in a sequence that contain text, images for 
presenting to the audience using a display device like projector. 

FAQ 8:  What are the charts in PowerPoint? 

Answer 
PowerPoint includes many types of charts for graphically representation of data i.e. Line chart, 
Pie chart, scatter chart, etc. 

FAQ 9:  What is the extension of PowerPoint file? 

Answer The extension of PowerPoint files are .ppt and .pptx 

FAQ 10:  What is the shortcut key for playing a slide show? 

Answer The shortcut key for playing a slide show is F5. 
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  To insert logo in the same position on every slide, automatically, Insert it on the ________. 

a.  Handout Master b.  Notes master 

c.  Slide master d.  All of the above. 

2.  Special effects used to introduce slides in a Slideshow are called_________________. 

a.  Effects b.  Custom animation 

c.  Transitions d.  Present animation 

3.  What is the shortcut key for saving a PowerPoint presentation? 

a.  CTRL+R b.  CTRL+S 

c.  CTRL+O d.  None 

4.  PowerPoint presentations are widely used as_________. 

a.  Note outlines for teachers b.  Project presentation by students. 

c.  Communication of planning. d.  All of the above. 

5.  To add more text to a slide add _______________. 

a.  Text box. b.  Contents control 

c.  Picture box d.  None 

6.  A theme includes all of the following except_____________. 

a.  Fonts b.  Clip art 

c.  Colors d.  effects 

7.  An images can be added to the presentation from the ________ tab. 

a.  Insert b.  View 

c.  Home d.  File 

8.  A _____ is the motion effect on slide when one slide changes to another in a slide show. 

a.  Transition b.  Animation 

c.  sound d.  None 

9.  
A presentation can be presented by selecting the ___________ view at the bottom of the 
PowerPoint window. 

a.  Reading View b.  Normal view 

c.  Slide show d.  None 

10.  All of the following is a type of animation except______? 

a.  Entrance b.  Equation 

c.  Emphasis d.  Exit 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 c 

3 b 

4 d 

5 a 

6 b 

7 a 

8 a 

9 c 

10 b 

 

 



Module 5: Prepare In-Page Documents 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 325 

Module 5: Prepare In-Page Documents 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Set Keyboard Preferences 

  Layout Page 

  Toggle Between Languages 

  Insert Columns 
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Learning Unit 1: Set Keyboard Preferences 

Overview 

From keyboard preference you can either select one of the predefined keyboards 
(Monotype, Farsi, Kashmiri, Kurdish, Aftab, Muqtadra, Phonetic, Farsi, and Arabic) or 
make your own keyboards (up-to eight User Defined Keyboards). Predefined 
Keyboards cannot be modified whereas you can modify User Defined Keyboard 
according to your need.In this learning unit, you will learn how to set the keyboard 
preferences.  

1. Method to Switch between Different Input Languages 

 
Using the “keyboard preferences” menu item, you can select from one of the predefine keyboards or from a 
list of eight User defined Keyboards and modify it as per your requirements. 
 

2. Setting Keyboard Preferences 

The procedure of setting keyboard preferences has the following steps: 

 

  

 

1. Open the new In-page file. 

By Default the 
keyboard is set to 
Phonetic. 

Do you know! 

There is a support of 
up to Eight User 
Defined Keyboards 
in In-Page 
Professional 
whereas other 
versions of In-Page 
have support for 
only one. 
User Defined 
Keyboard. 

Do you know! 



Module 5: Prepare In-Page Documents 

328 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 

2. Click on the “Edit Menu” from Menu bar. 

 

3. Click on the option “Preferences” and then select the keyboard preferences. 

 

 

4. Select the Keyboard from the combo box 

You can find out 
which language is 
currently enabled by 
looking at the 
language 
information in the 
bottom right of your 
In-Page window. 

Remember 
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5. Click on “OK” button. 

 

6. If you have selected one of the fixed keyboards, you can use the View button under the combo box to 
view or print the selected keyboard. 
 

3. Key Positions of Selected Keyboard Preferences 

The difference between key positions of any keyboard preferences can be illustrated by the following steps. 

 
Setting up Phonetic Keyboard: 

 

 
 

1. Open the new In-Page file. 
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2. Set the Keyboard preferences to Phonetic. 

 
 

3. Phonetic keyboard has the following key positions. 
 

 

4. Type “INPAGE URDU KEYBOARD” in Urdu language. Above example shows the key positions in the 
phonetic keyboard. 

 
Setting up Monotype Keyboard: 

  

 

1. Open the new In-Page file. 
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2. Set the Keyboard preferences to Monotype. 

 

 
 

3. Monotype keyboard has the following key positions. 

 
 

4. Press the same keys as used in phonetic keyboard. Above example shows the difference between key 
positions in the Monotype keyboard. 
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Learning Unit 2: Page Layout 

Overview 

Page layout includes formatting of page such as page size, margin, orientation and page number. After 
completion of this learning unit you will be able to demonstrate the different page sizes and page margins in the 
In-page file and could exhibit to add page numbering in the file. 
 

1. Specifying Page Layout and Paragraph Formatting Attributes on Text 

Specify Page layout: 
The dialog box that appears by clicking “New” button allows you to enter values for your document. The 
attributes that can be set in this dialog are 
 
Page Size:  
You can select one of the standard pages sizes from the page Size Combo Box. If a custom size is desired, 
then you need to enter the Page Width and Page Height. 
 
Page Margins: 
Specify the page margins distances from the respective Box boundary.  
 
Page Orientation: 
The pages in the document can either be in a Portrait mode or in a Landscape mode. In Portrait mode, the 
width and height that you specify are taken such, whereas in the Landscape mode, the widths and heights are 
interchanged. 

The procedure of specifying page layout has the following steps: 
 

1. Choose the New menu item from the File menu. 

 

2. A New Document dialog is displayed. You can specify the page size, orientation, margins etc. Or you 
can just let the default settings work for you. 
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3. Click on OK button. 

4. A new document with the specified attributes is created. 

2. Adding Page Number in File 

 
Selecting this option inserts a page number field at the insertion point.  
 
This option is available only if insertion point is in Title Text box. If you are in text Edit 
mode inside a normal text box, this menu item appears grayed. 
 
 
 

The procedure of adding page number has the following steps: 

1.  Open the document to which you want to insert Footer. 

2.  Now click on Master Page option on the left corner of the page. 

3.  By clicking on Master page a blank page will be open. 

4.  Make a title text box at the desired location on the page. 

5.  
Go to Text Edit Mode by choosing the IBEAM tool  and clicking on this title text box 

6.  Choose the Page Number menu item from the Insert menu. 

7.  Then click on the master page button again. 

8.  If you are inserting a page number inside a title text box on a master page, then the page 
number gets inserted as "#" character in master page. 

 

 
 
 
 
Paragraph Formatting Attributes 

Paragraph Setting: 
Paragraph Attributes are a collection of attributes that get applied to the paragraph as a whole. Unlike the 
character attributes which get applied to selected characters, paragraph attributes get applied to the 
whole paragraph(s) lying inside the selection. Therefore if paragraph attribute is applied when the cursor 
is blinking then these attributes get applied paragraph in which the cursor is blinking. 

Anything what we 
write on master 
page is also shown 
on all pages of the 
Document. 

Remember 
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The Paragraph Attributes are as follows: 

 Style Sheet Name Combo Box: All the defined Style Sheets appear in this combo box. You can 
define new style sheets by selecting the Define Style Sheets menu item from the Format menu. 
On selecting a Style Sheet from this combo box, the style sheet is applied to the selected 
paragraph.  

 

Defining New Style Sheet                   

The procedure to define a new style sheet has the following steps: 

9.  Click on style sheet in the format menu. 

 

10.  Make a New style sheet and define the name of your Style sheet. 
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11.  Click the “OK” button. 

12.  Now define the styles of paragraph, characters, border and hyphenation according to our choice 
and click “OK”. 

 

Alligning Paragraph 

The paragraph can be aligned in the following styles: 

 Start Align aligns the text on left side of the frame for horizontal line direction and on top of the 
frame for vertical line direction. 

 End Align aligns the text on right side of the frame for horizontal line direction and on bottom of the 
frame for vertical line direction. 

 Center Align aligns the text between the frame edges. 

 Full Align justifies the text between the frame edges. The last line of the paragraph remains start 
aligned.fdsa432; 

 Forced Align justifies all lines of the text between the frame edges. 

 

Line Height Edit Box:  

You can specify the line height (Auto by default) which sets line height of each line of text in the paragraph to 
this value. 

 

Inter Line Spacing Edit Box:  

Specifies the gap between lines.  
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Changing Point Size: 

 To change the point size of the selected text, you need to enter the new point size in the Size combo box 
either in the ribbon or in the Format Character dialog. 

 
Borders: 
You can apply borders before and after a paragraph (much like as Remember paragraphs. The Borders can 
also be given a line pattern style (whether dotted, dashed, dash-dotted etc.), its thickness and color can also 
be specified. 
 
Hyphenation: 
Hyphenation allows you to hyphenate English words at the end of the line of text in a paragraph. In-Page gives 
us the capability to specify the density of hyphenation in a paragraph. 
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Learning Unit 3: Toggle Between Languages 
 

Overview 

In-page supports several languages such as Urdu, Arabic, Pushtu, Sindhi, Farsi, Kashmiri. If other languages 
are enabled from the in-page setup then a short cut key (Ctrl + Space) can be used to switch between the 
languages. After completion of this learning unit you will be able to Perform toggle between different languages. 
 

1. How to Enable Optional Languages 

 
Following steps to be followed to enable the optional languages support such as Pushtu and Sindhi. 
 
Step 1: 
 
In the Menu bar click EDIT  then PREFERENCES and then KEYBOARD PREFERENCES 
 

 
 
Step 2: 
 
Check Enable Sindhi or Enable Pushtu or both 
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2. How to Toggle between Languages 

You can toggle between English and Urdu by pressing Ctrl+Space. Also you can choose the menu item Toggle 
Language from the Language menu. If you have enabled Sindhi and Pushtu, then this command switches 
amongst English, Urdu, Sindhi and Pushtu. 
 
Corresponding to the current language its name is displayed in the task bar on the bottom right corner of InPage 
frame window. 
 

3. Switching Amongst the Languages 

 
Step 1: 
 
Urdu is enabled in the lower right corner. Press Ctrl+Space to change the language  
 

 
 

 
Step 2:  
 
Sindhi is enabled in the lower right corner. Press Ctrl+Space to change the language. 
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Step 3: 
 
Pushtu is enabled in the lower right corner. Press Ctrl+Space to change the language  
 

 
 
 

 
Step: 4 
 
English is enabled in the lower right corner. Press Ctrl+Space to change the language. 
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Learning Unit 4: Insert Column 
 

Overview 

Column is an important feature in the In-page software. It is used to manage the text in a specific portion of the 
page or text and can be aligned properly using columns. After completion of this learning unit you will be able to 
use columns and its supporting options in In-page. 

1. Selecting Text and Inserting in Table 

 
The procedure to convert the text in a table has the following steps: 
 
1. Open the In-page file and type the text. 
 

 
 

2. Select the whole text by pressing “CTRL+A” key from keyboard. 

 

3. Click on Insert Menu and select Text to Table Option. 
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4. A Dialog box will appear select Tabs or Paragraph.  

 
5. Click on OK button. 

6. The table will be created on the paragraph. 

2. Inserting Specific Text in the Column 

 
A portion of the text can be selected to insert in a table. The procedure to insert specific text in the column has 
the following steps: 
 

1. Place the cursor on the page where you want to create columns. 

2. Now Click on Insert Menu and select the Table option. 

3. In appearing dialog box select the number of the rows and number of columns of the table. For 
example 3 columns and 1 row in the table. 

4. Now Click on Ok button. 

5. Finish. 

6. Now select the text that you want to insert in column 1 and paste it. 

7. Repeat step – 6 for other columns. 

Sample file using column is as follows 
 



Module 5: Prepare In-Page Documents 

342 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 
   



Module 5: Prepare In-Page Documents 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 343 

Learner’s Activity 

Description This learning activity consists of an interactive session in the class about the selection 
of keyboard and language urdu phenotic , alignment and page setup. 

 

Time 40 minutes. 

 

Purpose To defined the step by step procedure of urdu inpage. 

 

Instructions for 
Learner 

1. Ask learners how to select the page setup 

2. Ask the learner how to select the language and keyboard. 
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Summary of Module 

 Inpage is a program that is used to compose Urdu, Arabic, Farsi, Sindhi, Pushtu in computer. It is a very 
comprehensive program. This program is used to compose Urdu and other Pakistni languages with all 
fonts and facilities. 
 

 Inpage comes with eight predefined and eight user-defined key-boards.Predefined Keyboards cannot be 
modified whereas you can modify User Defined Keyboard according to your need. In the Inpage software 
Ctrl+Space command switches between the Input languages. Windows languages can be switched by 
Alt+Shift. 
 

 Page layout is the term used to describe how each page of your document will appear when it is printed. 
Inpage page layout has several important options such as margins, columns, portrait, landscape etc. 
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Frequently Asked Questions (FAQS) 

FAQ 1:  From where I can download INPAGE software? 

Answer 
In-page Urdu is a very popular Urdu desktop publishing software. While its original version is not 
available for download, many clone copies are available. These look and work like In-page Urdu 
but may have some bugs or viruses. Use at your own risk. 

FAQ 2:  Does In-page works under windows 7? 

Answer 
In-page works under almost all versions of windows including windows xp, windows 2000, 
windows 7 and windows 8. 

FAQ 3:  Can I save my files as PDF? 

Answer Yes, In-Page can save a file or pages in pdf format by Primopdf software tool. 

FAQ 4:  Can I copy contents from in-page and paste it to MS word? 

Answer Yes, In-page contents can be shifted to ms word through In-page Unicode convertor software. 

FAQ 5:  How do I convert Urdu image files like*.jpg,*.BMP,*.PNG in to an in-page file? 

Answer 
It is not possible to convert image files to in-page files at this time. It falls in to the realm of OCR 
(Optical Character Recognition) and currently there is no software that can do the job. 

FAQ 6:  Can I use In-page for mathematical equations? 

Answer 
Yes, you can use In-Page to inter mix mathematical equations with urdu/english text. These 
equations will need to be entered in MS Windows compatible software which supports equation. 
One such package is Microsoft's Equation Editor. 

FAQ 7:  Can I print inpage documents? 

Answer 
Yes, Printing can be carried out on any of the MS Windows compatible printers. You first need 
to choose the printer using Printer Setup dialog. 

FAQ 8:  Can I draw a line in the inpage document? 

Answer 
Yes, you can draw a line by Select the Line Tool from the Tools Bar. Now click with the CROSS 
cursor in the document Area and while keeping the mouse pressed, drag the mouse. The Ribbon 
shows the two end points of the line. 

FAQ 9:  Can I draw a line at any angle in the inpage document? 

Answer 
Yes, you can draw lines at any angle, keep the SHIFT key pressed while creating or resizing the 
line. 

FAQ 10:  Can I draw tables in the Inpage documents? 

Answer 
Yes, you can draw tables of any number of columns and rows by clicking on table from the insert 
menu. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the end 
of this module. 

1.  There are __________ number of user-defined keyboards in the Inpage. 

a.  2 b.  4 

c.  6 d.  8 

2.  Windows input languages can be switched by the short-cut-key command! 

a.  Alt + Control b.  Control +  Space 

c.  Alt + Shift d.  Control + Shift 

3.  Inpage input languages can be switched by the short-cut-key command! 

a.  Alt + Control b.  Control +  Space 

c.  Alt + Shift d.  Control +  Shift 

4.  Copy and Paste option is available in the __________ Menu. 

a File  b Edit 

c Format d Insert 

5.  Preferences options is available in the ___________ Menu. 

a File b Edit 

c Format d Insert 

6.  
___________command will replace the current occurrence of the found text. It will also find 
and select the next occurrence of the same word(s). 

a Find Text b Replace With 

c Replace and Find d Replace All 

7.  _____________Specify the gap between columns. 

a Margins b Direction 

c Gutter d Columns  
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8.  
__________is similar to Cut but the difference is that Copy does not delete the selected text 
or selected object(s) from the document. 

a Clear b Copy 

c Undo d Delete 

9.  Text to table and Table to text options are available in the ____________Menu. 

a File  b Edit 

c Insert d Format 

10.  Text to table option is only available when ____________. 

a Text is in the clip board b Text is selected 

c Table is selected d Table is in the clip board 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 c 

3 b 

4 b 

5 b 

6 c 

7 c 

8 b 

9 c 

10 b 
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Module 6: Manage E-mail / Internet 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Configure Email Account 

  Sort Out Email 

  Manage Address Book 

  Achieve Email Data 

  Perform Browsing 

  Download Data 

  Send and Receive Emails 
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Learning Unit 1: Configure Email Account 
 

Overview 

Email stands for electronic mail. It is like a message sending over the internet using 
email address. In this learning unit, you will learn how to configure internet email service 
in Microsoft Outlook software and how to send and receive email. After completion of 
this learning unit, you will be able to properly configure MS Outlook, send and receive 
messages and you will also be able to identify problems during configuration of MS 
outlook email.  

 

1. Configuring Email Account  

What is Email? 

Email stands for 'electronic mail'. It is used for sending Electronic message/Letter through internet. An email 
address is required to send or receive email, and that address is unique to the user. Email can be accessed in 
two ways, either from web browsers or desktop applications. Some companies provides facilty for email like 
yahoo, google,these are called email service providers. For using this facilty it is required to create an email 
address. 

 

Configuring Email Account Using MS Outlook:  

Hotmail.com is windows live email address which is created by microsoft 
corporation.For adding and configuring a windows live id / hotmail id just follow these 
steps: 

1. Open MS outlook application From MS Office. 
 

2. Enter user name, e-mail address, and password. 

To configure MS 
Outlook, an Email 
address must be 
created already. 

Remember 

Outlook 2010 is a 
personal information 
manager included in 
the Microsoft Office 
2010 suite, which is 
commonly used in 
the workplace. 

Outlook 2010 
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Entering Required Data in Outlook 

3. Click Next. 

4. A dialogue box will appear of configuration email.  

 

Configuring Outlook 

5. After completion of the configuration process click Finish. 

The tabbed Ribbon 
system was 
introduced in 
Outlook 2010 to 
replace traditional 
menus. The Ribbon 
contains multiple 
tabs, each with 
several groups of 
commands. 

Do you know! 
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Finish Configuring Outlook 

6. The account will be configured and the welcome screen will be appeared. 

 

Welcome Screen of Outlook 

This is the easiest way of configuring email using MS outlook. 

 

Adding an Account in MS Outlook: 

1. Start MS Outlook. 
 

2. Click on the File tab. 
 

3. In the Info category, click Account Settings, and then click Account Settings in the dropdown. 
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Account Settings of Outlook 

4. On the Email tab, click New. 

 

Adding an Account 

 

5. Click to select the Email Account option, and then click Next. 
 

6. In the Add New Account dialog box, to configure the new email account automatically, configure the 
following settings in the Email Account section under Auto Account Setup: 

 
7. In the Your Name box, type user full name. 

 
8. In the Email Address box, type e-mail address.  

 
9. In the Password box, type the password. 
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10. In the Retype Password box, retype the password, and then click Next to begin the Auto Account Setup 
process. 

 

Adding an Account 

11. Outlook will then try to automatically configure account. After successful configuration, the confirmation 
messages will appear that the account is created successfully. 

12. Click Finish, and then click Close to complete the account setup.  

 

Testing Email Configuration: 

If a problem occur during configuration of Outlook as shown in the picture below than it means that email is not 
configured successfully. It is necessary to configure Outlook manually.  

Some ISPs require 
the full email 
address to be 
entered into 
the User Name field 

Remember 
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Configuration Fails 

For manually configuration of Outlook mail follow these steps: 

1. Add New Account dialog box 
 

2. Click the Manually configure server settings or additional server types check box, and then click Next. 

 

Manually Configuration of Email 

3. Click Internet Email, and then click Next. 

If wanted Outlook to 
automatically enter 
email password, 
make sure that 
the "Save this 
password in your 
password 
list check box is 
selected. 

Remember 
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Manually Configuration of Email 

4. Click on More information button. 

 

More Information 

5. Select the Outgoing Server tab from the top of the new window that opens. 
 

6. Check the box for My outgoing server (SMTP) requires authentication and ensure that Use same settings 
as my incoming mail server is selected. 

 
7. Next, click the Advanced tab at the top of the window. 

Yahoo or Gmail id 
on Outlook needs 
manual 
configuration for 
setting incoming and 
outgoing ports. 

Remember 
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Check this Option 

8. Enter port 995 as the Incoming server (POP3) port and ensure that SSL is chosen from the Use the 
following type of encrypted connection drop-down box. 
 

9. Enter port 587 as the Outgoing server (SMTP) port and choose TLS from the drop-down box next to Use 
the following type of encrypted connection. 

 
10. Click the OK button to save settings. 
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Setting Properties 

11. After this a test email message will be send. If the test is successful, click the Close button. 

 

Test Account Settings 

 

12. The email will be configured successfully now. 
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Adding New Account Screen 

Now here a user can see configured email ids. 

 

Configured Emails 

 
 

Gmail uses 
Incoming port: 993 
and outgoing port: 
587 for outlook 
configuration. 

Do you know! 
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2. Sending and Retrieving Test Messages 

Sending and Retrieving Test Message: 

For testing newly configured email on outlook open MS Outlook. 

1. Click on New Email button on the left corner. 
 

2. Type the sender’s (it may be your second email id) email address for checking whether the emails are 
forwarded or not. 

 
3. Send and check the email on other email account. 

 
4. Also check if a test message is sent to the configured email address or not.  

 

Checking Test Email Send 

5. Now send an email form any id to check for whether the newly configured email account is receiving emails 
or not. 

 

Checking Test Email Received 
 

  

Adding a Gmail 
account will not 
import other Google 
services, such as 
your Gmail contacts 
or Google Calendar. 

Do you know! 
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  Learner’s Activity 

 Open MS Outlook 
 

 Configure Outlook.com /Hotmail account on MS Outlook. 
 

 Now add and configure a Yahoo id on MS Outlook account. 
 

 If a problem occur than configure it manually according to the given procedure in manual. 
 

 Check the email through send and receive emails using this email account. 

  



Module 6: Manage E-mail / Internet 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                   | 363 

Learning Unit 2: Sort Out Email 
 

Overview 

Sorting means arranging something in a way so that it can retrieve easily. MS Outlook 
emails can be sorted based on the Date, Account, Attachments, Flags, subjects and 
Size as per requirements for ease. In this learning unit you will learn how to sort email 
by the account through which they were received using various applications.  

After completion of this learning unit you will be able to sort out emails received from 
different accounts.  
 

1. Sorting Emails and its Benefits 

Sorting Out Emails: 

There are several features that can help manage and organize messages, one of them is sorting. There are many 
benefits of sorting emails in Outlook.   

 

Benefits of Sorting Emails: 

 

 If it is needed to find a particular email from a certain person than sorting is helpful in searching mails by a 
specific person. 

 If wanted to have emails sorted by date received with the most recent at the top than sorting is a best 
technique. 

 If it is needed to sort emails, received to a particular Account. 

 

Methods of Sorting Emails in Outlook:  

Outlook downloads email into the Inbox, which fills up inbox quickly. Finding what is 
needed when is needed it can become a frustrating task, but with a few easy-to-
implement sorting techniques, even the crowded Inbox can be handled. 

 

1: Click to Sort 

The click-a-header sort behavior in Outlook is probably a common method of sorting. With the Inbox (or any 
mail folder) open, simply click a column header (From, To, Subject, Received, and so on) to sort by the data in 
that column. Click a second time to toggle between ascending and descending order. 

Sort Mail by who it is From: 

If there is a mail in the folder there will be people’s names in the column. These names are the names of the 
people who have sent you email. 

 
1. If left click the From column name the mail will be sorted by name alphabetically in descending order. 

 
The Z’s will be at the top of the list and the A’s will be at the end of the list. 
 

By default, the 
messages are date 
wise sorted i.e. 
latest mail first. 

Do you know! 

Sorting is a 
technique for 
arranging data in 
ascending or 
descending order. 

Sorting 
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2. For sorting the mail by name in ascending order, left click the From column name again. 
 
Now the A’s are at the top of the list and the Z’s are at the bottom of the list. 
 

 
Sort Email by Subject: 

The Subject column is the next to the From column. 

 
1. Left click the Subject column label and the emails will be sorted in descending 
order. 
 
For multiple emails on the same date with the same Subject the last one received that 
date is at the top of the list. 
 
2. For sorting by Subject in ascending order, left click the Subject column label 
again.  

The emails are now sorted in ascending order with the A’s first and Z’s last. 

 

Sort Mail by Date Received: 
 

1. Left click the Received column label and the mail will be sorted in descending with the most recently 
received mail at the top of the list. 
 

2. Left click the Received column label again and the mail will be sorted in ascending order with the most 
recently received mail at the top of the list 

. 

Sort Mail by Account Name: 
 

1. Left click the Account column label and the mail will be sorted by Account name in descending order. 
 

2. Left click the Account column label again and the mail will be sorted by Account name in descending order 

Sorting mail by the column labels in Folder view is an easy way to find emails based on the From, Subject, 
Received and Account columns. 

 

Sorting Emails by the Account, Received: 

For sorting emails by the account through which they were received: 
 

1. First click on view tab. 
 

2. Then click on View settings. 
 

  This button is 
used from the 
column for sorting 
data in ascending or 
descending order. 

Do you know! 
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View Settings  in Outlook 

 
3. A dialogue box will appear. Click on sort button 

 
4. Another dialogue box will appear here the properties for sort can be set. 

 
5. Click on first drop down menu select the From and then click Ok. 

 

Account 

Then all emails in the selected folder are sorted by email senders automatically. 
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Sorted Emails in Ascending Order through Account 
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 Learner’s Activity 

1. Sort emails in Ascending Order  

 Data Wise 

 Subject Wise 
 

2. Sort emails in Descending Order 

 By Account Name 
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Learning Unit 3: Manage Address Book 
 

Overview 

Managing address book is very necessary in MS Outlook. The Microsoft Outlook 
Address Book is a container that includes the main Contacts folder and any others 
added. This learning unit covers the procedure for sending email using addresses in 
address book, copying, customizing, moving, importing and exporting contacts in 
address book, setting up a personal address book and importing contacts from 
personal address book to contacts in outlook. After completion of this learning unit you 
will be able to understand the functionality of address book in MS Outlook.  

1. Sending a Message Using Address Book 

For sending a message from names in MS outlook do the following 

 

Sending Email 
 
1. In MS Outlook Mail, click  on the Home tab 
2. In the New group, click New E-mail. 
3. A window will be appear.  

 

Creating New Email in Outlook 

 
4. Click on the Address Book a dialogue box will be appear. 

(Here the receiver’s email accounts, Cc. and Bcc. email Accounts can be added from the Address book 

The Outlook 
Address Book is a 
collection of address 
books or address 
lists, created from 
Outlook contact 
folders.  

Outlook Address 

Book 

Cc means carbon 
copy and Bcc 
means blind 
carbon copy. For 
emailing, you use 
Cc when you want 
to copy others 
publicly and Bcc 
when you want to do 
it privately. Any 
recipients on the 
Bcc line of an email 
are not visible to 
others on the email. 

Do you know! 
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Adding Email Account from Address Book 

 
5. Click on the first text field and select an account from the address book who will receive email. 

 
6. Click on the second field Cc. to add an email account. 
 
7. Click on third field Bcc. To add an email account. 
 
8. Click on OK button. 
 
9. Then enter the subject of email, write the text in body of email attach files if any and click on Send button at 

the top left corner of the window. 

      The mail will be sent. 

 

2. Specifying the Default Address Book 

Sometimes address book cannot be found due to the default selection of address book. 
You can change the default address book. 

To change the default Address Book, do the following: 
 
1. On the Home tab, in the Find group, click the Address Book or click Ctrl+Shift+B). 

 
2. In the Address Book dialog box, Click on Tools than Options to open the 

Addressing dialog box. 

You must exit and 
restart Outlook to 
use the address 
book that you 
added. 

Remember 

You can also open 
the Address Book by 
clicking Address 
Book on the Tools 
menu when you are 
sending an email. 

Remember 
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Address book Dialogue Box 

 
3. From the drop-down list labeled when opening the address book, show this address list first, select the 

desired address book. 
 

4. Select Custom option then select the desired address book which is wanted to show by default in Outlook. 
 
5. Select the option” Choose Automatically” and click OK.  

 

 

Addressing Dialogue Box 

 

The Display Name 
is created based on 
how you type the 
contact's name in 
the Full Name box. 

Remember 
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3. Copying Contacts from Personal Address Book to Outlook 

Outlook automatically updates its address book whenever it is updated / upgraded to latest version otherwise it 
can be imported manually. 

To import address book manually follow these steps: 

1. Start Outlook 2010. 

2. Click the File menu. 

3. Click Open, and then click Import. The Import and Export Wizard opens.  

4. Click Import from another program or file, and then click Next. 

5. Click Personal Address Book, and then click Next. 

6. Click Browse, locate the Personal Address Book that wanted to import, and then click OK. 

7. Click Next. 

8. Click Finish to import the Personal Address Book. 

 

4. Changing Appearance of Names in Address Book 

The appearance of address name can be changed by selecting the display format of 
last name, first name.  

 

Change to Last Name, First Name Format: 

A user can change the name format for the contacts in the main Microsoft Outlook 
Contact folder or any contact folders that is created. These folders are listed in the 
Outlook Address Book. However, you cannot change the name format for names in the 
Global Address List (GAL). 
  

1. Click the File tab. 

2. Click Account Settings, and then click Account Settings. 

3. On the Address Books tab, in the Name list, click Outlook Address Book, and then click 
Change. 

4. Under Outlook Address Books, click the address book that is wanted to change the contact 
display format for.  

5. Under Show names by, click File As (Ali, Khan). 

6. Click Close on the Microsoft Outlook Address Book and Account Settings dialog boxes. 

7. Exit and restart Outlook. 

 

To display this 
address book, you 
must use a Microsoft 
Exchange Server 
account. The GAL 
contains the names 
and e-mail 
addresses of 
everyone. 

Global Address 

List (GAL) 
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Change Individual Contacts to Last Name, First Name Format: 

After changing the name format for existing contacts in the Outlook Address Book, the change applies to future 
entries that are created. However, if all the contacts are not updated you must change the format for each contact 
by following steps: 

1. In Contacts, double-click a contact that does not appear in the last name, first name format. 

2. In the open contact, in the File as box, click the name in the last name, first name format.  

3. On the Contact tab, in the Actions group, click Save & Close. 
4. Repeat for each contact not displayed in the correct name format. 

 

5. Including or Excluding Contacts Folder from Address Book 

 

Including Contact to an Address Book: 

1. On the Tools menu, click Account Settings. 

2. On the Address Books tab, click New. 

3. You are prompted to select one of two types of address books. To add the type of address book that you 
want, follow these steps:  

 

Adding an Address Book by Using an Internet Directory Service (LDAP): 

1. Click Internet Directory Service (LDAP), and then click Next. 

2. In the Server name box, type the name of the server that was provided by your Internet service provider 
or system administrator. 

3. If the server that you specified is password-protected, select the This server requires me to log on 
check box, and then type your user name and password. 

4. Click More Settings. 

5. Under Display Name, type the name for the LDAP address book that you want to be displayed in the 
Address Book list in the Address Book dialog box. 

6. Under Connection Details, type the port number provided by your Internet service provider (ISP) or 
system administrator. 

7. Click the Search tab, and then change the server settings as needed.  
The Search Time-Out setting specifies the number of seconds that Outlook spends searching the LDAP 
directory to resolve names in a message. You can also limit the number of names listed in the Address 
Book after a successful search for a name. 

8. Under Search Options, if the Search base box is empty, type the distinguished names that were 
provided by your administrator. 

9. Click OK, click Next, and then click Finish. 
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Add an Additional Address Book 

1. Click Additional Address Books, and then click Next.  

2. Click the address book that you want to add, and then click Next. 

 

Removing an Address Book: 

1. On the Tools menu, click Account Settings.  

2. On the Address Books tab, click the address book that you want to remove. 

3. Click Remove. 

4. Click Finish. 

 

6. Moving Contacts from one Contact Folder to another  

 

Transferring contacts between Outlook and other mail account: 

To Import contacts from yahoo mail to Outlook, follow these steps: 

1. Log on to yahoo mail account. 

2. In the left column, click Contacts. 

3. At the top of the contacts section, click More actions, and then click Export. 

4. Under which contacts do you want to export, click a contact group or All Contacts. 

5. Under Which export format, click Outlook CSV (for importing into Outlook or another application). 

6. Click Export. 

7. When prompted to download the export file, click Save. 

8. Choose a location on computer to temporarily save the file. The default file name is google.csv. Click Close. 

9. Go to Outlook. 

10. Click the File tab. 

11. Click Open. 

12. Click Import. 

13. Click Import from another program or file, and then click Next. 

14. Click Comma Separated Values (DOS), and then click Next. 

15. In the Import a File box, browse to find the file downloaded in step 8, and then double-click the file. 

You can delete this 
export file after your 
contacts are 
imported into 
Outlook. 

Remember 
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16. Click one of the following: 

 Replace duplicates with items imported  

 Allow duplicates to be created  

 Do not import duplicate items  

17. Click Next. 

18. In the folder list, click the contacts folder where wanted the imported contact information to go, and then 
click Next. 

19. Click Finish.  

 

Exporting Contacts from Outlook to other mail account: 

Before exporting contacts from Outlook, it is helpful to understand the difference between the Outlook Address 
Book and Outlook Contacts. Both are part of Outlook. However, the Address Book is a compilation of the different 
address lists that might store in Outlook, such as LDAP Internet directories, the global address list (GAL), or other 
third-party address books. Contacts are only one of the address lists included in an Address Book. Only contacts 
can be exported directly from Outlook to yahoo mail or any other configured email account. 

1. Click the File tab. 

2. Click Options. 

3. Click Advanced. 

1. Under Export, click Export. 

1. In the Import and Export Wizard, click Export to a file, and then click Next. 

2. Click Comma Separated Value (DOS), and then click Next. 

3. In the folder list, click the contacts folder wanted to export, and then click Next. 

4. Choose a location on computer to temporarily save the file. 

5. Type a name for the exported file, and then click Next.  

6. Click Finish. 

7. Setting Up Personal Address Book as the Place to Store Addresses  

 

In case of large Contact List, you can easily create a personal Address Book from these entries. 

1. Right click over the Contact List (do not open) 
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Adding Personal Address Book 

2. Select Properties 
 

  

Adding Personal Address Book 
 

1. Click Outlook Address Book tab. 

When you add or 
edit a contact 
record, the personal 
address book is 
automatically 
updated. 

Remember 

NK2Edit is a 
downloadable 
Windows-based 
application that 
enables users to 
revise or modify 
their device's 
'AutoComplete' 
function to suit their 
personal 
preferences or 
needs. 

Do you know! 
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2. Check the "Show this folder as an e-mail Address Book" option. 
3. Type in the name for this new Address Book. 
4. Click Apply 
5. OK to save the settings 

 
Now a new Address Book list that will show up when search for email names/addresses. 

1. Click New E-mail 
2. Click on To button 
3. From the Address Book list. 
4. Click Personal List option. 
5. Search for names in the List. 

 

 

Adding New Address List 

8. Importing Contacts from a Personal Address Book to Contacts 

NK2Edit allows to easily importing the email addresses stored in address book of Outlook directly into NK2 file.  

In order to use this feature  

1. Go to Action Tab in NK2Edit than Add Records from Address Book, or simply press Ctrl+F6. The address 
book window of Outlook will be displayed:  
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Opening Address Book 

 

2. In the 'Search' section, choose 'Name Only' to view all addresses. 

or alternatively, choose 'More Columns' and then type a search string. 
In the 'Address Book' combo-box, choose the desired address book.  
For non-Exchange profiles, only choose 'Contacts'. For Exchange profiles, other address books may also 
be available, like 'Global Address List' and 'Personal Address Book'.  

3. After choosing the desired address book, select multiple addresses to add into NK2 file, by holding down 
the Shirt or Ctrl key and selecting the desired addresses with the UP/Down arrow keys.  
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Searching Contacts by Name 

4. Press the 'To' button in order to add the selected addresses to the list. 
 

 

Adding Selected Addresses to the List 

5. After that, press the 'Ok' button, and then the addresses list will be added into  current NK2 file:  
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Adding Selected Addresses to NK2 File 
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 Learner’s Activity 
 

 Import contact list of your yahoo account to Contacts folder. 
 

 Create a personal address list in contacts. 
 

 Send email to anyone of the contacts of the list. 
 

 Delete any of the contacts list from the contacts folder.  
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Learning Unit 4: Archive Email Data 
 

Overview 

An archive can include a simple list of files or files organized under a directory or catalog structure depending on 
how a particular program supports archiving. In this learning unit you will cover learn archiving emails for 
compressing the size of main personal folder and data file (PST) small and manageable. After completion of this 
learning unit you will be able to create archive of emails in outlook at regular basis for back up and future use 
and retrieving of emails from this archived file. 
 

1. Archiving Old Mails in Outlook & Keeping Main PST File Small Using Auto Archive 

Microsoft Outlook allows individua  ls to archive items to free up space in their inbox. They are saved in Outlook 
data file format, or ".pst " it can either set up an automatic archive feature or manually archive emails and items 
regularly.  

For achieving emails automatically do the following. 

 
1. Click on the file tab. 
2. Choose the "Options" button. 
3. Click "Advanced" and go to "AutoArchive Settings." 

 

Auto Archive Emails 

 
 

4. A dialogue box will be open. 
5. Choose the frequency with which wanted to run AutoArchive. 
6. Type a number in the section that says "Run AutoArchive every__ days." 

        If wanted to turn AutoArchive off, type a zero for the number of days. 

An archive is a 
collection of 
computer files that 
have been 
packaged together 
for backup, to 
transport to some 
other location, for 
saving away from 
the computer so that 
more hard disk 
storage can be 
made available, or 
for some other 
purpose. 

Archive 
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Auto Archive Emails 

 
7. Choose additional options. For example, 

 Choose to delete the archived messages automatically. 

 Choose prompt before “Auto-archive Runs” to prompt the user when it is time to run.  

 

Auto Archive Emails 
8. Enable the box to show archive folder in folder list. This will allows accessing archived items more quickly. 

The pst-file is also 
known as Personal 
Folders and Outlook 
Data File. 

Remember 
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Auto Archive Emails 

 
9. Decide how old the items have to be in order to be archived. Choose this under "Clean up items older than 

months." 

 

Auto Archive Emails 

 
10. Decide whether it is wanted to apply these settings to all folders. Check the box, if so. 

Auto Archive, which 
is turned on by 
default, 
automatically moves 
old items to an 
archive location at 
scheduled intervals. 

Do you know! 
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Auto Archive Emails 

 
11. Select the location where wanted the archived items to be stored. Use the browser to change from the 

default file. 

 

Auto Archive Emails 
 

12. Click "OK" to begin Auto-Archive program. It will automatically run according to the number of days specified 
by the user. 

 
 
 
 

Upgrading to 

Outlook 2010 or 

Outlook 2013 will 

not move your PST-

files to the new 

location. 

Remember 



Module 6: Manage E-mail / Internet 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                   | 385 

2. Creating Archive of Old Messages Separate from Main PST File 

1. Click on the "Archive" option. 
2. Select the archive this folders and all sub folders, in the dialog box. 

 

 
 

Creating Archive Mails 
 
3. Choose the folder would like to save and archive in the browser window. 
4. Choose a date when Outlook will decide items should be archived. 

 

 
 

Creating Archive Mails 
 
5. Select the location of the archive file. 
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Creating Archive 
 
6. Click OK. The Archive will be created. 

 

 
 

Archive Mail Folder 
 

3. Retrieving Messages from an Archived PST File after Closing 

There are 3 ways to retrieve the data from archives. 

 Moving individual items from a .pst file into their original folder or a new one. 

 Copy the e-mail back to the original folder.  

 Copying e-mail to a new folder. 

 
Opening a .Pst File: 

 
1. On the File tab, click Open. 
2. Click Open Outlook Data File (.pst). 

 

Outlook 
automatically 
creates another 
archive file for items 
in the folder and 
location specified. 

Do you know! 
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Importing PST File 
 

3. Choose the PST file and click OK. 
4. The folders from the PST file will now appear in the folder sidebar.  

 

 

Archive Emails Folder 

1. Retrieving / Copying all Archived Items from a .PST File Back into their Original 
Folder:  

 
1. On the File tab, click Open. 
2. Click Import. 
3. Click Import from another program or file. Click Next. 
4. Click Outlook Data File (.pst). Click Next. 

 

Never try to open a 
pst-file by 
overwriting an 
existing pst-file. 
Doing so will corrupt 
your mail profile and 
could lead to 
countless of “weird” 
issues. 

Remember 
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Importing Archived Emails 

 
5. Click Browse and choose the file wish to import. 
6.  Click the folder to import from. Select the Include subfolders check box if the folder that is importing has 

subfolders wanted to import as well. 
7. Select one of the destination options: 

 Import items into the current folder - this imports the data into the folder currently selected. 

 Import items into the same folder in - this imports the data into the destination folder of the same 
name as the source folder, e.g., from Inbox to Inbox. 

8. Click Finish.  

 

Importing Archived Emails 
 

2. Moving Individual Items from a .PST File into their Original Folder or a New One 

 
1. On the File tab, click Open. 

While making a copy 
of the pst-file will 
effectively backup 
your Outlook data, it 
will not include any 
mail account 
configuration 
settings (mail 
profile), templates or 
signatures. 

Do you know! 



Module 6: Manage E-mail / Internet 

Teaching and Learning Material: Information Technology (Computer Operator)                                                                   | 389 

2. Click Open Outlook Data File (.pst). 
3. Choose the PST file and click OK. 
4. The folders from the PST file will now appear in the folder sidebar. 
5. Click the folder containing the items want to move. 
6. Select the items want to move, and then drag them into their original folders in the Folder List.  
 

 

Moving Archived Mails to other Folder 

3. Copying all Archived Items from a .PST File Back into a New Folder: 

In Outlook, create a new folder to copy the archived items to. 
1. On the File tab, click Open. 
2. Click Import. 
3. Click Import from another program or file. Click Next. 
4. Click Outlook Data File (.pst). Click Next. 
5. Click Browse and choose the file wanted to import.  
6. Select Import items into the current folder.  
7. Click Finish. 

 

  

If you receive an 
error message that 
"the .pst is already in 
use," there may be 
some size or 
corruption issues 
with the .pst file. 

Remember 
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Learner’s Activity 

 Create an Auto archive of your emails in outlook. 
 

 Create an archive of emails manually. 
 

 Retrieve emails using different archiving methods. 
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Learning Unit 5: Perform Browsing 
 

Overview 

A search engine is a software program available through the internet that searches documents and files for 
keywords and returns the results of any files containing those keywords. In this learning unit you will learn how 
to use search engines to browse the data such as pictures, books, PowerPoint presentations and articles. After 
completion of this learning unit you will be able to perform browsing in manner that exact information is browsed 
and data can be fetched. 
 

1. Search Engines  

A Web Search Engine is a software program that is designed to search for information 
on the World Wide Web. The search results are generally presented in a line of results 
often referred to as search engine result pages (SERPs). The information may be a mix 
of web pages, images, and other types of files.  

There are 3 parts to a search engine: 

1. The search engines use robots (also known as spiders) to search the internet 
for websites. 

2. The results of the spiders' travels are put in a database which is then indexed 
based on words found and where these words were found. 

3. The users of search engines search for words or phrases related to what they are looking for and the 
search engine index returns related sites. 

 

Different Types of Search Engines:  

Although the term "search engine" is often used to describe crawler-based search engines, human-powered 
directories, and everything in between. 

Search engines are 
a program that 
search documents 
for specified 
keywords and 
returns a list of the 
documents where 
the keywords were 
found. 

Search Engine 

A browser is a 
software application 
used to locate, 
retrieve and display 
content on the World 
Wide Web, including 
Web pages, images, 
video and other files. 
i.e. Internet Explorer 

Web Browser 
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Crawler-Based: 

Crawler-based search engines such as Google, Yahoo and Bing, compile their 
listings automatically. They "crawl" or "spider" the web and people search through their 
listings. 

Crawler-based search engines are good when you have a specific search topic in mind 
and can be efficiently search the relevant topic. However, when the search topic is 
general, crawler-base search engines may return with hundreds of thousands of 
irrelevant responses to simple search requests, including lengthy documents in which 

your keyword appears only once.  

 

Human-powered directories: 

Such as the Yahoo Directory, open directory and look Smart, depend on human editors to create their listings. 
Webmasters submit an address, title, and a brief description of their site, and then editors review the submission. 

 

2. Browsing the Data Using Keywords 

Keyword: 

Keywords are words or phrases that describe content. They can be used as 
metadata to describe images, text documents, database records, and Web pages. A 
user may "tag" pictures or text files with keywords that are relevant to their content. 
Later on, these files may be searched using keywords, which can make finding files 
much easier.  

 

 

Browsing data using keywords: 

Keywords are used on the web in two different ways: 

 As search terms for search engines. 

 Words that identify the content of the website. 

 

 

Search Engine Search Term: 

Whenever you search for data using a search engine. You type keywords that tell the search engine what to 
search for. For example, if you are searching for Mobile phones, you may enter "Mobile Phones" as your 
keywords. The search engine will then return Web pages with content relevant to your search terms. The more 
specific keywords you use, the more specific and useful the results will be. Therefore, if you are searching for a 
mobile of specific company, you may enter something like "Samsung Mobile Phones" to get more accurate 
results. 

 

A word used by a 
search engine in its 
search for relevant 
Web pages is known 
as Keyword. 

Keyword 

There are many 
other web browsers 
like Mozilla Firefox, 
Opera, Google 
Chrome etc. 

Do you know! 
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Web Page Description Term: 

Keywords can also describe the content of a Web page using the keyword meta tag. The purpose of the keywords 
meta tag is to help search engines identify and organize Web pages. 

 

3. Performing Browsing On Different Search Engines  

With a few basic search strategies, you can find almost anything online. It doesn't matter if you're using Google, 
Yahoo!, Bing, or some other type of search engines; most of the techniques are same.  

Google is most common search engine on the Internet. 

Browsing using the Google: 

The steps are used to search data using Search Engine. 

1. Go to Google's homepage at Google.com. From there, conducting a search is straightforward. Just type 
your search terms in the box, then click the Google Search button or press Enter on your keyboard. 

 

2. The web page will be open with the expected result. 
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3. After you’ve searched, you’ll get a page full of results. Some of these will be matching pages from across 
the web. You might get news or image results mixed in, as you can see below: 

 

The read links will 
be shown in Purple 
color while link that 
you did not check 
will be displayed in 
Blue. 

Important 
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4. Google doesn’t know exactly what you want, when you enter keywords, the results you get are its best 
guess. There are ways you can help it make better guesses. At the lower part of page you can see the 
options of related searches where you can get the best Keywords for your search. 

 

 

4. Perform Browsing of Different Objects  

Different catagories are available to search some specific type of data as images, power point slides books 
etc. 

In the Google search Engine you can navigate between different types of contents using the option available on 
the upper side of the search bar. 
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1. To search the images of “Cats” write the keyword Cat in the Search bar and click the Images button on 
the upper side of search Results as shown in the picture above. 

 

2. Similarly you can search videos, News and many other objects using the tabs.  

To search the powerpoint slides follow these steps: 

1. Type the keywords that you want to search out on web and along with keywords, type “.ppt” that will 
show the type of search we want to do. 

2. In the result, the mostly searches will be displayed in the powerpoint format as shown in the picture 
below:  
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3. Click on the links to get the powerpoint slides online. 

Similarly any type of data can be search out through the buttons available on the Google search engine. 
 

  

The document with 
specific format can 
be search through 
the Advance Search 
option on the main 
page of the 
Goole.com. 

Remember 
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 Learner’s Activity 

 Browse the Pictures of Computer Parts on the Internet. 
 

 Search the PowerPoint Slides on the Topic “Storage Devices”. 
 

 Search for the Articles on the Child Labor. 
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Learning Unit 6: Download Data 
 

Overview 

When you search out the data on the web you must want to copy the files from the web to the computer. In this 
learning unit you will learn that what is downloading and its types and how data can be save from the internet to 
the computer with some specific path. After completion of this learning unit you will be able to download data 
from the internet with the proper precautions for downloading. 

1. Downloading and Its Different Types  

 Download: 

In computer network downloads means to receive data from the remote system to the 
local computer. The most commonly downloaded files are software, updates, game, 
demos, music, images, video files and documents. 

While downloading files and viewing websites, you’ll meet up with many file formats. 
Most are common and used frequently, others required special programs to open or 
use. Here, we have a list of the file types, along with the applications. 

1. .AVI, .MP4 (Audio/Video sound file format.  
2. .EXE Executable Files 
3. .DOC/.DOCX Microsoft Word Document. 
4. .JPG /.JPEG/.GIF File format most commonly used for Pictures. 
5. .PDF Portable Document Format 
6. .RAR/.Zip This is a compressed file format similar to the popular .zip format. 
7. .TXT file The most basic of files, it’s just some text. 

2. Saving a File with Proper Path  

If you want to save a file from the internet to a computer in the required folder, follow these steps: 

1. Right Click on the required file and select Save Target As / Save Image As option. Or when it prompts 
you for a download click the browse button to find a desired location of file where it is saved. 

2. When the next window pops up, you can see where the file has already been chosen to be downloaded. 
You can easily change this download path by finding your folder or the folder that you want to place the 
download in. Start from the top and click on My Computer. This shows all possible locations to save a 
file. When you find the proper location, click the Accept or Save button in the corner of the window. 

3. The file will be saved in the destination folder. 

3. Step Wise Procedure of Downloading Data  

 
The method you need to use to choose where the downloaded file is saved is depends on which internet browser 
you are using. 

For example if you want to download a program from the internet and you are using the Mozilla Firefox than 
follow these steps to save the file with the required location on your computer. 

1. Write search words on the search engine about which topic you want to download data or type the 
Website name from where the data is required. 

 

After downloading, 
to open the Specific 
type of file, 
softwares related to 
these files types 
must be installed on 
Computer. 

Do you know! 

Downloading is the 
transmission of data 
from one computer 
to another computer 
of from web page to 
another computer. 

Downloading 
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2. Click on the program that you want to download. The Next page will be open with the download option. 

 

3. Click on the Download Latest Version Option. The small window will open to ask for save file. 

 

4. Click on the Save file. The file will be automatically downloaded and after completion of downloading a 
green arrow will be shown on the upper right side of the Browser as shown in the picture below. Click on 
the Arrow to see your download file  
 

By Default the file 
will be saved in the 
Download folder 

Remember 
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5. Click on the downloaded file to open it. To open the folder where file is located, right click on the file and 
click Open Containing Folder. 

To change the destination folder of the downloaded file, follow these steps: 
 

1. Open Mozilla Firefox and click on the Open Menu button on the upper right side of the page 

2. Click on the Option Button to change setting. 
 

 
 

3. On the Download tab Click the browse button to change the location where file will be automatically save. 
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4. Close the window. Changes will automatically apply. 
 
 

4. Precaution taken while Downloading  

One of the easiest ways malware, spyware, and adware can access your computer is through downloads; 
therefore, it's important to take precautions when downloading content to your computer, whether it is a software 
program, the latest pop song, or a cool game. There are two things that provide the best defense against infected 
downloads: your computer's security programs and your own judgment. This is why it's important to make 
sure all of your security programs are up to date and that your firewall is turned on. 

Download only from trusted sites: 

You should only download from well-established sites you trust. CNET is one reputable site where you can 
download files that have been checked for malware, spyware, or adware. 

 

Save downloads: 

It is best that when prompted you must save a file on hard Disk instead of Running it. This gives your security 
programs time to check downloads before you open them. 

 

Check license agreements and privacy statements: 

Before installing any download, read the license agreement and privacy statement carefully to make sure you 
are not agreeing to allow spyware or adware.  

 

Avoid illegal downloads: 

When you illegally download copyrighted material like music, books, software, games, and videos, you are 
violating federal laws, which can lead to fines and even jail time. 

You should be aware that law agencies do respond to the misuse of copyrighted material on the Internet, so it is 
best to obey the laws. 
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 Learner’s Activity 

 Download and install “Google Chrome” on your Computer. 
 

 Download “Media Player Classic “software on the Desktop. 
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Learning Unit 7: Send and Receive Emails 
 

Overview 

It is important to learn sending emails and how to deal with the newly received emails 
in outlook. In this learning unit you will learn how to send and Receive emails with 
proper precautions. After completion of this learning unit you will be able to send and 
receive emails. 

1. Sending and Receiving Emails Using Outlook 

 
Sending an Email: 
 
1. Click on New Email command on the Home tab Ribbon. 
2. A window will appear.  

 

 
 
3. Click on the “TO” button and select the Recipient’s account from the address book or type and check it 

manually. 
4. Click on Cc. button to enter the email account of the person to whom wanted to send a carbon copy of email. 
5. Click on Bcc. Button to enter email account of the person to whom wanted to send a Blind carbon copy of 

email. 
6. Enter the subject of email in the subject text field. The subject must be concise and clear. 
7. Enter the text in the body of email. After entering the body text if there is spelling mistakes in the text than 

right click on the text or press F7 and select the appropriate word. 
8. If there is any attachment to send with the email then click on attach file and browse the file from its location 

and attach it with the email. 
9. After completion of these steps click on Send button or  
10. Click CTRL+ ENTER to send using keyboard. 

 
 
 

You can also press 
CTRL+ENTER to 
send an email using 
keyboard. 

Do you know! 

CTRL+N is the 
keyboard shortcut 
for opening a new 
email. 

Remember 
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Sending And Receiving Emails Automatically: 
 
The emails can send and receive automatically. To schedule Auto Send/Receive in Outlook 2010,  
 
1. Click on the File tab then Options. 
2. Click on Advanced and scroll down to Send and receive and click on the Send/Receive button. 

 

 
 

Send/Receive Emails 
 
3. In the Send/Receive Groups window under Setting for group “All Accounts” check the box Schedule an 

automatic send/receive every…minutes. It is set to 30 minutes by default and it can change the minutes 
to. If the user busy and wanted to keep up with the messages go as low as every one minute. 
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Send/Receive Emails 
 

4. It can also get to the Send/Receive groups by selecting Send/Receive tab on the Ribbon and then Define 
Send/Receive Groups. 

 

2. Sending Emails Using Keyboard in Outlook  

1. Use Alt+Tab to switch to Outlook.  
2. If looking at anything other than one of mail folders (like Calendar or Contacts), 
hit Ctrl+Shift+M to open a new mail message, otherwise just hit Ctrl+N. 
3. Now this is a blank email, with cursor placed in the To: field. Type the recipient’s 
name (and if Outlook is connected to Microsoft Exchange Server and emailing 
somebody in organization, type their name and hit Ctrl+K, which will verify their 
address). 
4. Use the TAB key to navigate between the CC: BCC: and Subject fields, filling 

in as necessary. 
5. Hit TAB to enter the main text area of the email, type the body of message. 
6. Use the TAB key to navigate, making changes as needed. 
7. Once you're ready to send, hit Ctrl+Enter. 

3. Using Spell Check and Attachment 

 
Outlook 2010 has a built-in proofreading feature which can check emails for spelling & grammar mistakes before 
you send them. To enable automatic spelling and grammar mistake option follow these steps: 

1. Launch Outlook 2010 and On File menu, click Options.  
 

By Default automatic 
spelling & grammar 
mistakes option is 
disabled in MS 
Outlook. 

Do you know! 
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2. This will open Outlook Options dialog, from left sidebar. 
3.  Click Mail from main window. 
4. Under Compose messages section, enable Always Check spelling before Sending option.  
5. Click OK in Outlook Options window. Now before sending emails, Outlook will always perform a spelling 

check. 

To Invoke the 
Spellcheck utility 
use F7 key. 

Remember 
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Adding Attachment:  
 
Files can be attached to an email message. Other Outlook items, such as messages, contacts, or tasks can be 
added with messages that you send. 

1. Create a message, or for an existing message, click Reply, Reply All, or Forward.  
2. In the message window, on the Message tab, in the Include group, click Attach File.  

 

3. A dialogue box will be appeared as shown in picture below. Choose the path where file is located, select 
the  file and click the insert button 

While composing a 
message, you can 
also drag files from 
folders on your 
computer and drop 
them on the 
message window. 

Do you know! 
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4. File will be attached. Now mail is ready to send. Click on the Send Button. 
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 Learner’s Activity 

 Create a New email. 
 

 Enter the Recipient’s account from the address book. 
 

 Enter Cc. account in Cc. field. 
 

 Enter the text in in the body and check the spellings and grammar mistakes. 
 

 Add an attachment with the mail. 
 

 Configure the Send and Receive emails automatically after 10 minutes. 
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Summary of Module 

 An email is an Electronic mail that sends and receives messages electronically. Email can be accessed 
in two ways, either from web browsers or desktop applications. 
 

 Sorting means arranging something in a way so that it can retrieve easily. In Ms Outlook emails can be 
sorted so that searching any specific email become easy. Emails can sorted based on the Date, Account, 
Attachments, Flags, subjects and Size. 
 

 The Microsoft Outlook Address Book is a container that includes the main Contacts folder and any others 
added. It’s used most often when click the To button on an open message. 
 

 An archive email is a collection of computer files that have been packaged together for backup, to take 
them to some other location, for saving away from the computer so that more hard disk storage can be 
made available, or for some other purpose. 
 

 A web browser is considered a software application that allows people to access, retrieve and view 
information on the internet.  The information that may be “browsed” can be in the form of text content on 
a web page, an image, video, audio etc.   The most popular web browsers currently in use are Firefox, 
Google Chrome, Internet Explorer, Opera and Safari.   
 

 The main purpose of a search engine is to search for information on the Internet.  They are software 
programs that search for websites based on keywords that the user types in. 
 

 Downloading Means copying a file from a remote server computer to local computer. Using browser a 
user can download files from the main servers to their computer. 
 

 Sending and Receiving emails automatically using outlook can be configured so that emails can be send 
and receive at the time when the user is busy. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is an Email Address?? 

Answer 
An email address is a unique address that is required to send or receive email, and that address 
is created by the user itself. 

FAQ 2:  What are the methods of sorting emails in outlook? 

Answer Emails can be sort by mails received from, sort by Date, Sort by subject, sort email account. 

FAQ 3:  What is address book? 

Answer 
The Outlook Address Book is a collection of address books or address lists, created from Outlook 
contact folders. 

FAQ 4:  What is an archive? 

Answer 
An archive is a collection of computer files that have been packaged together for backup, to 
transport to some other location, for saving away from the computer so that more hard disk 
storage can be made available, or for some other purpose. 

FAQ 5:  What is the difference between search engines and browsers? 

Answer 

A browser is a software program installed on computer locally. There are many browsers such 
as Internet Explorer, Firefox, Safari, and Opera, etc. A browser is used to access various 
websites and web pages. A search engine is also a software program that searches for some 
particular document when specific keywords are entered by the user like google search yahoo 
search etc. 

FAQ 6:  What is downloading? 

Answer Downloading a file means copying a file from the internet to the computer. 

FAQ 7:  What is POP3 server in outlook? 

Answer 

Post Office Protocol 3 (POP3) servers hold incoming e‑mail messages until you check your 
e‑mail, at which point they're transferred to your computer. POP3 is the most common account 

type for personal e‑mail. Messages are typically deleted from the server when you check your 

e‑mail. 

FAQ 8:  What is IMAP server? 

Answer 

Internet Message Access Protocol (IMAP) servers let you work with e‑mail messages without 
downloading them to your computer first. You can preview, delete, and organize messages 

directly on the e‑mail server, and copies are stored on the server until you choose to delete them. 

IMAP is commonly used for business e‑mail accounts. 

FAQ 9:  What is SMTP server? 

Answer 
Simple Mail Transfer Protocol (SMTP) servers handle the sending of your e‑mail messages to 

the Internet. The SMTP server handles outgoing e‑mail, and is used in conjunction with a POP3 

or IMAP incoming e‑mail server. 

FAQ 10:  Where archive files located? 

Answer 
The location of the archive Outlook Data File (.pst) varies depending on the version of Microsoft 
Windows you have on your computer when you create the archive. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  
One of the biggest changes to Outlook 2010 from previous versions is the addition of the 
____________. 

a.  Ribbon b.  View pane 

c.  Quick Access toolbar d.  Office button 

2.  
You'll navigate to commonly used features in Outlook like Print Preview and Help from 
___________________. 

a.  the File menu b.  Backstage view 

c.  the Navigation pane d.  None 

3.  Which one among the following can only be done successfully if Outlook has online status: 

a.  Creating an appointment b.  Creating an event 

c.  Scheduling a meeting d.  All 

4.  You can add existing contacts to an email message by _________________. 

a.  clicking To: in the Compose window b.  using the Address Book 

c.  typing a contact's name d.  B, C both 

5.  If you want to reply to a group of people, click the _____________ command. 

a.  Reply b.  Reply to All 

c.  Forward d.  Signature 

6.  Most folders you create will be nested within the ___________ folder. 

a.  Drafts b.  Inbox 

c.  Deleted items d.  Outbox 

7.  Before you can import contacts to Outlook, you'll need to______________. 

a.  sync them from your network b.  export them from another email client 

c.  upload them to the cloud d.  None 



Module 6: Manage E-mail / Internet 

414 |                                                                   Teaching and Learning Material: Information Technology (Computer Operator) 

8.  
If you want to send messages to multiple people at the same time, you can create a 
________________ for quick access. 

a.  Contact Team b.  Contact Group 

c.  Contact Network d.  None 

9.  A browser is a web ______________________. 

a.  application b.  Plug in. 

c.  widgets d.  Add in. 

10.  Which of the following web site is used to search other websites by typing keywords? 

a.  Social Networks b.  Web browser 

c.  Search Engines d.  None 
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Answer Key 
MCQ Number Correct Answer 

1 b 

2 a 

3 d 

4 d 

5 b 

6 b 

7 b 

8 b 

9 a 

10 c 
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Module 7: Manage Information System 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Perform Data Entry 

 Manage File / Folder 

 Perform Scanning 

 Maintain Office Record 

 Perform Printing 

 Search File/Folder 

 Convert Files 
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Learning Unit 1: Perform Data Entry 

Overview 

 
Raw data is data that has not been processed for use. In this learning unit, you will learn the techniques of using 
keyboard for different software packages, how to organize data in useful information and how you can process a 
data for making decisions. After completion of this learning unit, you will be able to process raw data into useful 
information. 
 

1. Organizing Raw Data 

Data 

The data you collect from different resources is in a raw format. Some examples of raw data are:  

 Completed hardcopy surveys 

 Field notes 

 Audio recordings of interviews or focus groups 

 Video recordings of observations 

Typically, raw data is difficult to understand.  

Information 

 Knowledge of facts about something or someone is called information.  

 The information is the processed data into desired format that is easy to understand. 

Information is valuable because it can affect behavior, a decision or an outcome. 

Entering and Organizing Data: 

Whether you have collected quantitative or qualitative data, it is important that you enter 
the data in a logical format that can be easily understood and analyzed. The data can 
be easily managed through computer. 

 For quantitative data, use Microsoft Excel or another spreadsheet software 
package to enter your data into an electronic format. 

 For example, if you administered a survey to parents and students, you 
would probably be best served to create one data spreadsheet for the parent survey and another 
spreadsheet for the student survey. 

 For qualitative data, type all the data into a word processing program such as Microsoft Word.  

 Also make sure that each participant is assigned to a unique participant ID and responses are 
organized by survey item/question. Below is an example of what your data spreadsheet may look 
like. 

Before you are 
being entering, 
develop a system to 
organize your data 

Remember 



Module 7: Manage Information System  

420 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 

Data Spread Sheet 

The code book is your data key/legend, so it is important to keep it in a safe place where you can access it easily 
and frequently. 

 

Use a similar organizational approach for qualitative data.  

 Create a file for each interview, observation site, focus group, etc. 

 Within each file, organize the data by question, time intervals, and/or topic (depending on what method makes 
the most sense). 

 Excel/Spreadsheet also can be used for qualitative survey, allocate every column will with spreadsheet field 
i.e. sr#, name, question1, question 2 etc. 

Cleaning Data 

Checking data for errors is commonly called “cleaning.” Cleaning data is critical because “dirty” data can severely 
influence your results.  

Three most commonly used in cleaning methods are: 

 Spot-checking 

The process of 
entering qualitative 
data can be very 
tedious and time-
consuming, so it is 
important that you 
plan accordingly. 

Remember 
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 Eye-balling 

 Logic checks 

The best practice is to use all three approaches so that you are sure you have caught all possible errors.  

 

2. Data Processing for Making Useful Decisions 

An ongoing process of analyzing and evaluating information to inform important educational decisions and 
actions are called Data-based Decision making. 

The purpose of data-based decision making is to review: 

 Systems 

 Practices 

 Tools 
 

The Process 

When data analysis is viewed as one step in a system, its use will become integral to the workings of the 
organization. Without a process, data analysis can be only an event. Time is spent in viewing and analyzing data, 
but there is no intended result other than to comment on what is observed. 

The following four-step process uses data as an integral part of Decision Making cycle. 

 

Decision Making Cycle 

1. Analyze 

Data analysis is a foundational part of the improvement cycle. Data provides evidence, successes and challenges 
of a system. The Five W’s (who, what, when, where, why) provide a summary of analysis components. 

2. Plan 

Planning is not about what people want to do, or what they think they might want to focus on, but what the data 
tell them they need to do to increase the achievement of the students. Long- and short-term improvement goals 
are established. 

Analyze

Plan

Implement

Assess
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Generating plans to reach goals requires the involvement of teachers and administrators at the school and district 
levels. At each level, plans need to be created that reflect the data. Classroom, school, and district plans should 
be mutually supportive. 

The planning form can be typed into a table so that the sections can expand to meet the needs of the group. 

3. Implement 

Plan implementation requires the involvement of all parties who are reflected in and affected by the plan. District 
staff should be knowledgeable and supportive. School staff should be clear on their key roles in the plan and its 
implementation. The involvement and support of students and parents is essential for the greatest impact on 
achievement. 

4. Assess 

Assessment takes a variety of forms and is ongoing. Types and times of assessments are identified during the 
planning process. The goal is to assess the effectiveness of the plan throughout 
implementation. These assessment tools create a focus to evaluate the key 
components of the plan. 

Decision-Making 

Data are key to an effective cycle of continuous improvement. The focus is continuous 
growth in student achievement. Through data analysis and discussion, district 
weaknesses are identified. These provide the improvement targets. The use of an 
improvement cycle supplies a process by which plans can be created and implemented 
to support the elimination of identified challenges. 

3. Skills Related To Keyboarding In Different Software 

Keyboard skills are necessary to operate computer efficiently. You can avoid reaching for the mouse if you are 
familiar with keyboard shortcuts. The following are some important keyboard shortcuts that you can use in 
different software packages: 
 
Ctrl+N 

Open a new file quickly. 

Ctrl+X 

Cut- Removes the selection from the active document and places it on the clipboard. 

Ctrl+O 

Opens a previously saved document. 

Ctrl+C 

Copies the selection to the clipboard 

Ctrl+W 

Closes the active window, but does not Exit Software. 

Ctrl+V 

Paste - Inserts the contents of the clipboard at the insertion point (cursor) or whatever is selected. 

For keyboard 
shortcuts in which 
you press two or 
more keys at the 
same time, the keys 
to press are 
separated by a plus 
sign (+). 

Important 
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Ctrl+S 

Saves the active document with its current file name, location and format. 

Ctrl+A 

Selects all on the active document/Workbook etc 

Ctrl+P 

Prints the active file, also gives the opportunity to change print options 

Ctrl+F 

Find /Searches for specified text in the active document 

Alt+F4 

Exit /Closes Microsoft  Software. 

Ctrl+B 

Bold - Formats selected text; make text bold, or remove bold formatting 

Ctrl+Z 

Undo the last action. This selection can be repeated several times. 

Ctrl+I 

Italic - Formats selected text; make text italic or remove italic 

Ctrl+Y 

Redo - After an action has been undone, it can be reinstated in the document. 

Ctrl+U 

Underline - Formats selected text; make text underlined or remove underline. 

Print Screen 

Copy a picture of the selected window to the Clipboard. 

ALT+TAB 

Switch to the other window 

Microsoft Office Basic Shortcut keys: 

Switch to the previous window. 

ALT+SHIFT+TAB 

Close the active window. 

CTRL+W or CTRL+F4 

Restore the size of the active window after you maximize it. 

ALT+F5 
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Move to a task pane from another pane in the program window (clockwise direction). You may need to press 
F6 more than once. 

F6 

Move to a task pane from another pane in the program window (counterclockwise direction). 

SHIFT+F6 

When more than one window is open, switch to the next window. 

CTRL+F6 

Switch to the previous window. 

CTRL+SHIFT+F6 

Maximize or restore a selected window. 

CTRL+F10 

Copy a picture of the screen to the Clipboard. 

ALT+PRINT SCREEN 

 

4. Typing Techniques to Enter Data 

Typing Master 

Typing master is a software with a lots of Lessons, Tests and Games to increase the typing speed. It is a well 
designed software that systamatically helps you to increase speed in a friendly way and inform you about the 
keys that are problamatic for you and suggest exercise for those problematic areas. 

The procedure to use Typing Mater has the follwing steps:  

1. Open the Typing Master Software from the all program. Enter the name to start the program.  

 

 
2. On the Next page the Course window will be open from where you can select the desired lesson.  

Once you added 
your name it 
remains save for the 
future use. 

Remember 
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3. After selecting the lesson next page will be open with the information about that lesson and the visual 
instructions of fingers position. Click on the Next button. 

 

4. Now the Exercise wil start with the time. You can also Pause the lesson, it will stop counting time of 
typing speed.  

 

5. As the time will over the Exercise Result will be open with the detail of your typing progress.  

You can directly 
practice the keys 
that you feel needs 
to be more 
perfection. 

Remember 



Module 7: Manage Information System  

426 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

 

When you start the Typing master by giving name you can select the category in which you want to enter. For 
example you can select studying, Typing Test, Games etc according to your level / interest . 

 

This type of typing software helps you to improve typing speed for data entry. 
 

  

  

The major focus of 
typing test result is 
speed and accuracy 

Note 
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Learning Unit 2: Manage File and Folder 

Overview 

 
Most of the operating systems provide much flexible options to organize your data. In this learning unit you will 
learn how to arrange file / folders in libraries and data can easily be search out and the techniques to naming and 
arranging files in the folders. After completion of this learning unit you will be able to organize your files and 
folders on the storage devices. 
 

1. Customizing the Document Library 

Libraries are the most useful features in Windows. It can help you to organize your files 
and folders very efficiently. By using libraries, you can easily build a system so that you 
can always find what you want within seconds. It is not limited to this, but you can also 
sort, tag or edit files and folders with just a few clicks.  

In Windows 7 default libraries include two standard folders: the user folder specific to 
each library and the public folder specific to it. For example, the Documents library 
includes your user's Documents folder and the Public Documents folder, 
the Music library includes your user's Music folder and the Public Music folder and 
so on. By default, you have the Documents, Music, Pictures and Videos libraries. 
Three of them can be found, by default, on the upper right side of the Start Menu in 
Windows 7. 

 

 

2.  Adding File /Folders in the Existing Library 

If you have documents stored in a folder other than My Documents, and you need to add it to the Documents 
Library. There are a couple of ways you can use.  

1. Right-click on a folder and select Include in library from the context menu.  
2. Choose the Documents Library.  

A library is a virtual 
collection of folders 
on your system. 
A library is a 
reference to one or 
more folders on your 
computers and the 
files found inside.  

Do you know! 

Libraries can also be 
accessed in the 
navigation pane 
of Windows 
Explorer. 

Do you know! 
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Or when you have the folder containing your documents open, select Include in library and choose the library to 
put them in from the dropdown. 

 

When you add a 
folder to a library, 
that folder is still in 
its original location. 

Remember 
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Here look at the Documents library that contains files that are located in different places throughout the hard 
drive, including some on another partition. 

3. Customizing the Libraries 

Libraries can be customized in many ways. You can view and arrange the files/ folders or you can create your 
own libraries. 

To customize the view of folders/files follow these steps: 

1. Open the required folder or library in windows explorer. 
2. Click on the View Menu Bar item and select Group by arrangement options. 
3. Select a field Name by Ascending or Descending order for sorting as per requirement.  
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Creating Own Library 

The default libraries are all well and good, but if you really want to take advantage of this feature, you have to 
create your own.  

1. In the libraries directory click on the New library button and give it a name. 

 

2. The first time you open it you’ll be prompted to include a folder. 
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3. Browse to the location with the files you want to add then click Include a folder. 

 

4. Now the files included in that folder will show up in the new library. 

 

 

4. Finding Files 

Windows provide several ways to find files and folders. There isn't only one way to search,you can use different 
methods for different situations. 
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1. Using the search box in a folder or library: 

When you're looking for a file that you know is in a particular folder or library, such as Documents or Pictures. 
Browsing for the file might mean looking through hundreds of files and subfolders. To save time and effort, use 
the search box at the top of the open window. 

 

Search Box  

2. Using Search Bar in the Start Menu: 

You can use the search box on the Start menu to find files, folders, programs, and e-mail messages stored on 
your computer. 

  

Using Search Box  at Start Button 

 

5. Storing Data on Different Storage Devices 

Difference between File and Folder: 

File: 

There are different types of files each have different extensions and icons. For example, Microsoft Word 
documents (.doc/.docx), digital photos (.gif/.jpeg), music (.mp3), and videos (.avi) and many more. When you use 
different applications, you'll often be view, create, or edite files. 
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Files are usually represented by an icon. 

 

Icons of Different Files 

Folder: 

Windows uses folders to organize files. You can put files inside a folder, just like you would put documents 
inside a real folder. In the image below, you can see some folders on the desktop.  

 

Icons of Different Folders 

Storing Files/Folders: 

If you select Start > Computer you can see all the different drives available for storing your files. 

 

Files Storing Drives 

 

To prevent future 
copies of files, it’s 
important to make 
shortcuts of files and 
folders, not copies 

Remember 

Copy leaves the 
copy of file at 
original place while 
move does not. 

Copy vs. Move  



Module 7: Manage Information System  

434 |                                                                    Teaching and Learning Material: Information Technology (Computer Operator) 

A folder that’s not properly labeled, or is in the wrong place, is just as bad as files all over your computer without 
a home (folder). 

If you want to store your personal data to a specific location within the hard drive or a device attached with the 
computer you can do it by copying or moving it. 

If you want to change where files are stored on your computer. You might want to move files to a different folder, 
for example, or copy them to removable media (such as CDs or memory cards) to share with another person. 

Mostly copy and move files using a method called drag and drop.  

 

Drag and Drop  

 
When using the drag-and-drop method, you might notice that sometimes the file or folder is copied, and at other 
times it's moved. If you're dragging an item between two folders that are stored on the same hard disk, then the 
item is moved so that two copies of the same file or folder aren't created in the same location. If you drag the 
item to a folder that's in a different location (such as a network location) or to removable media like a CD, then 
the item is copied. 

 Start by opening the folder that contains the file or folder you want to move.  

  Then, open the folder where you want to move it to in a different window.  

 Reduce the sizes and position the windows side by side on the desktop so that you can see the contents 
of both.  

 Next, drag the file or folder from the first folder to the second folder. 
 

6. Getting Backup Files 

The procedure to back up your files on the storage device has the following steps: 

1. Open Backup and Restore by clicking the start button> Control Panel>System and Security, and then 
clicking Backup and Restore. 

2. Click on the Set up Back up option and follow the steps in the wizard. 
3. When you click on the setup Back Up, the window will be open with the options to select the desired 

location where you want to back up your files.  

 

Don’t back up your 
files to the same 
hard disk / drive that 
Windows is installed 
on. 

Remember 

Another way to copy 
or move a file is to 
drag it from the file 
list to a folder or 
library in the 
navigation pane so 
you don't need to 
open two separate 
windows. 

Important 
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4. Select the Backup Destination and click Next. 
5. Select the option either you want to back up recommended files/Folders or you want to Backup files of 

your choice and click Next. 

 

6. After selecting the files/Folders you want to backup, Review Backup window will appear that shows 
detail of your Backup. Check your Backup Detail and click Save Setting and Run Backup 

 

Backing Up Files  
Restoring Backup Files: 

You can restore backed up versions of files that are lost, damaged, or changed accidentally. You can also 
restore individual files, groups of files, or all of the files that you've backed up. 

1. Open Backup and Restore by clicking the Start button , > Control Panel > System and Maintenance, 
and then clicking Backup and Restore. 

 

Some companies 
provide free web 
space for backup 
your files i.e. Google 
drive, Degoo etc. 

Do you know! 

When you're 
browsing for folders, 
you won't be able to 
see the individual 
files in a folder. To 
view individual files, 
use the Browse for 
files option. 

Important 
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Option 1: 

1. To restore your files, click Restore my files. 

2. To restore the files of all users, click Restore all users' files.  If you're prompted for an administrator 
password or confirmation, type the password or provide confirmation. 

Option 2: 

1. To browse the contents of the backup, click Browse for files or Browse for folders.. 

2. To search the contents of the backup, click Search, type all or part of a file name, and then 
click Search. 
 

7. Naming File and Folder 

Choose a logical and consistent way to name and organizing your files allows you and 
others to locate them. Ideally, the best time to think how to name and structure the 
documents and directories at the time of their creation.  

Develop a naming scheme for all kinds of files you create most often and then stick to 
it. Useful file names must be:  

 Consistent. 

 Meaningful to you and your colleagues. 

 Allow you to find the file easily. 
 

The following are useful elements for a file naming:  

 Vocabulary – choose a standard vocabulary for file names, so that everyone uses a common 
language. 

 Punctuation – decide on conventions for if and when to use punctuation symbols, capitals, hyphens 
and spaces. 

 Dates – agree on a logical use of dates so that they display chronologically i.e. YYYY-MM-DD. 

 Order - confirm which element should go first, so that files on the same theme are listed together and 
can therefore be found easily. 

 Numbers – specify the amount of digits that will be used in numbering so that files are listed 
numerically e.g. 01, 002, etc. 
 

8. Keeping File Name Short 

Its best practice to keep folder and file names as short and meaningful as possible. The following 3 tips should 
be follow for file naming: 

File length: 

 As you create folders and documents a file path is created.  

The file path below has 141 characters  
 
X:\Philosophy\Dept Management\ Print Accounting Reports\... 
... \Other Print Charging Files\Charging Rates - various calculations\Department costs.xls 
 

If the total length of 
the file path is more 
than 200 characters 
this may cause 
problems when the 
files are backed up 
or moved.  

Important 
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it could be shortened to 85 characters 
…\Print Charge\Rates\Dept cost.xls 

Repetition: 

Unless you are going to email a file externally, you should shorten the name if you want to avoid repeating the 
folder names in the file name. 

Abbreviations: 

You might find it useful to abbreviate words in file names. It is good practice to use abbreviations in file naming 
in spite of using full name. 
 

9. Structuring Folders 

Using single folder for a long topic is not a good choice and also don’t use too many folders for data. You 
should start with a limited number of folders for the broader topics, and then create more specific folders within 
these.  

Let your folders do some of the naming. For example, rather than create a file called Computer Operator 
Semester 1 Database management version1.doc, you can build a structure like: 

 

10. Avoid Big Sub Folder  

If you need to put so many subfolders in a folder that you can't see all of them at a glance, consider creating an 
alphabetic menu. 

 

To organize the folder alphabaticaly the best solution is to sort the folders. To sort the foldrs follow these steps: 

1. Open the folder having folders in it. 
2. Right click on the empty space and click on the Sort By option and select Ascending order to arrange 

folders Alphabetically. 
3. The data will be arranged Alphabetically. 
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Learning Unit 3: Perform Scanning 

Overview 

An anti-virus scanner is a component of an anti-virus software package that scans a 
hard drive for viruses and other harmful items. In this learning unit you will learn how to 
scan your computer from viruses, Trojan horses, malwares, and worms and how you 
can update your antiviruses and can completely scan computer from malwares. After 
completion of this learning unit you will be able to scan/protect your computer from 
viruses with updated antiviruses etc.  

1. Scanning Computer Completely 

An antivirus program is a software utility designed to protect your computer or network against computer 
viruses. Whenever a virus is detected, the computer displays a warning that what action should be done, often 
giving the options to remove, ignore, or move the file to the vault. 

If a virus infected a computer without an antivirus program, it may delete files, prevent access to files, send spam, 
spy on you, or perform other malicious actions. 

Today, there are dozens of different companies and antivirus products available for computers, servers, and even 
phones. All new antivirus programs have a feature to schedule times to scan all of the files on your computer for 
infections or can be manually run to check for viruses. 

After installing antivirus in the computer it should automatically start each time you boot your computer. In the 
picture below Avast antivirus is being displayed in the Window Notification Area. 

 

To start the complete scan of computer follow these steps: 

1. Click on the Avast Antivirus from the Notification area. 
2. Antivirus window will be open.  

The first antivirus 
programs began 
appearing in 
1987 with the 
introduction of an 
antivirus program 
from G Data 
Software for the 
Atari ST 

Do you know! 
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1. Click on the option Scan>Scan for Viruses. The following window will be appearing. 

 

2. Select the option Full system scan from the drop down menu of Quick Scan and click on the Start 
button. 

3. The scan will be start. 

 

Other well-known 
antivirus programs 
include Norton 
Antivirus and MAC 
Fee, and popular 
free antivirus 
programs include 
Avira and AVG.  

Important 
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4. After completion of the scan the summary will be displayed.  

 

5. Click on the Show result option to check the threats. 

 

6. See the threats that are found and then select  the action that you want to perform from the drop down 
menu and click on the Apply option. 

7. The selected action will be applied and your scan is complete against viruses ,trojan horses and 
malewares. 

2. Using Microsoft Windows Malicious Removal Tool 

The Microsoft Windows Malicious Software Removal Tool helps remove malicious software from your computers. 
After you download the tool, the tool runs one time to check your computer for infection by specific prevalent 
malicious software (including Blaster, Sasser, and Mydoom) and helps remove any infection it finds. 

The Microsoft Windows Malicious Software Removal Tool can download from the http://www.microsoft.com/en-
pk/download/malicious-software-removal-tool-details.aspx website. As downloading complete run Microsoft 
windows malicious Removal tool and follow instructions: 

Normally Fix 
Automatically option 
is chosen for the 
threat fixation. 

Note 

Microsoft releases a 
new version of the 
Microsoft Malicious 
Software Removal 
Tool every month. 

Remember 

http://www.microsoft.com/en-pk/download/malicious-software-removal-tool-details.aspx
http://www.microsoft.com/en-pk/download/malicious-software-removal-tool-details.aspx
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1. Run the setup. The window will apear with the terms and conditions. For installation you have to accept 
the terms and conditions by checking/clicking the check box. This checked box will enable the next button 
for you to move forward, click Next. 

 

2. Click Next button from the next window.  
3. Select the type of scan that you want their, click Next. 

 Quick Scan: will scan those areas of computer where malicious softwares are most likely to be. 

 Full Scan: scans the complete system and it  takes long time. 

 Custom Scan: will scan the selected files in the computer. 

 

4. The Scan will be started and after completion shows the result with possible threats and infections that 
are found.  

It runs in "quiet 
mode", which means 
it doesn't tell you 
anything at least as 
long as it doesn't 
find any malware to 
remove. 

Important 
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3. Updating Virus Definition 

Every virus or spyware application has unique identification information, known as its 
signature definition file. Security software uses these files to detect viruses and 
spyware on your computer.  

As new viruses or spyware applications are discovered, your security software updates 
its databases with the signature files it needs to detect these new threats. 

Therefore, computer becomes vulnerable to viruses and spyware whenever its 
database of virus signature definition files become outdated. But, this issue can be 
resolved, because: 

 By default, virus definition files are automatically updated regularly. 

 If you hear of an outbreak and want to get the latest updates immediately, select Update option in the 
main window. 

To customize automatic signature update for Avira Antivirus follow these steps: 

1. Open the Avira Antivirus Window. 
2. Click on the Schedular option on the Left side of the Window. 
3. Click on the + sign to insert New job. 
4. Select the job type (Scan,Update) and then set the schedule for update. 

 

4. Updating Antivirus 

A feature of most of our programs is their ability to update themselves automatically. If you are connected to the 
Internet, virus database updates are downloaded and installed automatically without any user action. You 
can also update your software manually. Antivirus software must be updated regularly to stay effective against 
new viruses. 

To update the Antivirus installed in your computer,follow these steps: 

You can also 
schedule update 
task from the 
Scheduler option in 
Antivirus window. 

Note 

Computers become 
vulnerable to viruses 
whenever its 
database becomes 
outdated. To solve 
this issue regular 
updates required. 

Do you know! 
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1. Open the Antivirus window installed in your computer from the Notification Area. This window will show 
the computer status whether it is updated or needs to be updated.  

 

2. Click on the Start Update option as shown in the picture below. 

 

3. The updates will be start downloading and then automatically install.  

 

4. After installation of updates the window will show the status of computer as working properly. 

If you are not 
connected to the 
internet then the 
antivirus will notify in 
daily basis for the 
updates 

Remember 

The Update 
now option only 
appears if Windows 
detects that your 
antivirus software is 
out of date. Not all 
antivirus software 
reports its status to 
Windows. 

Important 
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5. Running Complete Virus Scan 

Antivirus is always running on the background. It monitor the processes that are running on system, and ensures 
that there are no malicious processes running. Whenever you start downloading a new file or open a program or 
attach any removable device, your antivirus quickly start processing, examine the file and compar it to viruses 
before allowing it to run. If you download a virus or attach an infected device with computer, antivirus will notice 
without your scanning. Antiviruses generally run system scans in the background once a week without interrupting 
you. 

If you want to manualy complete scan your computer with Avira Antivirus,follow these steps: 

1. Open the Antivirus window installed in your computer. 

 

2. It will show when last scan was performed. Click on the Scan Sytem. 
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3. The antivirus will start scanning all files of computer including hidden files, diretries, archive files etc. 
ater completion it will show you the summary of scan. 

 

4. If it finds any malicious it will prompt for actions otherwise Close it, after that chek the stautus of 
Antivirus. 
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Learning Unit 4: Maintain Office Record 

Overview 

 
Office record is a very valuable asset of any organization so it must keep in organized and maintained form. In 
this learning unit you will learn about the Electronic record management and it’s backup. How you can access 
and maintain the records without its physical existence. After completion of this learning unit you will be able to 
maintain office records. 
 

1. Ensuring the Existence of Electronic Record 

With the rapid development of computer technology many organisations are shifting 
from manual to electronic records by use of office automation tools such as word 
processing, spread sheets, electronic mail and database management software. 

In reality few automated systems have implemented paperless environment by 
eliminating the use of “hard copy” (printed form of the computerized data. 

Electronic records are logical and cannot be read directly without the use of computer 
software and hardware.  

As logical entities, electronic records have three attributes: content, context and structure, which can be explained 
as follows. 

Content: what the record says.  

Context: is the background information that helps to explain the meaning of the 
document.  This includes two types of information.  Firstly, there is information that 
identifies the particular document, such as the title, author and date of creation.  
Secondly, there is information about the creator and the purpose of creation. 

Structure: relates to both the appearance and arrangement of the content (for 
example, the layout, fonts, page and paragraph breaks, tables, graphs, charts and so 
on) and the relationship of the record to other related records in the system (i.e the 
links).   

To ensure that the record is preserved and protected by all means, follow these steps: 

1. Do not use computer hard drives (C: drives) to store records or important information. Instead, store 
records in formally established electronic record-keeping systems or, in the absence of such systems, in 
secured network drives. 

2. Regularly clean up computers and network locations by destroying obsolete records that have met their 
retention periods. 

3. Ensure your computer systems are configured with proper security systems, anti-virus software, 
password protection, and automatic time out/lock features to restrict access to password holders only. 

4. Good record-keeping involves keeping full and accurate documentation about which records were 
destroyed and which were kept safe. 

5. Always check that the website you are using is using secure links. 
6. Ensure that no body is looking you during password typing and always logout after finishing work or 

leaving the seat. 
7. Always install antivirus on your computer and be sure that all the softwares are properly updated. 

 

For secure record-
keeping records 
must be protected till 
they need to be 
kept, and after that 
dispose them 
appropriately. 

Remember 

A digital record that 
can be manipulated 
transmitted or 
processed by a 
computer is known 
as Electronic 
Record. 

Note 
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2. Managing Electronic Record Backup 

 
Dependable backup procedures protect electronic documents from loss and corruption 
.Record must be well organized and timely backup has been taken for proper working 
otherwise many issues can be arise. 
 
Some important points are given below to manage backups. 
 

1. You must back up electronic records on a regular basis to safeguard against loss 
of information due to equipment malfunctions, human error, or other disaster.  

 
2. Back-up media created for recovery purposes must be stored in another storage 

facility with constant temperature (below 68 degrees Fahrenheit) and relative 
humidity controls.  

 
3. Electronic records on magnetic tape or disk must not be stored in metal containers unless the metal is non-

magnetic.  
 

3. Enhancing Ability to Access Record Overtime 

There is often a presumption that because information is stored on the computer or on disk or tape, it is somehow 
automatically preserved for all time. Unfortunately, electronic storage media can easily become unreadable over 
time due to physical, chemical, or other deterioration. Special care and precautionary measures must be taken 
to avoid the loss of records stored on electronic media. 

The following are general suggestions to enhance the data availability. 

 Do not use diskettes for long-term storage of permanent records.  Temporary storage on diskettes is 
acceptable. 

 Keep disk and tape drives clean and give them periodic preventative maintenance. 

 Keep diskettes and tapes away from strong electrical or magnetic fields. 

 Do not touch the recording surfaces of floppy diskettes; do not break open their outer shell. 

 Do not allow unauthorised persons to have access to the computer or to the diskettes or tape files and 
records.  Even people with good intentions can enter commands that will delete files or reformat hard 
disks. 

 Keep food and drink away from storage media as well as equipment. 

 Store disks and tapes in a vertical position in a storage container (for example a disk box). 

 Store diskettes under normal office conditions, taking care to avoid extreme fluctuations in temperature 
and humidity if possible. 

 You must annually read a statistical sample of all electronic media containing permanent or long-term 
records to identify any loss of information and to discover and correct the cause of data loss.  

 Copy data on the tapes to new or re-certified tapes at least once every ten years or more frequently when 
necessary to prevent the physical loss of data or technological obsolescence of the medium. 

 

  

Individual hard 
drives on PCs are 
not backed up via 
the regular network 
backup procedures 
and must be backed 
up regularly by 
users onto backup 
drives i.e. Usb flash 
passport disks. 

Important 
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Learning Unit 5: Perform Printing 

Overview 

Printing is process of getting hard copy of a file, image, email or anything which is 
wanted to print on paper. Printer must be installed on the computer before printing. 
Printing ink/powder and paper directly affect the printing quality. This learning unit 
covers the procedure for printing a file on a paper and how to get print on both side of 
a paper. After completion of this learning unit You will be able to demonstrate the 
procedure of printing a good quality print of a file. 
 

1. Getting Print Out From a PC 

 

 Open any document, webpage, or email for printing. 
 

 Click the File menu, and then click Print. 
 

 In the Print dialog box, change the settings as per requirements i.e paper size, margin, copies, page 
numbers etc. click Print. 
 

2. Handling Problems that Occur While Printing 

 
Check Before Printing 
 

 Before printing any file, check whether the printer is installed, connected with 
computer and powered on.  

 Also, check type of printer (inkjet or a laser printer). 

 Choose the appropriate paper and ink/Powder.  

 Determine what type of paper size wanted to print on before printing. This paper 
will need to be loaded into the appropriate slot / tray. 

 Determine what is needed, color or black & white prints. 

 Ensure that printing material is open and visible on the computer. It is impossible to print if the document 
to be printed is not open. 

 
Getting Printout:  
 
1. Click File in the top left-hand corner of document or file. 

 

 
 

Choose paper as 
per requirement 
within allowed 
weight limit of 
printer. 

Remember 

Printer is a device 
that is used to 
convert a softcopy 
result to a hard copy 
(like Paper). 

Printer 

CTRL + P command 
prints on by default 
printer’s settings. 

Do you know! 
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2. Move down and click Print in the menu. 
 

 
 
3. Choose how many copies of the document needed. 
 

 
  

 
4. Click Print Preview. To see what the document will look like once printed.  
5. Click Properties, Preview, or Advanced. Find the button which will allows accessing the more advanced 

settings.  
6. (This menu will allow changing paper sizes, source, and type, as well as a variety of other options depending 

on the program using.  
7. If wanted to print on both sides of a paper than select the option from settings than Pages and then select 

Manually print on both sides (This is subject to the printer). 
 

You can also print 
Envelops Labels, 
Charts and images, 
Wedding Cards 
using printer. 

Do you know! 
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8. Click Ok or Print. 

 

 
Select Print 

. 

3. Printing E-Mail 

To print an E-Mail follow these steps:  

1. Open an E-Mail you want to print out. 
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2. Press CTRL+P to print E-Mail. A small window will open with the preview of email. 
 

 
 

3. Click on the Print button shown in the above button . 
4. E-Mail will be printed, you can collect it from out tray of printer. 
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Learning Unit 6: Search Files and Folders 
 

Overview 

Finding files and folders means searching for a specific folder or files in a computer. 
Windows provides several ways to find files and folders. There isn't one best way to 
search. You can use different methods for different situations. This learning unit will 
covers the procedure for searching files and folders using different methods. After 
completion of this learning unit you will be able to search known and unknown files 
using wild cards using names of files or folder through start buttons and search tool.  

 

1. Methods of Finding Files and Folders 

For finding or searching files and folders different methods are provided with windows like: 
 
1. Using the search box on the start button. 

The search box on the Start menu is used to find files, folders, programs, and e‑mail messages stored on 
computer. 
 
2. Using search box in a file, folder or library. 

 The search box filters the current view based on text that is typed. The search looks for text in the file name and 
contents; and in the file properties, such as in tags. In a library, the search includes all folders included in the 
library as well as subfolders within those folders. 
 
3. Expanding a search beyond a specific library or folder. 
If it cannot find what is looking for in a specific library or folder, than expand the search to include different 
locations. 

 

2. Use of Search Box to Find Files, Folders and Programs 

Search Box 

The search box is one of the most convenient ways to find things on computer. The search box finds programs 
and all of the folders in personal folder (which includes Documents, Pictures, Music, Desktop, and other common 
locations). It will also search e-mail messages, saved instant messages, appointments, and contacts etc. saved 
in computer. 

 

Search Box 

Using Search Box 

Open the Start menu and start typing. It doesn’t need to click inside the box first. As you type, the search results 
appear above the search box in the left pane of the Start menu. 

You can search a 
specific file or folder 
through navigation 
but it takes a lot of 
time for searching a 
specific file. 

Remember 
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A program, file, or folder will appear as a search result if: 

 Any word in its title matches or begins with the search term. 

 Any text in the actual contents of the file such as the text in a word processing document matches or begins 
with the search term. 

 Any word in a property of the file, such as the author, matches or begins with the search term.  

 Click any search result to open it. Or, click the Clear button  to clear the search 
results and return to the main programs list.( You can also click See more 
results to search your entire computer.) 

Besides searching programs, files and folders, and communications, the search box 
also looks through your Internet favorites and the history of websites you've visited. If 
any of these webpages include the search term, they appear under a heading called 
"Files." 

3. Finding Files and Folders Using Start Button 

Finding an item using the Start menu: 
 
1. Click on the Start button, and then type a word or part of a word in the search box. 

 
 

Search Box in Start Button  
 
2. Search results appear as soon as start typing in the search box. 
As you type, items that match your text will appear on the Start menu. The search results are based on text in 
the file name, text in the file, tags, and other file properties. 
 

4. Finding Known Files and Folders Using Windows Search Box Tool 

Using the Search Box in a Folder or Library 

When looking for a file that someone knows is in a particular folder or library, such as Documents or Pictures. 
Browsing for the file might mean looking through hundreds of files and subfolders. To save time and effort, use 
the search box at the top of the open window.  

Microsoft has 
allowed searches 
using two wildcards, 
the asterisk (*) and 
the question mark 
(?). 

Remember 
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  Search Box in a File and Folder 

Search for a File or Folder by Using the Search Box: 

Type a word or part of a word in the search box. When done, the contents of the folder or library are filtered to 
reflect each successive Character typed. When the wanted file is seen stop typing or filter it with other checks 
that is date, author, size etc. 

 

Searching a File and Folder 

 

 
 

  

In wildcards the 
question mark (?) is 
used to substitute 
for one letter or 
symbol that you 
don't know. The 
asterisk (*) is used 
to substitute for 
many letters and 
symbols. 

Do you know! 



Module 7: Manage Information System  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 455 

Learning Unit 7: Convert Files 
 

Overview 

Sometimes it is necessary to convert a file into another format, like converting an MS 
word file into a PDF file which is an adobe acrobat file or conversion of a video file into 
audio file. This conversion can be done using different types of software available on 
internet. The software can be downloaded and installed. This learning unit covers the 
procedure for converting a file into a different format like a MS word file to PDF file, 
demonstrate software types used for file conversion, conversion of a file manually and 
procedure for converting files using online software are website. After completion of 
this learning unit you will be able to conversion of files using different methods.  
 

1. Converting a File into Different Format 

A file can be converted into different formats through many ways. It can be converted either manually or using 
download or online software for example converting a word document file into pdf file. Some software gives the 
option of saving a file in different format like MS office provided this conversion option. For conversion a word file 
into pdf follow the steps: 

1. Open the file in Office Word 2010. 
2. Click the "File" tab and go to Save & Send.  

 

3. In the "File Types" field, choose Create PDF or XPS Document. 

 

Make sure that you 
have downloaded 
freeware software 
for conversion. 

Remember 

The Save as 
PDF/XPS add-in is 
built in Word 2010, 
and it can directly 
save Word 2010 or 
other parts of 2010 
Office suite to PDF 
format. 

Do you know! 
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4. Click "Create a PDF/XPS". 
5. In the pop-up dialog box, enter a file name and location.  

 

6. Click Publish. 
 

2. Software Used for Converting Files 

There is a lot of software available for conversion of files to different format. For 
example converting a word file to pdf, converting a video file to audio, and many more.  
 

Word to PDF or PDF to word file conversion software 

Foxit Phantom and Nitro are the software used for converting word document to PDF 
file while PDF to Word convertor is software used for PDF to word conversion. 

 

Audio ,Video file conversion software 

Any video convertor, Total video convertor, AVS video convertor is software used for conversion of audio and 
video files into different formats. Like it can convert an .FLV file into MP4 or MP3 file format. 

Archive file to Zip File conversion software 

Express zip software is used to convert archive file to zip file. 

All File 3000 converter software 

All File to File Converters 3000 is revolutionary software, which has the ability to convert any file format to almost 
any format under the sun. With this file conversion software, users can easily convert massive different formatted 
files to one specific format with fast conversion speed. It has the ability of all different file converter like the PDF 
converter, Video and Audio converter.  

 

There are many 
methods for files 
conversion it 
depends on user 
what method he 
/she is used. 

Remember 
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Universal file convertor Software 

Universal Converter offers a complete solution for converting documents into major file formats like PDF, HTML, 
TIFF, JPEG, PNG, BMP, RAW, EPS, PS and other file formats. One great feature of the Universal Converter is 
that it provides security features like password protection, water mark and unique copy protection to the 
documents that are converted. The software also provides a command line interface for converting files and users 
are enabled to combine multiple files of different formats into a single file and convert it to any desired file format. 
 

3. Changing the Extension of a File Manually 

A file extension (or simply "extension") is the suffix at the end of a filename that indicates what type of file it is. 
For example, in the filename "computer.txt," the .TXT is the file extension.  A file extensions can also be changed 
manually for doing this: 

Changing a file extension manually 

In Windows 7, to change a file extension, first, make sure file extensions are visible using the steps below, then: 

1. Open any folder window. 
2. Press Alt+T+O (it is letter O, not a zero) to open the Folder Options dialog box. 
3. Click the View tab. 
4. Remove the checkmark beside ‘Hide extensions for known file types’ and click OK. 
5. Click the file to select it, and then click once more. Windows automatically selects the filename so that 

anything that is typed will replace the existing name. 
6. Click and select the extension, type the new extension and press Enter. 

Changing a file extension using save as command 

A file extension can also be changed using Save as command for doing this: 

1. Open a file for change extension. 
2. Click on File tab then save as button. Save as dialogue box will appear. 

 

Change File Type Using Save as Command 
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3. Click on the save as type text box and select the type wanted to change or save. 
4. Click on OK button. 
5. The file extension will be saved as selected type. 

4. Using Online Converter for Converting Files  

A file can also be converted using online available software. www.zamzar.com is a website for providing 
different file formats to convert a file. Here are some steps to follow for conversion:  

1. Open a web browser 
2. Click on address bar and type www.zamzar.com 
3. Click enter button, the website will be open. 

 

Here is different option available. 

 

Step 1: 

Click on first option for selecting a file which is wanted to convert. 

Step 2: 

Click on this option for selecting a file format. For converting a .PNG form select PNG. 

Step 3: 

Enter email address on which the converted file will be sent after conversion. 

 

To change the file 
extension only does 
not mean to change 
of format of file. 

Remember 

http://www.zamzar.com/
http://www.zamzar.com/
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Step 4: 

In the last click on Convert button for converting. 

 

 

It will take a few minutes after conversion the file will be sent to the given email address. 
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Learner’s Activity 

Description This learning activity consists of an interactive session in the class about 
installing a file conversion and converts a file in different format. 

 

Time 40 minutes. 

 

Purpose To highlight the procedure for installing a conversion software and conversion 
of a file. 

 

Instructions for Learner 1. Ask learners how to download install conversion software. 

2. Ask learners how to convert a file in any other format. 

3. Ask learners are they able to convert a file using online available software 
for conversion. 
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Summary of Module 

  Knowledge of facts about something or someone is called information. Information is valuable 
because it can affect behavior, a decision or an outcome. 

  Checking data for errors is commonly called “cleaning.”  
Three most common methods used for data cleaning are: 
1. Spot-checking 
2. Eye-balling 
3. Logic checks 

 

  The following four-step process uses data as an integral part of Decision Making cycle. 

 Analyze 

 Plan 

 Implementation 

 Analysis 
 

  Typing master is software that systematically helps you to increase speed in a friendly way with lots 
of Lessons, Tests and Games. 
 

  Library helps you to organize your work and make finding easy. In Windows 7 default libraries 
include two standard folders: the user folder specific to each library and the public folder specific to 
it. 
 

  An antivirus program is a software utility designed to protect your computer or network against 
computer viruses. whenever a virus is detected, the computer displays a warning asking what 
action should be done, often giving the options to remove, ignore, or move the file to the vault. 
 

  Most of the antivirus software have feature of automatic update and can be updated manually as 
well 

  Print out/Hard Copy means physical copy of data on paper. Different printing devices are available 
for this. 

  The search box on the Start menu is used to find files, folders, programs, and e‑mail messages 
stored on computer. 

  A file can be converted into different formats through many ways. It can be converted either 
manually or using download or online software 

  A file extension (or simply "extension") is the suffix at the end of a filename that indicates type of 
file. 

  Universal Converter offers a complete solution for converting documents into major file formats like 
PDF, HTML, TIFF, JPEG, PNG, BMP, RAW, EPS, PS and other file formats. 
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Frequently Asked Questions (FAQS) 
FAQ 1:  Differentiate between files/folders? 

Answer 
File is signal unit of data i.e. program, document etc. while folder is a logical location where 
these files or other folders exist. 

FAQ 2:  What is the short key to Find /Searche for specified text in the active document 

Answer Ctrl+F 

FAQ 3:  What are the 3 common methods for checking error? 

Answer 

 Spot-checking 

 Eye-balling 

 Logic checks 

FAQ 4:  What are the common folders included in the library? 

Answer 

 Documents 

 Pictures 

 Music 

 Videos 

FAQ 5:  Write some names of common storages devices? 

Answer 

 Hard Disk 

 USB 

 CD/DVD 

FAQ 6:  What is the recommended storage device to store backup files? 

Answer 
Backup files can be stores on any storage device expect that where the files are actually 
stored. 

FAQ 7:  Define antivirus. 

Answer 
An Antivirus Program is a software utility designed to protect your computer or network against 
computer viruses.  

FAQ 8:  What is short key to print an E-mail? 

Answer Ctrl+P 

FAQ 9:  From how many ways a file/Folder can search out? 

Answer 

There are many ways to search any file/folder. Window 7 provides the search boxes for ease. 

 Through Search Bar on the opened window. 

 Using Search Box in the Start Menu 

FAQ 10:  What is meant by file extension? 

Answer 
A file extension (or simply "extension") is the suffix at the end of a filename that indicates type 
of the file. 

 

  



Module 7: Manage Information System  

Teaching and Learning Material: Information Technology (Computer Operator)                                                                    | 463 

Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  A collection of letters, numbers and special characters is called a 

a.  Folder b.  File 

c.  Information d.  Data  

2.  CD/ DVD are _____________ device. 

a.  Temporary Storage Device b.  External Storage Device 

c.  Output device d.  None of Above 

3.  Which statement is true for Viruses? 

a.  Increase speed of Computer System. b.  Corrupt the files in Computer. 

c.  Protect our Computer from malwares. d.  None of Above 

4.  In “Rapid Typing Tutor.exe” .exe is__________ of file. 

a Name b Extension. 

c Version d None of above 

5.  To Exit /Close Microsoft  Softwares___________ key is used. 

a ALT+F4 b CTRL+C 

c ALT+Tab d ALT+F5 

6.  A ____________is a virtual collection of files/ folders on your system. 

a File  b Libraries 

c Program  d None of these 

7.  Foxit Phantom is the software used for converting ___________ files. 

a Word /PDF Files b Audio/Videos 

c Archive/Zip Files d None of the Above 

8.  
In wildcards the _______________ is used to substitute for one letter or symbol that you 
don't know.  

a Question Mark (?)  b Asterisk Sign(*) 

c # Sign d None of Above 

9.  
A digital record that can be manipulated transmitted or processed by a computer is known 
___________. 

a Paper work b Electronic record 

c Information  d None of Above 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 b 

3 c 

4 b 

5 a 

6 b 

7 a 

8 a 

9 b 
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Module 8: Identify and Peruse New 
Business Opportunities in the Field of 
Computer (ICT) 

Learning Outcomes 

After completion of this learning module learner will be able to: 

 Identify business opportunities in the field of Computer (ICT) 

 Develop structure of the new Computer Business 

 Communicate new computer business to the customers 

 Negotiate arrangements for the new computer business 
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Learning Unit 1: Identify Business Opportunities in the 
Field of Computer (ICT) 
 

Overview 

 
A business plan lays out a written plan from a marketing, financial and operational 
viewpoint. Sometimes a business plan is prepared for an established business that is 
moving in a new direction. In this learning unit you will learn how to identify new 
business opportunities for new and existing business and learn to face challenges 
related to business planning, finance, competition, market trend, employment issues 
etc. after completion of this learning unit you will be able to identify how to start a 
successful business by improving business plan, market research budgeting and 
dealing with suppliers and/or customers, proper business places etc. 
 

1. Identifying Business Opportunities 

It's incredibly tough to find good business opportunities. The best tactic is to read examples and understand what 
to look for and where to go to find a successful opportunity. It's never guaranteed, but it's a good (and necessary) 
place to start. There are a few general things that should always be present with a good opportunity (no matter 
what type) of business you are going to start. 
 

1. The product or service will be according to need: 
 
For a new business when you evaluate an opportunity, ask yourself if there is really need for this product 
or service. Does the product or service solve the problem for consumers? The best way to see if the 
people are going to like your product is to take a survey. 
 

2. The opportunity will work in your location. 
 
If the opportunity meets the need that's sufficient, but if isn't specific to your location it won't work for you. 
You also have to think of the economic environment.  
 

3. Ensure Resources to make Business Successful: 
 
While it's true that you can start to compile resources once you have acquired or started a business, you 
should still be considering this at the start. This is more of a personal requirement for an opportunity as 
opposed to finding one in general. Do you have what it takes to run that type of business right now? Are 
you going to be able to afford the resources needed to help the business succeed? 
If you will not keep in mind this point in start, in the end you need to trust others so that you can focus on 
the bigger picture of setting the strategy. 
 

4. Product and services price is according to market: 
 
You have to consider the market and consider price. Ask yourself whether or not you can provide the 
product or service at a price the market can handle. 
 

5. Timing is suitable in term of Market and Resources: 
 
Timing is everything when evaluating business opportunities. It's also worth noting that even in a down 
economy there could be a window of opportunity. It's all about considering the above points to decide if 
the timing is right for your idea. 
 

 

A written document 
that describes in 
detail how a 
new business is 
going to achieve its 
goals is called 
Business Plan. 

Business Plan 
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2. Facing Challenges in the Business 

Growing businesses face a range of challenges. As a business grows, different 
problems and opportunities demand different solutions. Recognizing and overcoming 
the common pitfalls associated with growth is essential if your business is to continue 
to grow. The main problems that you have to face during the business development 
are as follow: 

 

 

 

Keeping Up with the Market: 

Market research in not something that you do when you start your business. Business conditions changes 
continuously, so market research should also be continuous to how the success of business. 

Problem Solving: 

As your business grows, you also need to be alert to new problems and priorities. For example, your business 
might be increasingly at risk unless you take steps to ensure your intellectual property is properly protected. 

If you are focusing on individual marketing campaigns, you might need to devote more resources to developing 
your brand. 

Money Management: 

Money management becomes even more important when cash is flowing into the business and to the owner.  

Making the best use of your finances should be a key element in business planning and assessing new 
opportunities.  

Proper Systematic Way: 

Responsibilities and tasks can be delegated as your business grows, but without solid management information 
systems you cannot manage effectively. The larger your business grows, the harder it is to ensure that information 
is shared and different functions work together effectively.  

 

3. Identify Risk Related to Business 

There are many different types of business risk. Risks can be internal and external to 
your business. They can also directly or indirectly affect your business's ability to 
operate. The types of risk you face are specific to your business and its objectives. 
Some common risk categories are: 

 Regulatory and government policy changes, such as water restriction, 
quarantine restrictions, carbon emission restrictions and tax. 
 

 Property and equipment, such as damage from natural disasters, burst water 
pipes, robbery. 

 

 economic and financial, such as global financial events, interest rate increases, cash flow shortages, 
customers not paying, rapid growth  and rising costs 

The Australian 
standard defines 
risk as 'the chance 
of something 
happening that will 
have an impact on 
objectives'. 

Risk 

Remember that the 
process of entering 
qualitative data can 
be very tedious and 
time-consuming, so 
it is important that 
you plan 
accordingly. 

Remember 
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 Market, such as changes in Consumer preference and increased competition.  

You should use this list as a starting point for thinking broadly about the types of risks 
that could impact your business. People often make the mistake of overlooking things 
that don't directly impact their business and are therefore unprepared to deal with 
change. For example, while your business might not be directly affected by a natural 
disaster, you may still suffer if it affects your suppliers, customers or general location. 

Consider how these scenarios could affect your business: 

 If your suppliers are affected, you may run out of the products you sell, or the 
materials you need to make products. 

 If your customers are personally affected their priorities may change and you 
could experience a reduced demand for your products or services. 

 If your general location is affected, you and your customers may not be able to access your premises, or 
your utilities could be affected. 

 

Assessing your Business: 

Before you begin identifying risks, you need to assess your business. Think about your critical business activities, 
including your key services, resources and staff, and things that could affect them, such as power failures, natural 
disaster and illness. Assessing your business will help you work out which aspects you couldn't operate without. 
You thing about the following questions? 

 When, where, why and how are risks likely to happen in your business? 

 Are the risks internal or external? 

 Who might be involved or affected if an incident happens? 

 

Brainstorm: 

Brainstorming with different people, such as your accountant, financial adviser, staff, suppliers and other 
interested parties, will help you get many different perspectives on risks to your business. 

 

Consider the Worst Case Scenario: 

Thinking about the worst things that could happen to your business can help you deal with smaller risks. The 
worst case scenario could be the result of several risks happening at once. For example, someone running a 
restaurant could lose power, which could then cause the food to spoil. If the restaurant owner was unaware of 
the power outage or the chef decided to serve the food anyway, customers could get food poisoning and the 
restaurant could be liable and suffer from financial losses and negative publicity. 

 

 

 

 

 

The process of 
identifying risks, 
assessing risks and 
developing 
strategies to 
manage risks is 
known as risk 
management. 

Risk 

https://www.business.qld.gov.au/business/running/risk-management/identifying-business-risk
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4. Assessing Cost Including Break-Even Point 

Your cost and profit margin is a key piece of information about the health of your 
business. You’ll need it to create a good business plan, monitor your costs, adjust your 
prices, and as a measurement of how profitable your business is over time. There are 
two distinct nature of costs that a business has to incur in its normal operational 
activities: 

 

Fixed Cost: 

These costs stay the same regardless of how many units the company is producing. These include start-up costs, 
and other capital expenses which do not have to be paid periodically. Rent, insurance, utility bills and repairs are 
also considered fixed costs. For Example if a company is paying 10000 Rupees rent for a building and decides 
to design 200 shirts with in a month. Then the monthly fixed cost will be 10000 rupees. The amount will stay the 
same if even there is no activity and zero shirts are produced. 

Variable Costs: 

These costs are directly associated with the number of units produced, and these are recurring in nature, since 
they have to be paid periodically. As the business produces more and more goods and services, these costs 
increase proportional. For example, the cost of paint required to design a shirts is 200 rupees. If company designs 
zero shirt, the total variable cost comes down to 0 (10*0). On the other hand, if the company designs 500 shirts, 
the total variable cost comes down to 10000 (500*20). These costs usually include material, labor, direct sales 
and promotion, storage etc. 

Break-Even Point: 

Break-even analysis is an important aspect of a good business plan, since it helps the business determine the 
cost structures, and the number of units that need to be sold in order to cover the cost or make a profit.Even after 
a business has been set-up, break-even analysis can be immensely helpful in the pricing and promotion process, 
along with cost control. 

 

 

Break-even Point = 
Fixed Costs/ (Unit 
Selling Price – 
Variable Costs) 

Important 
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Once the business has reached this point, in sales or units sold, all costs (Fixed and Variable) have been 
recovered. Beyond this point, every additional unit sold will result in increasing profit for the business.  

Behavioral Effect: 

The best way to upsell customers is to keep in touch with them. Here are a few ideas to incorporate into your 
business. 

 Contact customers within 7-10 days of a sale 

 Conduct an online survey about your customer service 

 Invite customers to leave a review on your website, LinkedIn, Google+ local, or Yahoo local listings. 

 Send an email newsletter at least monthly (weekly is best). 

 Send birthday cards. 

 Send holiday cards. 

 Ask for feedback on Facebook and Twitter. 
 

5. Business Ethics with Customers in Relationship 

 In order to build and maintain trust with our customers we have to first develop a strong, 
company-wide reputation for integrity. We accomplish that through clearly established 
internal ethical principles. For example, all of our employees are required to take part 
in annual online training with ethics courses. They also participate in refresher courses 
throughout the year, covering various ethical practices and of course, all relevant laws. 

 

Human Resources: 

Ethical human resource policies are vital to creating and maintaining an ethical 
company culture. Employees who are treated with politeness are more likely to be 
content with their jobs. When employees feel exploited, they commit unethical behavior such as theft, as well as 
offenses such as using company resources for personal gain. 

 

Product Integrity: 

A company that inspires ethical behavior in its employees will probably provide products and services created 
with ethical values in mind. For example, a food business that uses optimally fresh ingredients handled in a clean 
and compliant facility most likely won't have to be dishonest with customers who get sick from eating the 
company's food. 

 

Competitive Integrity: 

It is true that a company's competitors are often seems as enemies, a truly ethical company extends its solid 
values to the way it treats its competitors as well as its stakeholders. Calling a competitor, pretending to be a 
customer and asking questions that you will use to create competing products is dishonest. 

  

A company that 
bases its policies 
and decisions on 
deeply rooted ethics 
will create a culture 
in which employees 
are naturally 
disposed to act 
ethically, too.  

Note 



Module 8: Identify and Peruse New Business Opportunities in the Field of Computer (ICT) 

472 |                                                                   Teaching and Learning Material: Information Technology (Computer Operator) 

Learning Unit 2: Develop Business Plan for the New 
Computer Business 

Overview 

In this learning unit you will learn to manage all important arrangements to start a new 
business including finance management, hiring staff, arranging Business policies and 
necessary arrangement of tools and equipment etc. After completion of this learning 
unit you will be able to design a proper Business plan keeping in mind all important 
aspects. 

 

 

1. Studying Business Laws and Regulations 

One of the first decisions is to determine the legal form of ownership of an enterprise / business / firm. Few 
possible options are: 

Sole Proprietor: 

A sole proprietorship, also known as the sole trader or simply a proprietorship, is a type 
of business entity that is owned and run by one person and in which there is no legal 
distinction between the owner and the business. The owner is in direct control of all 
elements and is legally accountable for the finances of such business which may 
include debts, loans, loss etc. 

 

Partnership: 

The partners in a partnership may be individuals, businesses, interest-based organizations, schools and 
government. 

 

Limited Company: 

In a limited company, the liability of members or subscribers of the company is limited to what they have invested 
or guaranteed to the company. Limited companies may be limited by shares or by guarantee. The former may 
be further divided into public companies and private companies. Who may become a member of a private limited 
company is restricted by law and by the company's rules. In contrast, anyone may buy shares in a public limited 
company. 

Limited companies can be found in most countries, although the detailed rules governing them vary widely. In 
Pakistan companies may incorporate with Security and Exchange Commission of Pakistan (SECP). 

 

 

Partnership Act 
1932 deals with the 
law of Partnerships 
and firms in 
Pakistan.  

Do you know! 

A partnership is an 
arrangement where 
parties, known 
as partners, agree to 
cooperate to 
advance their 
mutual interests. 

Partnership 

https://en.wikipedia.org/wiki/Business_entity
https://en.wikipedia.org/wiki/Business_entity
https://en.wikipedia.org/wiki/Interest
https://en.wikipedia.org/wiki/Organization
https://en.wikipedia.org/wiki/School
https://en.wikipedia.org/wiki/Government
https://en.wikipedia.org/wiki/Company
https://en.wikipedia.org/wiki/Share_(finance)
https://en.wikipedia.org/wiki/Guarantee
https://en.wikipedia.org/wiki/Business_partners
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Incorporation of a Company with Security and Exchange Commission of Pakistan: 

Following are the requirements for registration of a new company under the Companies 
Ordinance, 1984:  

1. Availability of Name: 
 The first step with regard to incorporation of a company is to seek the 

availability of the proposed name for the company from the registrar.  
 

2. The following documents are required to be filed with the registrar concerned 
for registration of a private limited company:- 
 

1. Copy of national identity card or passport, in case of foreigner, of each 
subscriber and witness to the memorandum and article of association.  

2. Memorandum and articles of association Four printed copies of 
Memorandum and Articles of Association in case of offline submission 
and one copy for online submission, duly signed by each subscriber in the presence of one 
witness 

3. Form - 1 Declaration of compliance with the pre-requisites for formation of the company. 
4. Registration/filing fee a copy of the original paid Challan in the any branch of MCB Bank Limited 

or a Bank Draft / Pay Order drawn in favor of the Securities and Exchange Commission of 
Pakistan of the prescribed amount.   

5. Authorization by sponsors The authorization of sponsors in favor of a person to make good the 
deficiencies, if any, in memorandum and articles of association as may be pointed out by the 
registrar concerned and to collect the certificate of incorporation.  
 

3. Additional Requirements for Incorporation Of a Company having objects of providing Security Services 
In case of security object company nine additional sets of each of the documents at i and ii above along-
with the bio-data, four attested photographs of each subscribers and financial position/bank statement of 
the subscribers (Aggregate wealth should not be less than 1.5 million) is required to be provided. Ministry 
of Interior grants NOC for a security object company.  
 

4. Documents for incorporation of a Single Member Company Any person may form a single member 
company and would file with the registrar at the time of incorporation a nomination in the form as set out 
in Form S1 indicating at least two individuals to act as nominee director and alternate nominee director, 
of the company in the event of his death. All the requirements for incorporation of a private limited 
company shall mutatis mutandis apply to a single member company.  
 

5. If the membership of a single member company is transferred to a new member, the company shall, 
within fifteen days from such transfer, also file with the registrar, a nomination in the form as set out in 
Form S1. 
 

6. hange in status of a single member company.  

 

How to Get NTN: 

Taxpayer Registration can be obtained by any of the following two ways: 

 Apply online at FBR Portal by visiting https://e.fbr.gov.pk 

 Apply on paper at any of the Taxpayer Facilitation Centre. 

Taxpayer registration is available for following three types of persons: 

a. Company. 
b. Association of Persons (AOP) 

NTN is the 
abbreviation of 
National Tax 
Number 

Important 

For the naming 
purpose, an 
application is to be 
made and Rs.200/- 
for online application 
and Rs. 500/- for 
offline application is 
required to be paid 
for seeking 
availability certificate 
for each name. 

Remember 

https://e.fbr.gov.pk/
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c. Individual 

For registration of all the above type of persons, there is a single form notified by FBR which can be downloaded.  

2. Understanding Finance 

Equity Capital is the owner’s investment in the business. Borrowing needed capital for 
the business is called credit or debt financing. 

 

 

 

Where can equity capital are obtained? 

1. Personal savings 
2. Friends and relatives 
3. Partners. The owner may form a partnership with one or more individuals to obtain equity capital to 

initiate the business 
4. Corporation. It is possible to incorporate the business (as a company or a corporation) and sell stock 

to raise equity capital 

 

Where can credit or debt financing be obtained? 

1. Banks 
2. Finance companies 
3. Governments agencies (with loan schemes) 
4. Trade credit. Suppliers extending credit terms for equipment, inventory, etc. allow the business to begin 

generating sales before payment is due  
5. Microfinance institutions 

 

How will the capital be used? 

In financing a new business, first determine your specific needs for money. To help determine your money needs, 
three groups of costs and expenses are examined: start-up costs, operating expenses and personal expenses. 

A. Start-up costs: expenses that occur once only when starting the business. Once your business is 
started, you may never have these expenses again. Some examples of start-up costs include: 
 
• Fixtures and equipment 
• Initial inventory 
• Deposits for rent and utilities 
• Business licenses and permits 
• Certain legal fees and 
• Advertising for the grand opening. 
 

B. Operating expenses: until there is enough profit to keep the business running, money will be needed 
for operating expenses. Examples of operating expenses include inventory, supplies, advertising, payroll, 
taxes, wages, repairs and depreciation of equipment, insurance, monthly rent and utilities. 

Money that the 
owner puts into the 
business is called 
equity capital. 

Equity Capital 
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C. Personal expenses: these include costs that are necessary for you to live. You need money for personal 
expenses such as rent or mortgage payments, food, transportation, insurance, clothing, utilities, medical 
bills and entertainment. 

 

Considerations in Applying for a Business Loan: 

Different lending institutions have different procedures which have to be followed by the loan applicant. It is 
necessary to understand the following factors that are taken into consideration when a banker is appraising a 
loan application. 

• Type of loan 
• Purpose of the loan:  
• Credit worthiness and integrity of the borrower.  
• Capability:  
• Repayment period:  
• Security:  
• Guarantors:  
• Business plan: 
 

3. Managing Resources for Business Advertisement  

Most marketing experts recommend that businesses spend anywhere from 2 to 5 percent of their gross sales on 
advertising. But if you're still growing your business, you might not have the budget for large advertisement 
campaigns, or you might be focusing your capital on other areas. You too can take advantage of free ways to 
reach potential customers and advertise your business. 

• Marketing Online 
 

1. Use Tweeter 
2. Create Facebook Page 
3. Create An account 
4. Create Blog 

 
• Using Local Media 

 
1. Write Press Releases 
2. Contact Columnist 
3. Work for Charity 

 
• Networking 

 
1. Build Partnership 
2. Join Community Organization 
3. Host seminars, workshops 
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4. Managing Business  

1) Every business sells some type of product or service to people. 

Potential customers can be described as: 

1. People who need or want the product or service. 

2. People who are able to buy the product or service. 

3. People who are willing to buy the product or service. 

Competition must be considered. If competitors are serving the same market, it must 
be decided if the market is large enough to support another business. It should also be 

determined how the product or service is unique and different from that of the competitors.  

 

2) What should entrepreneurs know about potential customers? 

1. Know the customers: The market can be segmented either by dividing it into meaningful buyer groups 
or dividing it according to characteristics such as age, sex, marital and family status, employment, 
income and trends regarding any of these characteristics. 

2. Know what different customer groups want: By segmenting the marketing into groups, it is easier 
for entrepreneurs to determine what products or services each group wants or needs. 

3. Know where the customer buys: Entrepreneurs need to find out where the customers in their market 
are presently buying. 

4. Know when the customer buys: By knowing when customers buy (daily, weekly, monthly, yearly, or 
seasonally).  

5. Know how the customer buys: Knowing how the customer pays for products and services can help 
the entrepreneur to determine a credit policy as well as a pricing policy for the business. 

6. Customers with disabilities: Businesses benefit when they give customers with disabilities an equal 
opportunity to obtain their goods and services. For example, easy access to buildings benefits people 
with disabilities, plus others with baby strollers, or doing deliveries, etc.. 

 

3) Where can customer information be located? 

Customer information can be obtained from trade associations (publications), Chambers of Commerce, 
government agencies (including local government), newspapers and magazines, the internet, and individual 
research by conducting a market survey in the community. 

 

4) What is the marketing concept? 

Marketing is based on the fact that: (a) business policies and activities should be focused on satisfying customer 
needs, and (b) profitable sales volume is a primary goal. 

When applying the marketing concept, a small business should: 

The market, for a 
business is all the 
people within a 
specific 
geographical area, 
who need a specific 
product or service 
and are willing and 
able to buy it. 

Market 
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1. Determine the needs of their customers (market research); 

2. Analyse their competitive advantages (marketing strategy); 

3. Select specific markets to serve (target marketing); and 

4. Determine how to best satisfy those needs (marketing mix). 

 

5) What is market research? 

A small market research program, based on a questionnaire given to present customers and / or prospective 
customers, can disclose problems and areas of dissatisfaction that can be easily remedied, or new products or 
services that could be offered successfully. For example, it is very useful to know what your competitors’ 
strategies are (i.e. how they compete?). 

 

6) What is target marketing? 

Owners of small businesses have limited resources to spend on marketing activities. Concentrating their 
marketing efforts on one or two key market segments is the basis for their target marketing. The major ways for 
a business to segment its market are: 

1. Geographical segmentation:  

2. Customer segmentation:  

 

7) How marketing performances can be evaluated? 

The standards of performance need to be established so results can be evaluated against them. Sound data on 
industry norms and past performance provide a basis for comparing present performance. Owners should 
evaluate their business performance at least quarterly. 

The key questions are: 

1. Is the business doing all it can to be customer-oriented? 

2. Do employees make sure customers’ needs are satisfied? 

5. Hiring and Waging Staff 

Best organization always has the right man on right job and offer wages according to market. 

Types of Staffing Services: 

 Temporary staffing: Services supply client companies with workers on a short-term basis, either to fill in 
for absent employees or to supplement existing staff during particularly busy times. 

 Long-term staffing services: also known as "facilities staffing," specialize in placing employees in 
long-term assignments, for indefinite periods of time. Project-related assignments, such as those found in 
the professional and technical sectors, often require long-term staffing. 
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 A temp-to-perm staffing service, offers clients a chance to try out a worker on a temporary basis and to 
hire that worker later if the client wishes to do so. 

Staffing Service Sector: 

The staffing services industry is divided into the following sectors: 

 Office and clerical.  

 Industrial. Professional /Technical 

Start-Up Cost: 

The staffing industry has higher startup costs than do many other industries--for a couple of reasons. 

 A home office isn't usually a reasonable option. 

 You’ll have to meet payroll immediately, even though your business may have no income for a few 
months. 

Size: Obviously, starting out with a small office and few permanent employees costs less than starting out with 
a larger facility and numerous permanent employees. 

Niche: Some sectors of the industry are more expensive to operate in than are others. As a rule of thumb, the 
more highly skilled the job assignments your company handles, the higher your start-up costs will be. There are 
at least three reasons for this: 1) employee salaries will be higher, 2) the need for a certain image may require a 
more expensive location, and 3) computer demands (both hardware and software) for testing and training will be 
greater. The most expensive niche in which to start up appears to be the medical staffing industry. 

Geographical location: Office rent, employee pay, advertising costs, tax rates and insurance rates all depend 
on both your area of the country and the city/town distinction. 

Operations: 

As a general rule, front office work is "people work" and that involves dealing with 
clients, employees and applicants, either in person, on the phone or at the computer. 
Your sales staff will usually be out of the office by about 9 a.m. to drum up clients for 
you, so this section is about the people work those in the office for instance (recruiters, 
employment counselors, coordinators, etc.) will be doing. 

Most staffing services are open from 8 a.m. to 6 p.m., or some close approximation 
thereof. During that time, you should always have someone at the front desk, ready to 
greet those who walk in. The majority of people coming through your doors will be 
applicants, since clients rarely visit and most employees come in only occasionally (for 
example, to pick up a paycheck). 

 

 

 

 

 

 

PSQCA came into 
operation since 1st 
December 2000, 
working with 81 
scientists/engineers 
and 254 supporting 
staff as self-finance 
organization 

Do you know! 
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6. Quality Standard  

PSQCA: 

The Pakistan Standards and Quality Control Authority, under the Ministry of Science 
and Technology, is the national standardization body. In performing its duties and 
functions, PSQCA is governed by the PSQCA Act, 1996. PSQCA has been given the 
task of not only formulation of Pakistan Standards but is also responsible for 
promulgation thereof. 

PSQCA has also been established to advise the Government on standardization 
policies, programs and activities to promote industrial efficiency and development, as 
well as for consumer protection. 

7. Customer Service Policy from Consumer Rights Commission of Pakistan 

CRCP is an independent, non-profit, and non-governmental organization. It largely works through local fund-
raising and engaging volunteers. It is not supported by any industry or commercial sector. It is the first national 
consumer organization in the country, which approaches the issue of consumer protection in comprehensive and 
holistic terms. Its vision and strategies have significant cross linkages with both market practices and issues of 
governance.  

8. Search for Premises 

Specify your Premises Requirement 

Drawing up a list of what you need from your premises is a good way to start your search. This list might include 
the following points: 

 size and layout of the premises 

 structure and appearance, both internally and externally 

 any special structural requirements, such as high ceilings 

 facilities and comfort for employees and visitors - including lighting, toilets and kitchen facilities 

 utilities, such as power and drainage, water and any special requirements - for example, 3-phase 
electricity 

 access and parking space - for deliveries or customers, including disabled customers 

 

Your choice of premises will also depend on your budget. Whether you rent or buy, costs can include: 

 initial purchase costs, including legal costs such as solicitor's fees and professional fees for surveyors 

 initial alterations, fitting out and decoration 

 any alterations required to meet building, health and safety and fire regulations 

 ongoing rent, service and utility charges, including water, electricity and gas 

Consumer Rights 
Commission of 
Pakistan (CRCP) is 
a rights-based civil 
initiative registered 
under the Trust Act, 

1882.Established 
in 1998 

CRCP 
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 Business rates. 

 continuing maintenance and repairs 

 building and contents insurance 

 

Search For Premises 

You can then circulate this specification to estate agents and surveyors that handle commercial properties in your 
area. Your local authority, Chamber of Commerce or trade association may also be able to help. 

Many local authorities maintain a register of available commercial property. It's also worth investigating any 
grants, loans on preferential terms and incentive schemes set up to tempt small businesses into urban areas, 
such as grants from inner city renewal projects, or cheaper premises for small businesses in designated areas. 

When starting out, you'll need to decide where you will conduct business. If you sell products, this might be 
deciding where to set up a shop.  If you're a professional service provider. 

 

Fire and Security Protection: 

Good electrical and gas safety could help protect premises against fire. Installing fire and burglar alarms also 
makes sense. 

Include contact details for those you're likely to have to notify in an emergency such as the emergency services, 
insurers, municipal services, customers, suppliers, utility companies and neighboring businesses. 

9. Employer Source of Support 

To gear-up a business you must need the support of other people. Chamber of Commerce is a huge platform for 
this purpose. 

Chamber of Commerce: 

Chambers of Commerce is essential to the economic growth of our communities; through making introductions, 
facilitating projects, maintaining data on the areas served and their economic climates and keeping abreast of 
pending development projects. 

Through an online community members can: 

1. Network, with fewer members able to attend events, a forum in which they can connect with others 
(virtually) on their schedule is of great value. 

2. Update your own information, saving administrations and members’ time as business profiles can be 
updated by members on their schedule. 

3. Promote your business, an online community allows member businesses to offer each other deal 
through a secure environment. 

4. Educate yourself; you are the keeper of important economic information for your area. 

In addition you can arrange business parties with other to build relationship.  
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10. Custom Printed T-Shirts Business Plan 

EXECUTIVE SUMMARY 

Printing T-shirt (Mind Expression) is an exciting new business that allows people to custom design a shirt 
(specifically the design on the front or back) any way that they would like. 

 Name of Business: 
Mind Expression 

 Legal Form: 

 Partnership 
Mind Expression is formed on partnership. Partnership is registered as per Partnership Act 
among the four partners.  

 

 

BRIEF DESCRIPTION OF THE BUSINESS IDEA 

 Product: 
Mind Expression will offer customers a variety of options for creating their own custom shirts. 
Initially all orders will be for t-shirts only, however in future other style shirts will be entertained.  

 Customer: 
The first group is customers that desire an already created graphic image to be placed on their 
shirt.  
The second group are those that prefer custom artwork to be placed on their shirt.  

 Age: 10 – 40 

 Occupation:  
Students, Department or Business (Celebrating their special events, for their employees), Player 

 Events:  
Local Public (celebrating events i.e Birthday, Independence Day, Valentine Day etc.) 

 Employability: 
Mind expression will be source of employment as well by generating 08 positions. Out of which 
half will be occupied by the owners / partners and remaining 04 will be open for the market. 

 

 

START-UP CAPITAL 

Investment   Rs. 0.325 Million 

Working capital  Rs. 0.075 Million 

Total    Rs. 0.400 Million 

(Rs. 0.100 Million / Partner) 

 

SOURCE OF CAPITAL: 

Partners will manage the all source on their own (on loan) as per share mentioned in the partnership deed. 

 



Module 8: Identify and Peruse New Business Opportunities in the Field of Computer (ICT) 

482 |                                                                   Teaching and Learning Material: Information Technology (Computer Operator) 

START-UP EXPENSES 

Item Description Cost (Rs.) 

Legal (Partnership Stamp Paper etc.) 2500 

Stationery  5000 

Brochures 5000 

Computer equipment 50000 

Rent 5000 

Advance for Shop 15000 

Office furniture 30000 

Sublimation heat transfer unit 100000 

Internet Connection 2500 

White Wash 5000 

Display Board 5000 

Rack 5000 

Printer 50000 

Cash in Hand 50000 

Advertisement 25000 

Utility Expense (Installation Charges) 10000 

Generator / UPS / Solar Panel 35000 

TOTAL 400000 

 

STRATEGY AND IMPLEMENTATION SUMMARY: 

Mind Expression will leverage their two competitive edges to quickly gain market share.  
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 Marketing Campaign: 

The marketing campaign will emphasize the ability to completely customize a shirt. Other 
possible marketing tools are, Boucher, Cable TV, Gifts, Panaflex on Auto Rikshaw etc. 

 Competitive Edge: 

Mind Expression has two competitive edges (uniqueness) that they will use to their advantage 
to achieve market penetration. 

 Large catalogue of graphics – 

 Quality of the sublimation – 
 

 

 Market Segmentation 

We segmented their market into two distinct group’s i-e Graphics and Network.  

 

MONTHLY EXPENSES 

Item Description Cost (Rs.) 

Salaries (8000 *4 =32000) 32000 

Rent 5000 

Utilities 1500 

Other 1500 

Total 40000 
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Learning Unit 3: Marketing the New Computer Business’s 
Services to Customers 

Overview 

Start-up businesses must be even more careful when it comes to advertising. The fact is that 
most businesses spend way too much money advertising to get new customers. In this learning unit you will 
learn how to grasp the new business with communicating the information clearly and passionately to potential 
customers and how you can advertise your business and can attract your customers by offering promotions and 
deals. After completion of this learning unit you will find the key points to nourish your business with good 
communication and behavioral skills and strategies for marketing of business. 
 

1. Grasping Vision of New Business 

Before starting new business you will see the existing business through the directories available in the market 
and will find business according to your mind; you will see the case studies of different companies and will decide 
your business according to availability resources. You will generate an idea what to do according to watching all 
the factors, Innovative, risk factor and all watching the competitors.  Seven C’s of Effective Business 
Communication are described as under: 

 

1. Correctness 

At the time of encoding, if the encoder has comprehensive knowledge about the decoder of message, it makes 
the communication an ease. The encoder should know the status, knowledge and educational background of the 
decoder. Correctness means: 

 Use the right level of language 

 Correct use of grammar, spelling and punctuation 

 Accuracy in stating facts and figures 

Correctness in message helps in building confidence. 

 

2. Clarity 

Clarity demands the use of simple language and easy sentence structure in composing the message. When there 
is clarity in presenting ideas, it’s easy for the receiver/decoder to grasp the meaning being conveyed by the 
sender/encoder. Clarity makes comprehension easier. 

 

3. Conciseness 

A concise message saves time of both the sender and the receiver. Conciseness, in a business message, can 
be achieved by avoiding wordy expressions and repetition. Using brief and to the point sentences, including 
relevant material makes the message concise. Achieving conciseness does not mean to loose completeness of 
message. Conciseness saves time. 
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4. Completeness 

By completeness means the message must bear all the necessary information to bring the response you desire. 
The sender should answer all the questions and with facts and figures. And when desirable, go for extra details. 
Completeness brings the desired response. 

 

5. Consideration 

Consideration demands to put oneself in the place of receiver while composing a message. It refers to the use 
of You attitude, emphases positive pleasant facts, visualizing reader’s problems, desires, emotions and his 
response. Consideration means understanding of human nature. 

 

6. Concreteness 

Being definite, vivid and specific rather than vague, obscure and general leads to concreteness of the message. 
Facts and figures being presented in the message should be specif. Concreteness reinforces confidence. 

 

7. Courtesy 

In business, almost everything starts and ends in courtesy. Courtesy means not only thinking about receiver but 
also valuing his feelings. Much can be achieved by using polite words and gestures, being appreciative, 
thoughtful, tactful, and showing respect to the receiver. Courtesy builds goodwill. 
 
 

2. Employing Methods of Marketing 

Advertising: The key to advertising successfully is to generate promising leads in exchange for the money you 
spend. To do so, it helps to offer a message that not only hits on your target customers, but also showcases the 
value you can offer them.  

 Social Media 
 
Social media is about connecting with the people in your niche: customers, potential customers, people who 
are interested in what you do, or who share similar interests and circles or hubs with you. It’s about building 
relationships and networking, not selling, although that does come as a result. 
Create an interactive, regularly update site or Blog, or by build informative yet informal profiles on social 
networking sites like Facebook or Twitter.  
 

 Offer Gifts, Discount Coupons etc. 
 
Offer your customers with a gift pack. Make sure your gift bag offering has your website address, business 
card and additional offers that inspire recipients to follow up or at least check you out. For instance, if you’re 
giving away t-shirts, include a list of celebrities who also wear the shirt they’re getting. 

 New Contents 
 
Content are any articles, information, video, info graphics or stuff people can read, watch or look at that tells 
them something they didn’t know already about your product or service. If you can consistently amaze and 
thrill readers with new content and new information or entertainment about your product or services, you’ll 
grow quickly! 
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3. Marketing Mix 

McCarthy classified all these marketing tools under four broad categories: 

 Product 

 Price 

 Place 

 Promotion 

These four elements are the basic components of a marketing plan and are collectively called 4 P’s of 
marketing. 4 P’s pertain more to physical products than services.  Below is an illustration for marketing mix. 

 

The important thing to note is that all these four P’s (variable) are controllable, subject to internal and external 
constraints of marketing environment. Marketers, using different blends of these variables, can target different 
group of customers having different needs. So, a customer may call marketing mix “the offering”. 

 

Product 

Product is the actual offering by the company to its targeted customers which also includes value added stuff. 
Product may be tangible (goods) or intangible (services). While formulating the marketing strategy, product 
decisions include: 

 What to offer? 

 Brand name 

http://notesdesk.com/wp-content/uploads/2009/03/marketing-mix-4-ps-of-marketing.jpg
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 Packaging 

 Quality 

 Appearance 

 Functionality 

 Accessories 

 Installation 

 After sale services 

 Warranty 

 

Price 

Price includes the pricing strategy of the company for its products. How much customer should pay for a 
product? Pricing strategy not only related to the profit margins but also helps in finding target customers. Pricing 
decision also influence the choice of marketing channels. Price decisions include: 

 Pricing Strategy (Penetration, Skim, etc.) 

 List Price 

 payment period 

 Discounts 

 Financing 

 Credit terms 

 

Using price as a weapon for rivals is as old as mankind. But it’s risky too. Consumers are often sensitive for price, 
discounts and additional offers. Another aspect of pricing is that expensive products are considered of good 
quality. 

 

Place (Placement) 

It not only includes the place where the product is placed, all those activities performed by the company to 
ensure the availability of the product to the targeted customers. Availability of the product at the right place, at 
the right time and in the right quantity is crucial in placement decisions. 

     Placement decisions include: 

 Placement 

 Distribution channels 

 Logistics 
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 Inventory 

 Order processing 

 Market coverage 

 selection of channel members 

 

Promotion 

Promotion includes all communication and selling activities to persuade future prospects to buy the product. 
Promotion decisions include: 

 Advertising 

 Media Types 

 Message 

 Budgets 

 Sales promotion 

 Personal selling 

 Public relations 

 Direct marketing 

 

Limitation of Marketing Mix 

Marketing mix (4 P’s) was more useful in early 19’s when production concept was in and physical products were 
in larger proportion. Today, with latest marketing concept, marketing environment has become more integrated. 
So, in order to extend the usefulness of marketing mix, some authors introduced a fifth P and then seven P’s 
(People, Packaging, and Process). But the foundation of Marketing Mix still stands on the basic 4P’s. 

 

Data Bank and Record: 

The company will have its own data bank of all the potential customers in PC and maintenance of record register. 
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Learning Unit 4: Negotiate Agreements for the New 
Computer Business 
 

Overview 

 
Negotiation is a method by which people settle differences. It is a process by which compromise or agreement is 
reached while avoiding argument and dispute. In this learning unit you will learn the strategies and skills used to 
negotiate with suppliers, staff and customers that how in a mannered way you can solve your issues with others 
through negotiation. After completion of this learning unit you will be able to know tactical points to resolve your 
problems related to suppliers, customers and staff through negotiation. 
 

1. Businessman Negotiation 

Major Actors with whom Businessman Negotiate:  

1. Suppliers 

2. Customers 

3. Staff / Employees 

4. Partners 

5. Banker 

 

Important Negotiation Strategies with Suppliers, Staff and Customer 

Here are few important strategies that may be used for negotiations in business with 
suppliers, staff and customers. 

1. The negotiating process is continual, not an individual event.  Good negotiating outcomes are a 
result of good relationships and relationships must be developed over time.  Because of that, good 
negotiators are constantly looking for opportunities to enhance the relationship and strengthen their 
position.  

2. Think positive.  Many negotiators underestimate themselves because they don’t perceive the power 
they have inside of themselves accurately.  In most negotiating situations, you have more power than 
you think.  You must believe that the other party needs what you bring to the table as much as you want 
the negotiation to be a success.  Also, be sure that that positivity is visible during the negotiation.  Be 
aware of the tone of your voice and non-verbal body language while interacting with the other party. 

3. Prepare.  Information is crucial for negotiation.  Research the history, past problems or any sensitive 
points of the other party.  The more knowledge you have about the situation of the other party, the better 
position you’ll be in to negotiate.  The most important part of preparation is Practice!  The study of 
negotiation is like golf or karate.  You have to practice to execute well. 

4. Think about the best & worst outcome before the negotiations begin.  Don’t be upset if things don’t go 
your way.  In these instances, it’s a good time to re-evaluate all positions and return to the table.   In most 
cases, as long as you know the highest and lowest expectations of each party a middle ground can 
usually be reached in the overlapping areas. 

Negotiation is a 
dialogue between 
two or more people 
or parties intended 
to reach a mutually 
beneficial outcome, 
resolve points of 
difference, to gain 
advantage for an 
individual 
or collective or to 
craft outcomes to 
satisfy various 
interests. 

Negotiation 
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5. Be articulate & build value.  This is key, and it’s what separates the good negotiators from the 
masters.  When you have a strong belief in what you’re negotiating for, you will shine.  Become a master 
at presenting your thoughts and ideas so that others see the value. 
A tip on how to do that well: 

 Be direct when presenting a situation.  Be clear about what is expected.  Discuss ways to apply 
how it can happen. 

 Don’t simply talk about what needs to happen.  Discuss the consequences – how your solution 
will be beneficial to the other party. 

6. Give & Take.  When a person gives something up or concedes on part of a negotiation, always make 
sure to get something in return.  Otherwise, you’re conditioning the other party to ask for more while 
reducing your position and value.  Maintaining a balance will establish that both parties are equal. 

 

 

2. Issues that can be considered for Negotiation with Suppliers 

The following issues can be considered for negotiation with suppliers: 

1. Quality 

2. Timely Delivery 

3. Freight Charges 

4. Rate vs Quantity 

5. Areas of Mutual Gain 

6. Rate of other Suppliers 

7. Reference Their Customers 

8. Play the High / Low Quality Game 

 

Essential Negotiations Skills: 

 Handle any type of negotiation situation with poise and confidence  

 Focus on the relationship-centred aspects of a negotiation 

 Recognize and flex with various negotiation styles and what each style  

 Improve your ability to reach mutually satisfactory outcomes 

 Increase your effectiveness by raising your aspiration level 

 Defuse conflict that may arise during heated or drawn-out negotiations 

 Understand whether a team-based or individual approach will be more effective 
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 Reduce deadlocks and adversarial situations 

 Evaluate your level of success in past negotiations so as to improve your ability in future discussions 

 Increase personal confidence that will spread to other aspects of your job. 

 

3. Advantages of Negotiation Other than Profit 

 Help in Good working relations with suppliers, customer and  staff 

 Building Trust with suppliers, customer and  staff 

 Partnership Approach 

 Increasing cooperative environment 

 Build loyalty 

 Conflict resolution. 

 

4. Importance of Emotions in Negotiations 

Lot of factors influence the process of negotiation, our emotions being one of the major factors. Emotions can be 
a barrier to a value-maximizing agreement / business deals. Emotions can hinder the ability of negotiators to 
reach a wise agreement in a fair and amicable way. Our mood / emotion decide a lot many things. 

1. If one is in a happy mood, everything seems perfect and good to him. 

2. In a state of anger a mind is not in a position to think constructively.  

3. Being positive always helps. 

4. Individuals with a positive attitude tend to trust each other better. They take keen interest in the 
negotiation and actively participate in discussions.  

5. Don’t try to fool the other person. One should not fake things or manipulate the truth. 

6. Avoid being partial. A deal is a deal whether it is with a friend or with a stranger. 

7. Don’t mix your personal interests with your professional life. 

 

WRITTEN CONTRACT / AGREEMENT  

In common law or in  legal systems, a contract (or informally known as an agreement in some  jurisdiction) is 
an agreement having a lawful object entered into voluntarily by two or more parties, each of whom intends to 
create one or more legal obligations between them. The elements of a contract are "offer" and "acceptance" by 
"competent persons" having legal capacity who exchanges "consideration" to create "mutuality of obligation. 
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Key Parts of A Business Contract:  

There are several key parts or elements of a business contract.. The key parts of a business contract do not have 
to be any specific length. Simple, handwritten and even oral agreements can be enforceable. 

 

Parties 

The first section of a business contract includes the parties. One party is usually the business that is paying for 
a particular product or service. For example, a small company might be hiring a marketing consulting firm to help 
it market a new product line. An owner or manager typically includes her name in the payee spot. The other party 
is the Service Company or supplier. This independent representative or businessperson is the one who is 
expected to complete the work or provide the products. 

 

Agreement 

The agreement is legally called the consideration, according to "Entrepreneur" online. The agreement could be 
only a sentence or two in length. It includes a general statement of what the service or product provider is 
expected to do for the buyer.  

 

Terms 

More detailed information about the deal is included in the terms section of the business contract. This section 
spells out exactly what services or products are expected from the company doing the work. The terms section 
also includes the price, details of the payment, the length of the contract and when the services or products will 
be delivered.  

 

Signatures and Date 

The business contract must be signed by both parties. This indicates that the buyer accepts the payment 
conditions and the seller agrees to complete the specified work.  
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Learner’s Activity 

Description This learning activity consists of an interactive session in the class about 
marketing research like collecting data about any product and services. 

Time 40 minutes. 

Purpose To highlight how to analyze marketing products and services. 

Instructions for Learner 1. Ask learners how to do the market research. 

2. Ask learners how to collect the data. 

3. Ask learners are they able to do the SWOT analysis. 

4. Ask learners how to give the recommendations. 
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Summary of Module 

  A business plan lays out a written plan from a marketing, financial and operational viewpoint. It's 
incredibly tough to find good business opportunities. The best tactic is to read examples and 
understand what to look for and where to go to find a successful opportunity. 

  There are many different types of business risk. Risks can be internal and external to your business. 
They can also directly or indirectly affect your business's ability to operate.  The types of risk you face 
are specific to your business and its objectives. 

  A risk management plan is an essential part of any business as it helps you to understand potential 
risks to your business and identify ways to minimize them or recover from their impacts. 

  Break-even analysis is an important aspect of a good business plan, since it helps the business 
determine the cost structures, and the number of units that need to be sold in order to cover the cost 
or make a profit. 

  Break-even Point = Fixed Costs / (Unit Selling Price – Variable Costs) 

  In order to build and maintain trust with our customers we have to first develop a strong, company-
wide reputation for integrity. We accomplish that, through clearly established internal ethical 
principles. 

  A sole proprietorship, also known as the sole trader, is a type of business entity that is owned and 
run by one natural person and in which there is no legal distinction between the owner and the 
business. 

  NTN is the abbreviation of National Tax Number. 

  Equity Capital is the owner’s investment in the business. Money that the owner puts into the business 
is called equity capital. 

  A small market research program, based on a questionnaire given to present customers and / or 
prospective customers, can disclose problems and areas of dissatisfaction that can be easily 
remedied, or new products or services that could be offered successfully. 

  The Pakistan Standards and Quality Control Authority, under the Ministry of Science and 
Technology, is the national standardization body.  PSQCA came into operation since 1st December 
2000, working with 81 scientists/engineers and 254 supporting staff as self-finance organization. 

  CRCP is an independent, non-profit, and non-governmental organization. It largely works through 
local fund-raising and engaging volunteers. 

  Chambers of Commerce is essential to the economic growth of our communities; through making 
introductions, facilitating projects, maintaining data on the areas served and their economic climates 
and keeping abreast of pending development projects. 

  

https://en.wikipedia.org/wiki/Business_entity
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  Seven C’s of Effective Business Communication are: 

 Correctness 

 Clarity 

 Conciseness 

 Completeness 

 Consideration 

 Concreteness 

 Courtesy 

  Marketing Mix is a combination of marketing tools that a company uses to satisfy their target 
customers and achieving organizational goals. 

  Negotiation is a dialogue between two or more people or parties intended to reach a mutually 
beneficial outcome, resolve points of difference, to gain advantage for an individual or collective or 
to craft outcomes to satisfy various interests. 
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Frequently Asked Questions (FAQS) 

FAQ 1:  Define Business Plan? 

Answer 
A written document that describes in detail how a new business is going to achieve its goal is 
called Business Plan. 

FAQ 2:  Identify Risks rerlated to management of Business. 

Answer 

 Regulatory and government policy changes 

 Property and equipment 

 Economic and financial 

 Market 

FAQ 3:  What is Break-Even point? 

Answer 
In economics & business, specifically cost accounting, the break-even point (BEP) is 
the point at which cost or expenses and revenue are equal: there is no net loss or gain 

FAQ 4:  What is partnership? 

Answer 
A partnership is an arrangement where parties, known as partner, agree to cooperate to 
advance their mutual interests. 

FAQ 5:  What is NTN? 

Answer NTN is the abbreviation of National Tax Number. 

FAQ 6:  Where can credit or debt financing be obtained? 

Answer 

 Banks 

 Finance companies 

 Governments agencies  

 Trade credit. 

 Microfinance institutions 

FAQ 7:  What is Market? 

Answer 
The market, for a business is all the people within a specific geographical area, who need a 
specific product or service and are willing and able to buy it. 

FAQ 8:  What is target Marketing? 

Answer 
Owners of small businesses have limited resources to spend on marketing activities. 
Concentrating their marketing efforts on one or two key market segments is the basis for their 
target marketing. 
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FAQ 9:  What is CRCP? 

Answer 
CRCP is an independent, non-profit, and non-governmental organization. It largely works 
through local fund-raising and engaging volunteers. It is not supported by any industry or 
commercial sector. 

FAQ 10:  What are the four basic components of Marketing Plan? 

Answer 

 Product 
 Price 
 Place 
 Promotion 
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Test yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key at the 
end of this module. 

1.  A _______________ lays out a written plan from a marketing, financial and operational 
viewpoint. 

a.  Business Plan b.  Money Management 

c.  Marketing Strategy d.  Market 

2.  The Australian standard defines_________________ as 'the chance of something happening 
that will have an impact on objectives'. 

a.  Market b.  Partnership 

c.  Risk d.  None of Above 

3.  Expenses that occur once only when starting the business is known as 

a.  Personal expense b.  Start-Up Cost 

c.  Equity Capital d.  None of Above 

4.  A _______________ is an arrangement where parties, known as partners, agree to cooperate 
to advance their mutual interests. 

a.  Agreement b.  Mix Marketing 

c. Partnership d. None of above 

5.  A process by which compromise or agreement is reached while avoiding argument and 
dispute is called. 

a. Marketing b. Negotiation 

c sole proprietorship d None of Above 

https://en.wikipedia.org/wiki/Business_partners
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6.  _____________ is a combination of marketing tools that a company uses to satisfy their 
target customers and achieving organizational goals 

a Marketing Mix b Target Market 

c Break-Even Point d None of these 

7.  A local association to promote and protect the interests of the business community in a 
particular placeis known as. 

a Target Market 
 

b NTN 

c A and b d Chamber of Commerce 

8.  _________________ is the best cheaper way to advertise your business 

a Internet  b Newspaper 

c Television d All of Above 

9.  Break-even Point =  

a Fixed Costs / (Unit Selling Price+ Variable 
Costs) 

b Fixed Costs* (Unit Selling Price – Variable 
Costs) 

c Fixed Costs / (Unit Selling Price – 
Variable Costs) 

d None of Above 
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Answer Key 
MCQ Number Correct Answer 

1 a 

2 c 

3 b 

4 c 

5 b 

6 a 

7 d 

8 a 

9 c 

 

 




